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Introduction

This manual contains detailed instructions and notes on the operation and use of this printer. For your safety and

benefit, read this manual carefully before using the printer. Keep this manual in a handy place for quick

reference. For safe and correct use, be sure to read the "Safety Information" before using the machine.

Trademarks

Adobe, Acrobat, Acrobat Reader, Adobe Type Manager, Flash, Macromedia, PageMaker and PostScript 

are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 

other countries.

Apple, AppleTalk, Bonjour, Macintosh, Mac OS, Mac OS X and True Type are trademarks of Apple Inc., registered 

in the 

U.S. and other countries.

Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc.

Monotype® is a registered trademark of Monotype Imaging, Inc.

Netware®, IPXTM, IPX/SPXTM, Novell ClientTM are either registered trademarks or trademarks of Novell, Inc.

Netscape® and Netscape Navigator® are registered trademarks of Netscape Communications Corporation.

PCL® is a registered trademark of Hewlett-Packard Company.

Safari is a trademark of Apple Inc.

SolarisTM is trademark of Sun Microsystems, Inc. in the U.S. and other countries.

UNIX® is a registered trademark of The Open Group.

UPnPTM is a trademark of the UPnPTM Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their 

respective companies. We disclaim any and all rights to those marks.

Microsoft®, Windows®, Windows Server®, MS-DOS®, and Windows Vista® are registered trademarks of 

Microsoft Corporation in the United States and/or other countries.

    *   The product names of Windows 2000 are as follows:

        Microsoft® Windows® 2000 Advanced Server

        Microsoft® Windows® 2000 Server

        Microsoft® Windows® 2000 Professional

    *   The product names of Windows XP are as follows:

        Microsoft® Windows® XP Professional

        Microsoft® Windows®  XP Home Edition

    *   The product names of Windows Vista are as follows:

        Microsoft® Windows Vista® Ultimate

        Microsoft® Windows Vista® Enterprise

        Microsoft® Windows Vista® Business

        Microsoft® Windows Vista® Home Premium

        Microsoft® Windows Vista® Home Basic

    *   The product names of Windows Server 2003 are as follows:

        Microsoft® Windows Server® 2003 Standard Edition

        Microsoft® Windows Server® 2003 Enterprise Edition

        Microsoft® Windows Server® 2003 Web Edition

    *   The product names of Windows Server 2003 R2 are as follows:

        Microsoft® Windows Server® 2003 R2 Standard Edition

        Microsoft® Windows Server® 2003 R2 Enterprise Edition

        Microsoft® Windows Server® 2003 R2 Web Edition

    *   The product names of Windows Server 2008 are as follows:

        Microsoft® Windows Server® 2008 Standard

        Microsoft® Windows Server® 2008 Enterprise

        Microsoft® Windows Server® 2008 Datacenter

Some illustrations in this manual might be slightly different from the machine.



Manuals for This Printer
Refer to the manuals that are relevant to what you want to do with the printer.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe Acrobat Reader/Adobe Reader must be installed in order to view the manuals as PDF files.

• A Web browser must be installed in order to view the html manuals.

Safety Information

Contains information about safe usage of this printer.

To avoid injury and prevent damage to the printer, be sure to read this.

Quick Installation Guide

Contains procedures for removing the printer from its box, connecting it to a computer, and installing
its driver.

Hardware Guide

Contains information about paper and procedures such as installing options, replacing consumables,
responding to error messages, and resolving jams.

Software Guide (This manual)

Contains information about using this printer, its software, and its security functions.

Security Guide

Contains information for administrators of the printer. It explains security functions that the
administrators can use to prevent data tampering or unauthorized use of the printer. Also refer to this
manual for the procedure for registering an administrator, as well as setting user and administrator
authentication.

Unix Supplement

For “UNIX Supplement”, please visit our Web site or consult an authorized dealer. This manual
includes descriptions of functions and settings that might not be available on this printer.

• Manuals provided are specific to machine types.

• The following software products are referred to as using general names:

Product name General name

DeskTopBinder Lite and DeskTopBinder
Professional*1 DeskTopBinder
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Product name General name

Web SmartDeviceMonitor professional IS*1 and
Web SmartDeviceMonitor Standard*1 Web SmartDeviceMonitor

*1 Optional
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these notes. They can be found
in the “Safety Information” section of Safety Information.

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the printer or to property. Be
sure to read these notes. They can be found in the “Safety Information” section of Safety Information.

Indicates points to pay attention to when using the printer, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the printer's functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys that appear on the printer's display panel.

[ ]
Indicates the names of keys on the printer's control panel.

About IP Address

In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the instructions that are relevant
to the environment you are using.
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Model-Specific Information
In this manual, the following symbols indicate information that relates to a specific printer model.

This indicates information about the 220 to 240 V model printer.

Read if you have purchased this model.

This indicates information about the 120 V model printer.

Read if you have purchased this model.

• Check the label on the rear of the printer to identify the printer's model.

BMW031S
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List of Options
This section provides a list of options for this printer, and how they are referred to as in this manual.

Some printer models have a hard drive installed by default. In this manual, the models with the hard disk
drive are referred to as the HDD standard model. The models for which the hard disk drive is optional are
referred to as the Basic model.

Option name Referred to as

IEEE802.11a/g Interface Unit Type J

IEEE802.11g Interface Unit Type K
Wireless LAN interface board

Memory Unit Type J 256 MB,

Memory Unit Type J 512 MB
SDRAM module

Printer Hard Disk Drive Type 820 Hard disk

Gigabit Ethernet Type B Gigabit Ethernet board

IEEE 1284 Interface Board Type A IEEE 1284 interface board

Bluetooth Interface Unit Type 3245 Bluetooth interface unit

HDD ENCRYPTION UNIT Type D HDD encryption unit

Data Overwrite Security Unit Type M Data overwrite security unit

Camera Direct Print Card Type F Camera direct print card

SD Card for NetWare Printing Type A NetWare card

VM Card Type K VM card

Finisher SR3030 2 tray finisher

Booklet Finisher SR3000 Booklet finisher

Punch Unit Type 3260 NA 3/2,

Punch Unit Type 3260 EU 2/4,

Punch Unit Type 3260 SC

Punch unit

Output Jogger Unit Type 3260 Output jogger unit

Paper Feed Unit PB3080 500-sheet paper feed unit

Paper Feed Unit PB3040 1000-sheet paper feed unit
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Option name Referred to as

LCIT PB3050 2000-sheet paper feed unit

Bridge Unit BU3030 Bridge unit

Punch Kit PU3000 NA

Punch Kit PU3000 EU

Punch Kit PU3000 SC

Punch kit

Mail Bin Type C820 Mailbox
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Using Keys
This section explains names and usage of the parts of the control panel.

BMV029S

1. Display

Displays current printer status and error messages.

When the printer enters energy saver mode, the display back light turns off. For details about energy saver mode,
see "System Menu".

2. Selection Keys

Correspond to the function items shown on the bottom line of the display.

3. [Escape] Key

Press this key to return to the previous display.

4. Scroll Keys

Press to move the cursor in each direction.

When the [ ] [ ] [ ] [ ] keys appear in this manual, press the scroll key of the same direction.

5. [OK] Key

Use this key to confirm settings or setting values, or move to the next menu level.

6. Data In indicator

Blinks when the printer is receiving data from a computer. Lights up if there is data to be printed.

7. Alert Indicator

Lights up in red or yellow when a printer error occurs.

Red: printing is not possible/possible but print quality cannot be ensured.

Yellow: printer requires maintenance, such as replacing consumables, shortly.

Follow the instructions that appear on the display.

8. Power Indicator

Remains lit while the power is on. It is unlit when the power is off or while the printer is in energy saver mode.
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9. [Suspend/Resume] Key

Press this key to suspend a print job. The key lights up while the job is suspended. To resume the job, press this
key again.

10. [Job Reset] Key

Press this key to cancel an ongoing print job.

11. [Menu] Key

Press this key to configure and check the current printer settings.

While configuring settings, press this key to return to the initial screen.

• p.166 "System Menu"
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1. Preparing for Printing
This chapter describes how to connect this printer to your computer, and install the printer driver.

Confirming the Connection Method
This printer supports network and local connections.

Before installing the printer driver, check how the printer is connected. Follow the driver installation
procedure that is appropriate for the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as a Windows printing port

Network connections can be established through Ethernet and Wireless LAN.

Available ports are determined based on the combination of the Windows operating system version and
connection method used.

BMU909S
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Windows 2000/XP, Windows Server 2003/2003 R2

Connection Method Available Ports

• Ethernet

• Wireless LAN

• SmartDeviceMonitor for Client port

• Standard TCP/IP port

• LPR port

Windows Vista, Windows Server 2008

Connection Method Available Ports

• Ethernet

• Wireless LAN

• SmartDeviceMonitor for Client port

• Standard TCP/IP port

• LPR port

• WSD port

• See the explanation about how to install the printer driver for each type of ports.

• For details about the SmartDeviceMonitor for Client port, see "Installing the Printer Driver".

• For details about the Standard TCP/IP port, see "Installing the Printer Driver".

• For details about the LPR port, see "Installing the Printer Driver".

• For details about the WSD port, see "Installing the Printer Driver".

• p.24 "Installing the Printer Driver"

Using as a network printer

This printer can be used as a Windows network printer, a NetWare print server, or a NetWare remote
printer.

1. Preparing for Printing
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• In an IPv6 environment, NetWare servers cannot be used.

• See the explanation about how to install the printer driver for each type of network printers.

• For details about Windows network printer, see "Using as a Windows Network Printer".

• For details about a NetWare print server and remote printer, see "Using as a NetWare Print Server/
Remote Printer".

• p.41 "Using as a Windows Network Printer"

• p.44 "Using as a NetWare Print Server / Remote Printer"

Local Connection

Local connections can be established via parallel, USB, and Bluetooth connections.

• See the explanation about how to install the printer driver for each connection method.

• For details about USB connections, see "Installing the Printer Driver Using USB".

• For details about parallel connections, see "Printing with Parallel Connection".

• p.47 "Installing the Printer Driver Using USB"

• p.50 "Printing with Parallel Connection"

Confirming the Connection Method
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Installing the Printer Driver
This section explains how to install the printer driver. There are two ways to install the printer driver: using
Quick Install, which installs the settings at once, or installing the appropriate driver according to the port
you want to use.

Downloading the Printer Driver

You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

If your operating system is Windows XP Pro x64, Windows Vista x64, or Windows Server
2003/2003 R2/2008 x64, you must download the printer driver from the supplier's Web site. Select
this printer and the operating system you are using, and then download it.

Quick Install

Users of Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008 can install this software
easily using the supplied CD-ROM.

Using Quick Install, the PCL and RPCS printer drivers and DeskTopBinder- SmartDeviceMonitor for
Client are installed under the network environment, and the TCP/IP port will be set.

• To install the printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an Administrator.

• If this printer is connected using USB, see "Installing the Printer Driver Using USB" and install the printer
driver.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

5. After reading the agreement, click [I accept the agreement.] and then click [Next >].

6. Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is displayed in [Connect To].

For parallel connection, select the printer whose printer port is displayed in [Connect To].
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7. Click [Install].

The printer driver installation starts.

8. Click [Finish].

A message about restarting the computer appears. Restart the computer to complete the installation.

9. Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

• To stop installation of the selected software, click [Cancel] before the installation is complete.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• Select a printer to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for
Client when using TCP/IP.

• Quick Install is not available unless bidirectional communication between the printer and computer
is enabled via parallel connection. For details about bidirectional communication between the printer
and computer, see "Making Option Settings for the Printer".

• p.47 "Installing the Printer Driver Using USB"

• p.59 "Making Option Settings for the Printer"

Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client port

• To install SmartDeviceMonitor for Client under Windows 2000/XP/Vista, and Windows Server
2003/2003 R2/2008, you must have an account that has Manage Printers permission. Log on as
an Administrator.

• Install SmartDeviceMonitor for Client before installing the printer driver when using the
SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.
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4. Click [DeskTopBinder - SmartDeviceMonitor for Client].

5. The message to quit all other applications appears. Quit all applications, and then click [Next
>].

6. The software license agreement appears in the [License Agreement] dialog box. After
reading through its contents, click [Yes].

7. Click [Full install] or [Custom install].

[Full install] installs all required applications: DeskTopBinder Lite and SmartDeviceMonitor for
Client.

[Custom install] installs selected applications.

8. Follow the instructions on the display and then click [Next >] to proceed to the next step.

9. After the installation is completed, select one of the options to restart the computer either
now or later, and click [Complete].

Restart the computer to complete the installation.

• To stop installation of the selected software, click [Cancel] before the installation is complete.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

Changing the port settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout,
recovery/parallel printing, and printer groups.

Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

3. On the [Ports] tab, click [Configure Port].

The [Configuration] dialog box appears.

Windows XP, Windows Server 2003/2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

3. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.
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Windows Vista, Windows Server 2008:

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer].

The [Printers] window appears.

3. Right-click the icon of the printer you want to use, and then click [Properties].

4. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

• User, proxy, and timeout settings can be configured for IPP.

• If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Click [Cancel] to close the [Port Configuration:] dialog box.

2. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon
on the tasktray.

3. Point to [Properties], and then click Extended Features Settings.

4. Select the Set [Recovery/Parallel Printing] for each port check box.

5. Click [OK] to close the [Extended Features] dialog box.

• For details about these settings, see "Using SmartDeviceMonitor for Client", or SmartDeviceMonitor
for Client Help.

• p.224 "Using SmartDeviceMonitor for Client"

Installing the PCL / RPCS printer drivers (TCP/IP)

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].
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5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [SmartDeviceMonitor], and then click [OK].

12. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

13. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IP address or host name of the printer.

14. Check that the port of the selected printer is displayed in [Port].

15. Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

Installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

• Setting a user code allows a SmartDeviceMonitor for Admin user to display and check statistics about
the number of sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"
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Installing the PostScript 3 printer driver (TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer] or [Local printer attached to this computer.], and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [DeskTopBinder - SmartDeviceMonitor for Client], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 13 does not apply for Windows Vista users.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page.

If you are using other than Windows Vista, click [Next].
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15. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PCL/RPCS printer drivers (IPP)

• To install printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

9. Click [Port], and then click [Add].

10. Click [SmartDeviceMonitor], and then click [OK].

11. Click [IPP].
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12. In the [Printer URL] box, enter "http://printer's IP address/printer" as the printer's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter
"https://printer's IP address/printer" (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's IP address/ipp" as the printer's address.

13. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing ports.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

14. Click [Detailed Settings] to make necessary settings.

For details about the settings, see SmartDeviceMonitor for Client Help.

15. Click [OK].

16. Check that the port of the selected printer is displayed in [Port].

17. Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

18. Select the [Default Printer] check box to configure the printer as default.

19. Click [Continue].

Installation starts.

20. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete the installation.

• To stop installation of the selected software, click [Cancel] before the installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• Setting a user code allows a SmartDeviceMonitor for Admin user to display and check the number
of sheets each user prints. For details, see SmartDeviceMonitor for Admin Help.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"
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Installing the PostScript 3 printer driver (IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer attached to this computer.], and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [DeskTopBinder - SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(machine's IP address or host name)/printer" as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(machine's IP address or host name)/printer" (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://machine's IP address or host name/ipp" as the printer's address.

If the address is "192.168.001.010", you must enter it as "192.168.1.10" to connect to the machine.
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11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings.

If you are using Windows 2000, click [OK] after making necessary settings.

For information about the settings, see DeskTopBinder-SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the printer driver you want to install is selected, and then click [Next
>].

15. Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 17 does not apply for Windows Vista users.

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

If you are using other than Windows Vista, click [Next].

18. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Using the Standard TCP/IP port

This describes how to install the PCL/ RPCS or PostScript 3 printer drivers using the TCP/IP port.

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor for
Client port.

Installing the PCL/RPCS Printer Drivers

1. Quit all applications currently running.
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2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings. See Windows Help if [Standard TCP/IP Port] does not
appear.

12. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When the device selection appears, select "RICOH NetworkPrinter Driver C Model".

14. Click [Next >].

15. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

16. Check that the port of the selected printer is displayed in [Port].

17. Configure the default printer as necessary.

18. Click [Continue].

The printer driver installation starts.

19. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete the installation.
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Installing the PostScript 3 Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer] or [Local printer attached to this printer], and then click [Next >].

If you are using Windows Vista, you do not need to click [Next].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port], and then click [Next >].

If you are using other than Windows 2000, [Standard TCP/IP Port] in [Create a new port].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".

11. Click [Next >].

12. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

14. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 15 does not apply for other than Windows 2000 users.

15. Click [Next >].

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page.

If you are using other than Windows Vista, click [Next >].
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18. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• To stop installation of the selected software, click [Cancel] before the installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"

Using the LPR port

This describes how to install the PCL/RPCS or PostScript 3 printer drivers using the LPR port.

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• If you are using other than Windows 2000 in an IPv6 environment, you cannot use the LPR Port. Use
the DeskTopBinder-SmartDeviceMonitor port.

Installing the PCL/RPCS Printer Drivers

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.
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7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

8. Click [Next >].

9. Double click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [LPR Port], and then click [OK].

If [LPR Port] does not appear, see Windows Help and install it.

12. Enter the printer's IP address in the [Name or address of server providing lpd] box.

13. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].

The port is added.

14. Check that the port of the selected printer is displayed in [Port].

15. Configure the default printer as necessary.

16. Click [Continue].

The printer driver installation starts.

17. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete the installation.

Installing the PostScript 3 Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Select [My Computer], and then click [Next >].

If you are using Windows 2000, you can click [Next >] without selecting [My Computer].
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6. Click [Local printer] or [Local Printer attached to this computer], and then click [Next >].

If you are using other than Windows Vista, click [Next >]

7. Click [Create a new port:].

8. Click [LPR Port], and then click [Next >].

If you are using other than Windows 2000, [Standard TCP/IP Port] in [Create a new port].

9. Enter the printer's IP address in the [Name or address of server providing lpd] box.

10. Enter "Ip" in the [Name of printer or print queue on that server box], and then click [OK].

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 13 does not apply for Windows Vista users.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page.

If you are using other than Windows Vista, click [Next >].

15. Click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• To stop installation of the selected software, click [Cancel] before the installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"

Using the WSD port

This section explains installation when using the WSD port.

• The WSD port can be used only under Windows Vista and Windows Server 2008.
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• To install under Windows Vista and Windows Server 2008, you must have an account that has
Manage Printers permission. Log on as an Administrator.

• If the printer is connected using the WSD port, bidirectional communication is not possible. For details
about bidirectional communication, see "Making Option Settings for the Printer".

• You can connect to the printer only if both the printer and computer are on the same network segment,
or "Network discovery" is enabled. For details, see Windows Help.

Installing the PCL/RPCS Printer Drivers

1. Quit all applications currently running.

2. On the [Start] menu, click [Network].

The [Network] window appears, and the device search begins automatically.

3. Right-click the printer's icon, and then click [Install].

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] dialog box appears.

4. Click [Locate and install driver software (Recommended)].

If the [User Account Control] dialog box appears, click [Continue].

5. Click [Don't search online].

6. Click [Browse my computer for driver software (advanced)].

7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button and then proceed to step 8.

8. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D: \DRIVERS\(RPCS,
PCL6, or PCL5C)\XP_VISTA\(Language)\DISK1".

9. Click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

10. Click [Close].

If installation is successful, the icon of the printer connected to the "WSD" port is added to the [Printers]
window.

Installing the PostScript 3 Printer Driver

1. Quit all applications currently running.

2. Click [Start], and then click [Network].

The [Network] window appears, and the device search begins automatically.
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3. Using as the NetWare Print Server / Remote Printer

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] dialog box appears.

4. Click [Locate and install driver software (Recommended)].

If the [User Account Control] dialog box appears, click [Continue].

The [Found New Hardware] window appears.

5. Click [Don't search online].

6. Click [Browse my computer for driver software (advanced)].

7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [close] button and then proceed to step 8.

8. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1".

9. Click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

10. Click [Close].

If installation is successful, the icon of the printer connected to the "WSD" port is added to the [Printers]
window.

• The port name that follows "WSD" uses random character strings. It cannot be changed freely.

• To stop the installation, click [Cancel] before the installation is complete. When re-installing the WSD
Port, right-click the printer's icon in the [Network] window, and then click [Uninstall].

• p.59 "Making Option Settings for the Printer"
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Using as a Windows Network Printer
This describes how to install the PCL, RPCS or PostScript 3 printer driver when using the printer as a Windows
network printer.

To use the print server, install the printer driver by selecting "Network printer server", and then select the
Windows 2000/XP/Vista, or Windows Server 2003/2003 R2/2008 shared printer.

This section assumes that the client has already been configured to communicate with a Windows 2000/
XP/Vista, or Windows Server 2003/2003 R2/2008 print server. Do not begin the following procedure
before the client is set up and configured correctly.

• To install the printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery
Printing and Parallel Printing cannot be used from the client.

• If you print under Windows XP/Vista or Windows Server 2003/2003 R2/2008 print server,
notification functions of SmartDeviceMonitor may not be used with the client.

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the DeskTopBinder-
SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows XP or Windows Server 2003/2003 R2/2008 print server,
DeskTopBinder-SmartDeviceMonitor notification functions may not be possible for the client.

• You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

• If your operating system is Windows XP Pro x64, Windows Vista x64 or Windows Server 2003/2003
R2/2008 x64, you must download the printer driver from the manufacturer's Web site. Select this
printer and the operating system you are using, and then download it.

Installing the PCL or RPCS Printer Drivers

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].
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5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the [Printer Name] check box to select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Click [Port], and then click [Add].

11. Click [Network Printer], and then click [OK].

12. Double-click the computer name you want to use as a print server in the [Browse for Printer]
window.

13. Select the printer you want to use, and then click [OK].

14. Check that the port of the selected printer is displayed in [Port].

15. Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver installation.

For details about user code, see the printer driver Help.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

The printer driver installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

Installing the PostScript 3 Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.
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4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Network printer] or [A network printer, or a printer attached to another computer].

If you are using other than Windows Vista, click [Next >].

7. Select [Browse for a printer], and then click [Next >].

If you are using Windows 2000, select the location method from the [Locate Your Printer] screen
before clicking [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

9. Select the printer you want to use, and then click [Next >].

10. The printer driver installation starts.

11. Click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Click [Finish].

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run.

• If you still want to install the printer driver, use [Add Printer]. See "Messages Displayed When Installing
the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"
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Using as a NetWare Print Server / Remote
Printer
This describes how to set up the Windows computer used as a NetWare client.

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, NetWare servers cannot be used.

The following explanation assumes NetWare Client is installed on the client computer and the NetWare
server environment is correctly set up. Install all necessary client applications before following this
procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PCL/RPCS Printer Drivers].

4. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

5. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

6. Click [Next >].

7. Select the [Printer Name] check box to select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.
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9. Click [Port], and then click [Add].

10. Click [Network Printer], and then click [OK].

11. Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

12. Select the print queue, and then click [OK].

13. Check that the port of the selected printer is displayed in [Port].

14. Click [Continue].

The printer driver installation starts.

15. Click [Finish] in the [Select Program] dialog box.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

17. After restarting the computer, open the printer properties from the [Printers and Faxes]
window.

Under Windows 2000/Vista or Windows Server 2003/2003 R2/2008, launch the [Printers]
window, and then open the printer properties.

18. Click the [NetWare setting] tab.

Under Windows 2000/Vista or Windows Server 2003/2003 R2/2008, on the [Printer Settings]
tab, clear the [Form Feed] and [Enable Banner] check boxes.

Do not select these check boxes since they are automatically selected by the printer driver. If you
select the check boxes, the printer may not print correctly.

19. Click [OK] to close the printer properties dialog box.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• The protocol is set to inactive as default. Enable it using SmartDeviceMonitor or Telnet.

When using the PostScript 3 Printer Driver

• In an IPv6 environment, Netware servers cannot be used.

Follow the procedure below to set up the PostScript 3 printer driver.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.
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2. Click the [PostScript] tab.

When using Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008, click the [Device
Settings] tab, and then proceed to step to clear the check box.

3. Click [Advanced].

4. Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and then click
[OK].

5. Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If
NetWare form feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to the operating system used:

• Under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2/2008, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating system used:

• Under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2/2008, clear the [Enable
banner] check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 to 40 seconds to resume after the printer is reset. During this
period, jobs may be accepted (depending on NetWare specifications) but not printed.

To print after resetting the printer as a remote printer, check on the print server that the remote printer is
disconnected, or wait for two minutes before trying to print.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the computer and no print jobs are in
progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows 2000/XP, Windows Server 2003/2003 R2 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Select the [Specify location] check box, and then click [Next >].

6. Insert the CD-ROM into the CD-ROM drive.

When Auto Run starts, click [Exit].

7. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVERS\RPCS\XP_VISTA\(language)\disk1

• PCL5c

D:\DRIVERS\PCL5C\XP_VISTA\(language)\disk1

• PCL6

D:\DRIVERS\PCL6\XP_VISTA\(language)\disk1
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• PostScript 3

D:\DRIVERS\PS\XP_VISTA\(language)\disk1

8. Check the printer driver location, and then click [OK].

9. Click [Next >].

10. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows Vista, Windows Server 2008 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using a USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS
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D:\DRIVERS\RPCS\XP_VISTA\(language)\disk1

• PCL5c

D:\DRIVERS\PCL5C\XP_VISTA\(language)\disk1

• PCL6

D:\DRIVERS\PCL6\XP_VISTA\(language)\disk1

• PostScript 3

D:\DRIVERS\PS\XP_VISTA\(language)\disk1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If the installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Troubleshooting USB

Problem Solutions

The printer is not recognized automatically. Turn off the power of the printer, reconnect the USB
cable, and then turn it on again.

Windows has already configured the USB settings. Open Windows' Device Manager, and then,
under [Universal Serial Bus controllers], remove
any conflicting devices. Conflicting devices have a
[!] or [?] icon by them. Take care not to accidentally
remove required devices. For details, see Windows
Help.

When using Windows 2000/XP or Windows
Server 2003/2003 R2/2008, an erroneous
device is displayed under [USB Controller] in the
[Device Manager] dialog box.
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Printing with Parallel Connection
This describes how to install the PCL, RPCS or PostScript 3 printer driver when using a parallel port.

To use a printer connected using a parallel interface, click [LPT1] when installing the printer driver.

• To install this printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003
R2/2008, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

• If your operating system is Windows XP Pro x64, Windows Vista x64, or Windows Server
2003/2003 R2/2008 x64, you must download the printer driver from the manufacturer's Web site.
Select this printer and the operating system you are using, and then download it.

Installing the PCL or RPCS Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the [Printer Name] check box to select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name' ] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

10. Check that [LPT1:] is shown in [Port].

11. Select the [Default Printer] check box to configure the printer as default.

12. Click [Finish].

The printer driver installation starts.
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13. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

Installing the PostScript 3 Printer Driver

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

The following procedure depends on your operation system.

Windows 2000:

1. [Local printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

2. Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].

3. Select whether or not to share the printer, and then click [Next >].

4. Select the name of the machine whose driver you want to install, and then click [Next
>].

5. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

Restart the computer to complete installation.

Other than Windows 2000:

1. Click [Local printer attached to this computer].

If you are using other than Windows Vista, click [Next >].

2. Select the port you want to use, and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.
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3. Select the name of the machine whose driver you want to install, and then click [Next
>].

4. Click [Close] to close the [Printer Port] dialog box.

5. Click [Next >].

6. Change the printer name if you want, and then click [Next >].

Step 7 does not apply for Windows Vista users.

7. Select whether or not to share the printer, and then click [Next >].

8. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "Messages Displayed When Installing the Printer Driver".

• p.56 "Messages Displayed When Installing the Printer Driver"
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Printing with Bluetooth Connection

Supported Profiles

SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers can be connected at
the same time using the Bluetooth interface: one by SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped computer at the same
time, the first device that establishes connection is selected. When selecting the connection
between the other devices, cancel the first established connection.

• Conditions for bidirectional communications

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

BIP

• For BIP connection, a module including PostScript 3 must be installed in the printer.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected via BIP.

• Only JPEG images that can be printed using BIP.

• User Codes are disabled for BIP.

• You cannot print if print functions are restricted.

• Some printers do not support BIP.

• In this manual, the instruction referred to print using SPP. To print using HCRP or BIP, see the Help
supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

• To install the printer driver under Windows 2000/XP Professional/Vista, or Windows Server
2003/2003 R2/2008, you must have an account that has Manage Printers permission. Log on as
an Administrators or Power Users group member.

1. Start 3Com Bluetooth Connection Manager.

2. Check that the printer you want to use appears in 3Com Bluetooth Connection Manager.

3. On the [Tool] menu, click [COM port].
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4. Check that the message "Bluetooth Serial Client (COMx) " appears under Client Ports. (X
indicates the COM port number used by Bluetooth.)

5. Click [Close].

6. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

7. Click the icon of the printer you want to use.

8. On the [File] menu, click [Properties].

9. Click the [Ports] tab.

10. Under [Port], select the [COMx:] check box. X indicates the COM port number used by
Bluetooth.

11. Click [OK].

Close the [Printers] window.

• System requirements vary depending on the Bluetooth standard and specifications. For details, see
the manuals provided with each product.

• For information about setting up Bluetooth under other operating systems or using it with different
utilities, see the manuals provided with those operating systems or utilities.

• To always use the same printer, select the [Always use for this connection] check box.

• If a dialog box appears while transmitting a print job, reestablish network connection as follows:

1. Select the printer you want to use in the [Printers and Faxes] box.

2. Click [Connect].

• For details, see the manuals provided with the Bluetooth adaptor or computer equipped with
Bluetooth.

Configuring Security Mode Settings

This describes how to configure the security mode settings.

1. Start 3Com Bluetooth Connection Manager.

2. On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

3. Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog box, enter the
Bluetooth password. For information about entering the password, see "Printing in the Security Mode".

For all other security modes and custom settings, no password is required.

For information about each mode, see the manuals provided with the utility.
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4. Click [OK].

Close the [Security Mode] dialog box.

• For details about the security mode, see 3Com Bluetooth Connection Manager Help. For details about
the password entry which is required to transmit print jobs, see the following section.

Printing in the Security Mode

This describes how to print in the security mode.

1. Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may appear. If it does, use it to
establish the network connection.

The [Authentication] dialog box appears.

2. Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the printer's serial number. You can find the
serial number on the label on the back of the printer. For example, if the serial number is
00A0-001234, the Bluetooth password is 1234.

3. The print job is sent.

• The Bluetooth password differs for each printer and cannot be changed.
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Messages Displayed When Installing the Printer
Driver
This section describes what to do if a message appears when installing the printer driver.

Message number 58 or 34 indicates that the printer driver cannot be installed using Auto Run. Install the
printer driver using [Add Printer] or [Install Printer].

Message number 58 appears if there is a newer version of the printer driver already installed.

Windows 2000

This section describes the procedure under Windows 2000.

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. Double-click the Add Printer icon.

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, PCL5C, or
PS)\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

4. Specify a port.

• Available ports vary according to your Windows operating system or the type of interface. For details,
see "Installing the Printer Driver".

• p.24 "Installing the Printer Driver"

Windows XP Professional or Windows Server 2003/2003 R2

This section describes the procedure under Windows XP Professional or Windows Server 2003/2003
R2.

1. On the [Start] menu, click [Printers and Faxes].

2. Click [Add a printer].

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, PCL5C, or
PS)\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

4. Specify a port.
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• Available ports vary according to your Windows operating system or the type of interface. For details,
see "Installing the Printer Driver".

• p.24 "Installing the Printer Driver"

Windows XP Home Edition

This section describes the procedure under Windows XP Home Edition.

1. On the [Start] menu, click [Control Panel].

2. Click [Printer and Other Hardware].

3. Click [Printers and Faxes].

4. Click [Add a Printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, PCL5C, or
PS)\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

6. Specify a port.

• Available ports vary according to your Windows operating system or the type of interface. For details,
see "Installing the Printer Driver".

• p.24 "Installing the Printer Driver"

Windows Vista, Windows Server 2008

This section describes the procedure under Windows Vista and Windows Server 2008.

1. On the [Start] menu, click [Control Panel].

2. Click [Hardware and Sound].

3. Click [Printers].

4. Click [Add a printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, PCL5C, or
PS)\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

6. Specify a port.
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• Available ports vary according to your Windows operating system or the type of interface. For details,
see "Installing the Printer Driver".

• p.24 "Installing the Printer Driver"
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Making Option Settings for the Printer
Make option settings for the printer using the printer driver when bidirectional communication is disabled.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direction settings to be
automatically sent to the printer. You can check printer status from your computer.

• Bidirectional communication is supported by Windows 2000/XP/Vista, and Windows Server
2003/2003 R2/2008.

• If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000,
the [Change Accessories] tab is unavailable.

To support bidirectional communication, the following conditions must be met:

When connected with parallel cables

• The computer must support bidirectional communication.

• The printer must support bidirectional communication.

• The interface cable must support bidirectional communication.

• The printer must be connected to a computer using the standard parallel cables and parallel
connectors.

• Under Windows 2000, [Enable bidirectional support] must be selected, and [Enable printer
pooling] must not be selected on the [Ports] tab with the RPCS printer driver.

When connected with a network

• The printer must support bidirectional communication.

• The Standard TCP/IP port must be used.

• [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be
selected on the [Ports] tab with the RPCS printer driver.

• In addition to the above, one of the following conditions must also be met:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be used. When using
the IPP protocol, the IPP port name must include the IP address.

• [Enable bidirectional support] must be selected, and [Enable printer pooling] must not be
selected on the [Ports] tab with the RPCS printer driver.

When connected with USB

• The printer must be connected to the computer's USB port using a USB interface cable (for
Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008).

• The computer must support bidirectional communication.

Making Option Settings for the Printer
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• The RPCS printer driver supports bidirectional communication and updates the printer status
automatically.

• The PCL printer driver supports bidirectional communication. You can update the printer status
manually.

• Install SmartDeviceMonitor for Client from the supplied CD-ROM.

If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communication is disabled.

• Under Windows 2000/XP/Vista, and Windows Server 2003/2003 R2/2008, Manage Printers
permission is required to change the printer properties in the [Printers] folder. Log on as an
Administrators or Power Users group member.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

When using Windows 2000, point to [Settings] on the [Start] menu, and then click [Printers]. The
[Printers] window appears.

When using Windows Vista and Windows Server 2008, click [Control Panel] on the [start] menu,
and then click [Printer]. The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

When using Windows Vista and Windows 2008, right-click the icon of the printer you want to use,
and then click [Properties].

4. Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection is enabled. In this
case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

5. Select options installed from the [Select printer options:] area, and then make the necessary
settings.

6. Select the total amount of the memory in [Total memory:] when the optional SDRAM module
is added.

7. Under [Paper source tray settings:], click the tray to be used, and then select the appropriate
size, position, and type for the tray. Select the [Do not use Auto Tray Select] check box to
exclude the tray from the targets of automatic tray selection.

8. Click [OK] to close the printer properties dialog box.
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Installing Font Manager

• Under Windows 2000 /XP/Vista, and Windows Server 2003/2003 R2/2008, installing
applications by Auto Run requires Administrator privilege. To install a printer driver by Auto Run, log
on using an account that has Administrator privilege.

1. Quit all applications currently running.

2. Insert the "Font Manager" CD-ROM into the CD-ROM drive.

The installer starts.

3. Click [Font Manager].

4. Follow the instructions on the display.

Installing Font Manager
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Using Adobe PageMaker Version 6.0, 6.5, or
7.0
Under Windows 2000/XP with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder "DRIVERS PS XP_VISTA (Language) DISK1" on the CD-
ROM.

The "XP_VISTA" folder inside the "PS" folder is for Windows 2000/XP, Windows Server 2003/2003 R2.
Use the folder that is appropriate for the operating system you are currently using.

The third folder "(Language)" may be substituted by an appropriate language name.

Copy the .ppd file to the PageMaker folder.

• For PageMaker 6.0 default installation

The directory is "C: PM6 RSRC PPD4".

• For PageMaker 6.5 default installation

The directory is "C: PM65 RSRC USENGLISH PPD4".

The "USENGLISH" may vary depending on your language selection.

• For PageMaker 7.0 default installation

The directory is "C: PM7 RSRC USENGLISH PPD4".

The "USENGLISH" may vary depending on your language selection.

• If the driver is not set correctly after copying the ".ppd" file, printing may not be performed properly.

• When using PageMaker, the optional features that can be selected by the printer driver will not be
active. The following procedure describes how to activate the optional printer features.

1. On the [File] menu, click [Print].

The [Print Document] dialog box appears.

2. Make the necessary settings in the [Features] box.
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2. Printing Documents
This chapter explains how to print documents using the printer driver. It also describes the procedure for
configuring PDF Direct Print and other printing functions.

Two Dialog Box Types
There are two dialog box types of the [Printer Properties] dialog box.

"Custom Setting" is used as an example in this manual. For details about changing the dialog box types,
see the printer driver Help.

Multi-tab

This dialog box type is designed for users who often change print settings to perform various printing
operations.

Custom Setting

This dialog box type is designed for users who rarely change print settings. This type of dialog box
may vary depending on the installed options.
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Displaying the Printer Driver Setting Screen
This describes how to launch printer driver's properties.

The following procedure explains how to make printer driver settings using Windows XP as an example.
The procedure may differ depending on the version of the operating system you are using.

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

• Depending on the application, the settings you make here may not apply as the default settings.

Making printer default settings - printing preferences

• The settings in the "Printing Settings" (Document Property) dialog box that can be modified and
retained differ depending on the printer driver, printer icon, and the users registered for each printer
icons.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.
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3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Depending on the application, the settings you make here may not apply as the default settings.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows XP Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

Displaying the Printer Driver Setting Screen
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Frequently Used Print Methods
This chapter explains how to use the various printing functions including specifying paper size and color,
duplex printing, combine printing, and watermark/overlay printing.

Each function described in this chapter is configured and registered under "Custom Settings". You can also
change the parameters for each function by modifying "Custom Settings".

• For details about Custom Settings, see "Using Custom Settings".

• p.76 "Using Custom Settings"

Standard Printing

This section explains how to print documents using the normal printing function with the printer driver.

• Before printing, make sure that the information on the installed options and loaded paper are correctly
set in [Change Accessories] in the printer driver. For details about opening [Change Accessories],
see "Making printer default settings - the printer properties".

1. Create a document using an appropriate application. On the [File] menu, click [Printing
Preference...].

2. Select [Color] or [Black and White] in the [Color/Black and White:] list.

Documents print faster when [Black and White] is selected instead of [Color].

3. When using paper with a different size from the document's size, select the [Reduce/
Enlarge] check box, and then select one of the following options from the [Reduce/Enlarge]
list:

• To scale the document to the size of the paper used, select [Fit to paper size].

• To scale the size of the printout by a specific percentage, select [Scale].

• To scale the horizontal and vertical proportions of the printout independently, select [Directional
Magnification].

Select the size of the paper used to print in [Printout paper size:].

4. Select the orientation of the document by selecting [Portrait] or [Landscape] in [Original
orientation] area.

5. When printing multiple copies, specify the number of sets in the [Copies] box.
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6. Select the paper tray to be used and the type of the paper loaded in the specified tray in the
[Paper source tray] and [Paper type] list.

When [Auto Tray Select] is selected in the [Paper source tray] list, the source tray is automatically
selected according to the paper size and type specified.

7. Click [OK].

8. Print the document using the print function in the application.

• The types of the paper loaded in the paper trays are indicated on the printer's display. You can check
the selected paper type is loaded in which tray. However, the paper type setting available in the
printing preference dialog box may be different from the type indicated on the printer's display.

• If the paper tray loaded with the specified paper size and type is not available, a warning message
appears on the machine's control panel. If this happens, follow the instruction displayed on the screen
to specify a paper tray and perform force printing, or press the job reset button to cancel printing. For
details, see "If Error Occurs with the Specified Paper Size and Type".

• If [Color] is selected in the [Color/Black and White:] list, you can print in color using all or some of
the 4 available colors: cyan, magenta, yellow, and black. For details about selecting the colors, see
"Printing with selected colors".

• p.64 "Making printer default settings - the printer properties"

• p.106 "If Error Occurs with the Specified Paper Size and Type"

• p.67 "Printing with selected colors"

Printing with selected colors

This section explains how to specify which colors are used to print a document. The 4 colors you can specify
are cyan, magenta, yellow, and black.

As an example, the following procedure explains how to print using only magenta and black.

1. Create a document using an appropriate application. On the [File] menu, click [Printing
Preference...].

2. Click [Print Quality] tab.

3. Check [User settings], and then select the user you want to change.

4. Click [Change User Settings...].

5. Click [Misc.].

6. Uncheck [Cyan] and [Yellow] from [Separate into CMYK, then print in designated color
only:].

7. Click [OK].
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8. Print the document using the print function in the application.

Printing on both sides of sheets

This section explains how to print on both sides of each page using the printer driver.

• When loading paper in the printer paper trays or the paper feed units, load at least 20 sheets. Also,
adjust the side guide so that it lightly touches the paper.

• Curled paper: If the paper is curled, flatten the paper before loading it.

• If you are using thick paper with a smooth surface, paper jams or multiple feeding can occur.
Fan the paper before loading it. If a paper jam or multiple feeding occurs even after you have
fanned the paper, set the paper one sheet at a time

1. Create a document using an appropriate application. On the [File] menu, click [Printing
Preference...].

2. When using the existing Custom Setting, click the icon in the [Custom Setting name] box.

If you do not wish to modify the custom settings already registered in the printer driver, change settings
such as paper size and source tray as required, and then proceed to step 10.

3. Click [Add/Change Custom Settings...].

4. Click the [Edit] tab, if it is not already selected.

5. Select the [Duplex/Booklet] check box.

6. Click the desired icon to specify the direction which the pages open to.

If you want to add binding margins, select the [Header/Footer/Adjust image position/Binding
margins] check box, and then click [Details].

7. Specify the margins on the front and back sides, and then click [OK].

8. Change other print settings if necessary, and then click [Save As...].

If you are modifying an existing setting and want to overwrite the previous setting, click the [Save]
button and then proceed to step 10.

9. Specify a name easily recognizable in the [Custom Setting name] box, and then click [OK].

10. Click [OK] to close the printer preference dialog box.

11. Print the document using the print function in the application.

• If the document contains pages with different original sizes, page break may occur.
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Types of duplex printing

This section explains the binding directions available when using the duplex printing function. When using
the duplex printing function, you can select whether to bind pages on an edge or in the center.

Bind on an edge

• Duplex (Open to Left)

BMF006S

• Duplex (Open to Right)

BMF007S

• Duplex (Open to Top)

BMF008S

Bind in the center

• Booklet1 (Open to Left)

Frequently Used Print Methods

69

2



BMF009S

• Booklet1 (Open to Right)

BMF010S

• Booklet1 (Open to Top)

BMF016S

• Booklet2 (Open to Left)

BMF011S
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• Booklet2 (Open to Right)

BMF012S

• Booklet2 (Open to Top)

BMF017S

• To specify Booklet1 (Open to Top) and Booklet2 (Open to Top), [Landscape] must be selected in the
[Original orientation].

Combining Multiple Pages into Single Page

This section explains how to combine multiple pages onto a single sheet of paper. When using the combine
printing function, multiple pages can be scaled and combined onto a single sheet of paper.

• The combine printing function is not available on a custom size paper. To use the combine printing
function, specify the standard size paper.

1. Create a document using an appropriate application. On the [File] menu, click [Printing
Preference...].

2. When using the existing Custom Setting, click the icon in the [Custom Setting name] box.

If you do not wish to modify the custom settings already registered in the printer driver, change settings
such as paper size and source tray as required, and then proceed to step 9.

3. Click [Add/Change Custom Settings...].
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4. Click the [Edit] tab, if it is not already selected.

5. Select the [Layout/Poster] check box, and then select the method of combining pages from
the list.

6. Specify the page order by selecting the desired icon.

7. Change other print settings if necessary, and then click [Save As...]

If you are modifying an existing setting and want to overwrite the previous setting, click the [Save]
button and then proceed to step 9.

8. Specify a name easily recognizable in the [Custom Setting name] box, and then click [OK].

9. Click [OK] to close the printer preference dialog box.

10. Print the document using the print function in the application.

• If the document contains pages with different original sizes, page break occurs.

• If the application you are using has the equivalent function, disable the function in the application. If
the function is enabled in the application, undesirable result may occur.

• For details about the combine printing such as combining pages with different orientations, see the
printer driver Help.

Types of combined printing

This section explains the different methods of the combine printing available. You can combine 2, 4, 9, or
16 pages onto a single sheet of paper. The page order can be specified from the following 4 patters.

2 pages per sheet

BMF018S
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BMF023S

BMF024S

4 pages per sheet

BMF019S

BMF020S
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BMF021S

BMF022S

Printing with Watermark/Overlay

This section explains how to print documents with text watermarks using the printer driver.

When the watermark function is enabled, image data or text string can be printed over document pages.
There are two types of watermarks available. With "Image" watermark, a bitmap image (.bmp) is printed
over the pages. "Text" watermark prints text string. You can specify only one kind of watermarks at a time.

1. Create a document using an appropriate application. On the [File] menu, click [Printing
Preference...].

2. When using the existing Custom Setting, click the icon in the [Custom Setting name] box.

If you do not wish to modify the custom settings already registered in the printer driver, change settings
such as paper size and source tray as required, and then proceed to step 8.

3. Click [Add/Change Custom Settings...].

4. Click the [Edit] tab, if it is not already selected.

5. Select the [Watermarks/Overlay] check box, and then select the type of the watermarks
from the list.

To change the watermarks setting, click [Edit].

6. Change other print settings if necessary, and then click [Save As...]

If you are modifying an existing setting and want to overwrite the previous setting, click the [Save]
button and then proceed to step 8.
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7. Specify a name easily recognizable in the [Custom Setting name] box, and then click [OK].

8. Click [OK] to close the printer preference dialog box.

9. Print the document using the print function in the application.

• Other than the watermarks already registered in the printer driver, you can create and apply your
own watermarks.

• For details about creating original watermarks, see the printer driver Help.

Types of watermarks

This section explains the types of watermarks available.

There are several text watermarks already registered in the printer driver. The following watermarks are
available.

• COPY

BMU900S

• URGENT

BMU901S

• CONFIDENTIAL
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BMU902S

• DRAFT

BMU903S

• ORIGINAL

BMU904S

Using Custom Settings

This section explains how to register and use the Custom settings.

Each function explained in this chapter is preconfigured and registered under "Custom Settings" in the [Print
Settings] tab.

You can apply the relevant setting by simply clicking on the custom setting name, and thereby eliminating
the redundant procedure to make the required changes. It also helps to avoid incorrect settings and
misprints.
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Custom settings except [Normal Print] can be added, modified, and deleted as desired. It can also be
shared and used among different users. By using the registered custom settings, the various printer functions
can be utilized without the user having the expert knowledge of the printer driver.

When using custom settings, [Color] is selected by default. Be sure to change this setting to [Black and
White] if you do not want to print in color.

For details about registering, modifying, and deleting custom settings, see the printer driver Help.
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Advanced Printing
This chapter explains various printing functions available on the printer.

Other than the [Edit] tab in the printing preference dialog box, you can also modify print settings in the
[Setup], [Finishing] and [Misc.] tabs. To change the settings explained in this section, click the following
tabs.

Settings that Can Be Changed on Each Tab

This section provides an overview of the [Setup] tab, [Finishing] tab and [Misc.] tab.

[Setup] tab

You can enable/disable the cover and slip sheets function.

• Cover sheets

Using this function, you can insert cover sheet fed from a different tray to that of the main paper,
and print on them.

• Slip Sheets

Using this function, you can insert slip sheets fed from a different tray to that of the main paper,
and print on them.

[Finishing] tab

You can enable/disable the collate function.

• Collate

When printing multiple sets of documents such as handouts for meetings, you can have prints
delivered in batches of ordered sets.

[Misc.] tab

You can change various settings for spool printing and other print options.

• Spool Printing

The print job is transmitted to the machine and temporarily stored when printing.

Printing on Cover Sheet

Using this function, you can insert cover sheet fed from a different tray to that of the main paper, and print
on them.

• To use this function, Collate must be set.

Prints the first page of the document on the sheet for the cover page.

2. Printing Documents

78

2



Print on one side

Prints on one side of the cover sheet only, even when duplex printing is selected.

BAC021S

Print on both sides

Prints on both sides of the cover sheet when duplex printing is selected.

• Cover sheet printed on both sides

BAC022S

• Cover sheet printed on one side

BAC026S

Blank

• When printing one side

BAC023S

• When printing both side
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BMU905S

• The cover sheets should be the same size and orientation as the body of the paper.

• If Auto Tray Select is set for the body paper feed tray, body paper will be delivered from a tray that
contains paper set in portrait orientation. Therefore, if the cover paper is set to landscape orientation,
the orientation of the cover and body paper will be different.

• For printing methods, see the printer driver Help.

Inserting Slip Sheets

Inserting a slip sheet between each page

• Print

BAC024S

• Blank

BAC019S

Inserting a slip sheet between OHP transparencies

• Print
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BAC025S

• Blank

BAC020S

• Collate cannot be set when using slip sheets.

• When the duplex printing or cover printing is set, you cannot insert slip sheets.

• The slip sheet should be the same size and orientation as the body paper.

• If "Auto Tray Select" has been set as the paper feed tray for the body paper, the paper will be delivered
from a tray containing paper in  orientation. Therefore, when the slip sheet has been set to 
orientation, the orientation of the output slip sheet and body paper will be different.

• The same paper feed tray cannot be set for the body of the document and slip sheets.

Staple

With the optional Booklet Finisher SR3000 or Finisher SR3030 installed, sets can be stapled individually
when printing multiple sets.

Staple position

The specified staple position varies depending on paper size, type, quantity and feed orientation. The
following table shows staple positions:
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Staple Position

BMW064S

Staple Capacity (Booklet Finisher SR3000)

Paper Size Staple Capacity

A3 , B4 JIS , 11" × 17" , 81/2" × 14" ,
81/2" × 13" , 81/4" × 13" , 8" × 13" , 8K 30

A4 , B5 JIS , 81/2" × 11" , 71/4" ×
101/2" , 16K

50

Staple Capacity (Finisher SR3030)

Paper Size Staple Capacity

A3 , B4 JIS , 12" × 18" , 11" × 17" ,
81/2" × 14" , 81/2" × 13" , 81/4" ×
13" , 8"×13" , 8K

30

A4 , B5 JIS , 81/2"×11" , 71/4" ×
101/2" , 16K

50
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Mixed Size

Mixed Paper Size
Staple Capacity (Booklet

Finisher SR3000)
Staple Capacity (Finisher

SR3030)

A3 and A4 22 30

B4 JIS  and B5 JIS 22 30

11" × 17"  and 81/2" ×
11"

22 30

81/2" × 14" , 81/2" ×
13" , and 81/2" × 11"

22 30

• When two-sided printing is selected, adjust the staple position to the binding direction.

• If you are punching at the same time, specify the same side.

• For printing methods, see the printer driver Help.

Stapling Precautions

• Stapling can be done only with the optional finisher installed.

• Staple printing will be canceled under the following conditions:

• If the number of pages to staple exceeds maximum.

• If a paper size that cannot be stapled is selected.

• If a paper type that cannot be stapled is selected.

• If positions other than those fixed for stapling are specified.

• If there are inconsistencies between the orientation in the duplex mode and the staple position.

• If there are inconsistencies between the orientation in letterhead mode and the staple position.

• When staples have run out and Auto Continue is set (Printing will continue without stapling after
the message has been displayed).

• When only 1 page is printed when staples have run out.

• If paper sizes are mixed when a different paper size is specified during a print job.

• When printing on letterhead, stapling may not be at the specified position.
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• If you cannot make staple settings even with Finisher installed, options may not be set correctly in the
printer driver. Correct option settings in the printer driver. For details, see the printer driver Help.

• When duplex printing is selected, adjust staple positions to the binding orientation.

• Depending on the software you are using, print settings may not be saved and the printed result may
not be as expected.

• When setting Staple in the printer driver settings, make sure that a collate option is not selected in the
print settings of the application. If a collate option is selected in the application, printing will not be
as intended.

• When using tracing paper, the vertical/horizontal position of the staples is opposite to the vertical/
horizontal position specified in the printer driver settings.

• Also, staples on the front cover sheet come out reversed.

Punch

By installing an optional punch unit to the optional finisher, Booklet Finisher SR3030 or Finisher 3030,
holes can be punched into printed output.

Punch position

The specified punch position varies depending on paper feed and print data orientation. The following
table shows punch positions:

Punch Position

BMW063S
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Holes Type (Booklet Finisher SR3000 and Finisher SR3030)

Type Paper Size

2 holes

A3 , A4  *1, A5 , B4 JIS , B5 JIS , 12" × 18"  *2, 11" ×
17" , 81/2" × 14" , 81/2" × 13" , 81/2" × 11" , 81/4" ×
13" , 8" × 13" , 71/4" × 101/2" , 51/2" × 81/2" , 8K , 16K

3 holes
A3 , A4 , B4 JIS , B5 JIS , 12" × 18"  *2, 11" × 17" , 81/2" ×
11" , 71/4" × 101/2" , 8K , 16K

EU 4 holes
A3 , A4 , B4 , B5 JIS , 12" × 18"  *2, 11" × 17" , 81/2" ×
11" , 71/4" × 101/2" , 8K , 16K

Northern EU 4 holes

A3 , A4 , A5 , B4 JIS , B5 JIS , 12" × 18" *2, 11" ×
17" , 81/2" × 14" , 81/2 " × 13" , 81/2" × 11" , 81/4" ×
13" , 8" × 13" , 71/4" × 101/2" , 51/2" × 81/2" , 8K , 16K

*1 Punching on A4  is not available when the  model is used with Finisher SR3030 .

*2 Punching on 12" × 18"  is available only for Finisher SR3030.

• Punch positions will vary slightly from page to page as holes are punched into each sheet individually.

• For printing methods, see the printer driver Help.

Punching Precautions

Follow these precautions when using the punch function.

• To use this function, an optional punch unit must be installed to the optional Finisher attached to the
printer.

• Punch printing will be canceled under the following conditions:

• When a paper type that cannot be punched is selected.

• When a paper size that cannot be punched is selected.

• If positions other than those fixed for punching are specified.

• If there are inconsistencies between the orientation in duplex mode and the punch position.

• If there are inconsistencies between the orientation in letterhead mode and the punch position.

• When the punch receptacle has become full and Auto Continue is set (Printing will continue
without punching after the message appears).
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• If there are inconsistencies between the staple position and the punch position, when using with
staple function.

• Punching might not be in the specified position when printing on letterhead paper.

• If you cannot make punch settings even with the optional finisher installed, options may not be set
correctly in the printer driver. Correct option settings in the printer driver. For details, see the printer
driver Help.

• When duplex print is selected, adjust the punch position to the binding direction.

• Be sure to set the punch position the same as the staple position when using it with the staple function.

• Be sure to set paper size and orientation in the printer driver when punching.

• Depending on the application, print settings may not be enabled and printed output may not be as
expected.

• When setting Punch in the printer driver settings, make sure that a collate option is not selected in the
print settings of the application.

• If a collate option is selected in the application, printing will not be as intended.

• When using tracing paper, the vertical/horizontal position of the punches is opposite to the vertical/
horizontal position specified in the printer driver settings.

Using Collate Function

The Collate function allows you to print while sorting printouts into page-ordered sets, such as when printing
multiple copies of meeting materials.

• Up to 150 pages can be stored using RAM. If the hard disk is installed, up to 1,000 pages can be
sorted.

• A hard disk is pre-installed in the HDD standard model.

Output can be assembled as sets in sequential order.

BAS053S

• If Auto Continue occurs on the first set, Collate will be canceled.

• If forced printing occurs on the first set, Collate will be canceled.
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• When setting Collate in the printer driver settings, make sure that a collate option is not selected in
the application's print settings. If a collate option is selected, printing will not be as intended.

• When setting Collate in the printer driver settings, make sure that a collate option is not selected in
the print settings of the application.

• For details about printing method, see the printer driver Help.

Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To use this function, set it from
the menu. See "Remote Maintenance by telnet".

• To use this function, the optional hard disk must be installed on the printer.

• Use the "spoolsw clear job" telnet command to clear a spooled print job. Do not turn off the printer
or computer while a print job is being spooled and the Data In is flashing. Print jobs that are interrupted
in this way remain on the printer's hard disk and will finish printing out when the printer is turned back
on.

• The Spool Printing function is available for data received using diprint, lpr, ipp, ftp, and sftp (TCP/IP
(IPv6)).

• When using diprint, the Spool Printing function cannot be used with bidirectional communication.

• The domain reserved for spool printing is about 1 GB.

• When Spool Printing is on, the size of a single print job cannot exceed 500 MB.

• When receiving jobs from multiple computers, the printer can spool a maximum of ten lpr jobs, and
only one diprint, ipp, ftp, sftp, or smb job. If the printer's spooling capacity is exceeded, newer jobs
cannot be printed. You must wait before sending further jobs.

• Printing the first page with Spool Printing will be slow.

• The computer requires less print processing time when large amounts of data are spooled.

• Stored spool jobs can be viewed or deleted using Web Image Monitor.

• The list of spool jobs cannot be viewed from the printer's control panel.

• For information about the "spoolsw clear job" command on the telnet, see "Remote Maintenance by
telnet".

• p.234 "Remote Maintenance by telnet"
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Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

• Using Web Image Monitor

In [System] on the [Configuration] menu, click [Active] in [Spool Printing].

• Using telnet

Enter "spoolsw spool on".

• For details about Web Image Monitor, see Web Image Monitor Help.

• For details about "spoolsw spool on", see Remote Maintenance by telnet.

• p.234 "Remote Maintenance by telnet"

Viewing or Deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image Monitor.

1. Open a Web browser.

2. Enter "http://(printer's address)/" in the address bar to access the printer whose settings
you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The window for entering the login user name and password appears.

4. Enter the login user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the menu area, click [Job].

A submenu will appear.

6. On the [Printer] menu, click [Spool Printing].

A list of spooled jobs appears.

7. To delete a job, select the check box of the job you want to delete, and then click [Delete].

The selected job is deleted.

8. Click [Logout].

9. Quit Web Image Monitor.

• For details about Web Image Monitor, see Web Image Monitor Help.
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Printing a PDF File Directly
You can send PDF files directly to the printer for printing, without having to open a PDF application.

There are the two methods of printing the PDF files directly, either using the DeskTopBinder Lite, or entering
commands.

• This function is possible only when the optional PostScript 3 unit is installed.

• This function is possible for genuine Adobe PDF files only.

• Version 1.3, 1.4, 1.5, and 1.6 PDF files are compatible.

• PDF files created using PDF version 1.5 Crypt Filter functions or more than eight DeviceN Color Space
components cannot be printed.

• PDF files created using PDF version 1.6 watermark note functions, or extended optional contents,
cannot be printed.

• PDF version 1.7 (Acrobat 8.0) files created without any functions that are exclusive to PDF version
1.7 can be printed.

• Due to reasons such as insufficient memory, some types of high compression PDF files might not be
printable.

• To print a document that contains transparency function data, the optional SDRAM module or hard
disk must be installed. However, the operation might still fail depending on the data contained in the
document. If this happens, use the printer driver to print the document.

• Paper size errors may occur when printing on custom size paper.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Use this procedure to install DeskTopBinder Lite.

1. Quit all applications currently running.

2. Insert the "Document Management Utility" CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

3. Click [DeskTopBinder Lite].

The [DeskTopBinder Lite] dialog box appears.
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4. Click [DeskTopBinder Lite], and then click [OK].

5. Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder Lite, restart the computer
and continue the configuration.

DeskTopBinder Lite enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files directly.

1. On the [Start] menu, point to [All Programs], [DeskTopBinder], and then click [Extended
Features Wizard].

The [Extended Features Wizard] dialog box appears.

2. Click [Start], and then click [Next>] repeatedly until the [Printing Function2] dialog box
appears.

3. In the [Printing Function2] dialog box, click [Add...].

The [PDF Direct Print Properties] dialog box appears.

4. Select the driver for this printer, and then click [OK].

The [PDF Direct Print Properties] dialog box closes.

5. Click [Next>] repeatedly until [Finish] appears.

6. Click [Finish].

Function palette

The Function palette contains buttons for functions that are already configured through DeskTopBinder
Lite enhancement. Using these buttons, you can print Windows files, preview printouts, convert images,
and register scanners for documents without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the required function and dropping
it there.

1. On the [Start] menu, point to [All Programs], [DeskTopBinder], and then click [Function
Palette].

An icon for the Function palette is added to the task tray displayed at the bottom right of the screen.

2. Right-click the new icon that has been added to the task tray, and then click [Properties].

The [Properties] dialog box appears.

3. Click the [Contents] tab, select the [PDF Direct Print] check box at the center, and then click
[OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

2. Printing Documents

90

2



PDF direct printing

Follow the procedure below to print PDF files directly.

1. Drag the PDF file you want to print to the PDF Direct Printing icon in the palette and drop it
there.

The [Output File List-PDF Direct Print] dialog box appears.

2. Highlight the PDF you want to print, and then click [OK].

The PDF file is printed.

Printing PDF password-protected documents

Follow the procedure below to print password- protected PDF files.

1. On the [Start] menu, point to [All Programs], [DeskTopBinder], and then click [Extended
Features Wizard].

The [Extended Features Wizard] dialog box appears.

2. Click [Start], and then click [Next>] repeatedly until the [Printing Function2] dialog box
appears.

3. In the [Printing Function2] dialog box, click [Properties].

The [PDF Direct Print Properties] dialog box appears.

4. Select the [Use PDF Password] check box at the bottom right of the dialog box, and then
click [OK].

5. Click [Next>] repeatedly until [Finish] appears.

6. Click [Finish].

The [Extended Features Wizard] dialog box closes.

7. Drag the PDF file you want to print over the PDF Direct Printing icon on the Function Palette
and drop it there.

The [Output File List-PDF Direct Print] dialog box appears.

8. Click on the PDF file you want to print, making it appear highlighted, and then click [OK].

The [PDF Direct Print Properties] dialog box appears.

9. In the [PDF password:] box at the bottom right of the dialog box, enter the password for
the PDF file you want to print, and then click [OK].

The password-protected PDF file is printed.

• Before printing a password-protected PDF file, perform one of the followings:

• In the [PDF Direct Print Properties] dialog box, enter the password for the PDF file you want to
print
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• Specify a password for the PDF file by selecting [Change PDF Password] in the [PDF Menu] on
the printer's control panel.

• If a [PDF Group Password] for the [PDF Menu] has been specified using DeskTopBinder Lite or the
printer's control panel, the same group password must be set on the other also.

PDF Direct Print Properties

BAC010S
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1. Setting name:

Displays the plug-in configuration name (up to 63 single byte characters)

2. Change Icon...

Changes the icon displayed on the tool bar.

3. Printer

Displays a list of RPCS drivers that support PDF direct printing.

4. Duplex

Prints on both sides of sheets.

5. Layout

Prints multiple pages on a single sheet.

6. Punch (not available for this printer)

Punches holes in printed sheets.

7. Staple (not available for this printer)

Staples together printed sheets.

8. Display this dialog box before printing

Appears in PDF direct printing mode if this check box is selected.

9. Orientation:

Specify the original's orientation.
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10. Number of copies

Specify the number of copies to print.

11. Collate

Sorts printed sheets.

12. Range

Specify which paper to print.

13. Printout paper size:

Specify the paper size you want copies to be printed onto.

14. Color/Black and White:

Specify color or black-and-white printing.

15. Resolution:

Specify a print resolution.

16. PDF password:

Enter the password for password-protected PDF files. A password-protected PDF file cannot be printed
unless its password is entered here.

17. Group password:

If a group password is assigned to DeskTopBinder Lite and this printer, enter the group password in this
field. The group password must be entered for printing to start.

Using Commands

You can print PDF files directly, using commands such as "ftp", "sftp", and "lpr".

For details about UNIX commands, see UNIX supplement.
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Unauthorized Copy Control
You can embed patterns and text under printed text to prevent unauthorized copying of the document.
Unauthorized Copy Control consists of two functions: [Data security for copying] and [Mask type:].

• This function is designed to discourage copying of confidential documents; it does not prevent
unauthorized use of information.

Opening the Unauthorized Copy Control Window

1. In the RPCS printer driver, open the [Printing Preference] window.

2. Click [Add/Change Custom Settings...].

3. Select the [Unauthorized copy...] check box.

4. Click [Control Settings...].

The Unauthorized Copy Control window appears.

• For details, see the printer driver Help.

Using [Data security for copying]

You can embed a print pattern by setting it in the printer driver.

Setting [Data security for copying] in the printer driver

• Select the [Data security for copying] check box. You can also enter the text in the [Text:] box.

• You cannot select the [Mask type:] check box at the same time.

• To print a document protected by gray overprint, the printer must be set up correctly. Contact
your administrator.
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Printing a document using [Data security for copying]

BEK229S

1. The pattern and text you have set is printed.

2. The document is copied or stored in copiers / multifunction machines which the optional Copy
Data Security unit is installed.

3. The document is blanked by vertical stripes overprint.

• When printing a document that is set with [Data security for copying], the printer does not require the
optional Copy Data Security unit to be installed. The Copy Data Security unit is required when copying
or storing a document protected by vertical stripes overprint.

• Only the RPCS printer driver is supported.

• Printing at 200  200 dpi is not possible.

• You cannot partially embed a pattern and text in a document.

• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.

• Use 182  257 mm (71/4  101/2 inches) or larger paper.

• Use ordinary or recycled paper of at least 70% whiteness.

• Duplex printing may interfere with this function as a result of text and patterns being visible through
the paper.

• For details about setting [Data security for copying], see the printer driver Help.

Unauthorized Copy Control

95

2



Using [Mask type:]

You can embed patterns and texts in a document by setting in the printer driver to prevent unauthorized
copying.

Setting [Mask type:] in the printer driver

• Select a pattern from [Mask type:], and then enter texts in the [Text:] box.

• You can select overprint color from [Black], [Cyan], or [Magenta] in the [Color:] list.

• You can set only [Text:], but [Mask type:] and [Text:] must be set together.

Printing a document using [Mask type:]

BEK228S

1. The pattern and text you have set is printed palely.

2. The document is copied, scanned, or stored in copiers/ multifunction machines.

3. The pattern and text you have set appear clearly.

• Only the RPCS printer driver is supported.

• Printing at 200  200 dpi is not possible.

• You cannot partially embed patterns and texts strings in a document.
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• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.

• Due to the effects of the settings, the results of copying, scanning, and saving documents in the
document server may vary depending on the printer model and setting conditions.

• Printing with background patterns and texts may be slower than normal printing.

• For details about setting [Mask type:], see the printer driver Help.

Important Notice

• The supplier does not provide warranty regarding the appearance of print patterns and other copy
protection features. The appearance of the print patterns and the performance of Unauthorized Copy
Control may vary depending on the quality of paper used and the printer model and settings.

• The supplier takes no responsibility for any damages sustained in connection with use of or inability
to make use of Unauthorized Copy Control print patterns.
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Specifying the Classification Code for a Print Job
When printing in an environment where classification codes are required, a classification code must be
specified for each print job.

• The PostScript 3 printer driver does not support the classification codes and it cannot be used to print
under environment which the classification codes are required.

For the RPCS printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Print Settings] or [Setup] tab.

3. Click [Details...].

If you select [Send to Job Binding] in the [Job type:] box, you cannot enter a classification code.

4. Enter the classification code in the [Classification code:] box, and then click [OK].

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

5. Make any other necessary print settings, and then click [OK].

6. A confirmation message appears. Read it, and then click [OK].

7. Execute the print command.

8. The print job is sent to the printer.

For the PCL printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Valid Access] tab.

3. Enter the classification code in the [Classification Code:] box.

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

4. Make any other necessary print settings, and then click [OK].

5. A confirmation message appears. Read it, and then click [OK].

6. Execute the print command.

7. The print job is sent to the printer.

• The specified classification code is stored in the printer driver.

• To switch between different classification codes, install the printer driver under different names, and
specify different classification code for each driver.
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• p.24 "Installing the Printer Driver"

• p.64 "Displaying the Printer Driver Setting Screen"
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Using the Virtual Printer
This section explains virtual printer functions.

A virtual printer is a pseudo printer that can only be recognized on a network. The virtual printer has various
print options, such as feeding tray selection and duplex printing, which you can set in advance. You can
also use the interrupt printing function. This function suspends the ongoing job and gives priority to a new
job. The optional hard disk must be installed to use this function.

If you use the virtual printer under UNIX, Solaris, and other operating systems, various print functions are
possible without having you manually enter usual print commands.

Adding a Virtual Printer

Use this procedure to add a virtual printer.

• Adding a virtual printer requires Administrators privilege. Log on using an account that has
Administrators privilege.

• The following Virtual Printer protocols are available: "TCP/IP (Unspecified, Normal)", "TCP/IP
(DIPRINT)", "TCP/IP (RHPP)", "Apple Talk", and "NetWare".

1. Log on to Web Image Monitor as an administrator.

2. In the menu area, click [Configuration], and then click [Virtual Printer Settings ]in the "Printer"
category.

A list of the available virtual printers appears.

3. Click [Add].

The screen for adding virtual printers appears.

4. In [Virtual Printer Name], enter a name for the new printer, and then select the protocol in
the [Protocol] list.

5. Click [OK].

The virtual printer is added.

• If you select [AppleTalk] or [NetWare] in the [Protocol] list, you cannot specify a virtual printer name.

• You can specify a virtual printer name using up to 47 characters.

• You can add up to 50 virtual printers. After 50 virtual printers have been added, [Add] will no longer
be displayed.

• For details about login user names and passwords, see "Using Web Image Monitor".
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• p.197 "Using Web Image Monitor"

Changing a Virtual Printer Configuration

Use this procedure to change a virtual printer configuration.

• You must have Administrators privilege to change the configuration of a virtual printer. Log on using
an account that has Administrators privilege.

1. Log on to Web Image Monitor as an administrator.

2. In the menu area, click [Configuration], and then click [Virtual Printer Settings] in the "Printer"
category.

A list of the available virtual printers appears.

3. Select the virtual printer whose configuration you want to change, and then click [Change].

If you want to configure this virtual printer for an interrupt printer, select [TCP/IP (Unspecified, Priority)]
in the protocol list.

4. Change the configuration as required.

5. Click [OK].

• For details about virtual printer configuration, see Web Image Monitor Help.

• For details about login user names and passwords, see "Using Web Image Monitor".

• p.197 "Using Web Image Monitor"

Confirming a Virtual Printer Configuration

Use this procedure to confirm a virtual printer configuration.

1. Start Web Image Monitor.

2. In the menu area, click [Configuration], and then click [Virtual Printer Settings] in the "Printer"
category.

A list of available virtual printers appears.

3. Select the virtual printer whose configuration details you want to confirm, and then click
[Details].

A configuration list for the selected virtual printer appears.
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• [Details] is not displayed if you log on to Web Image Monitor as an administrator. To confirm a virtual
printer configuration, click [Change].

• For details about login user names and passwords, see "Using Web Image Monitor".

• p.197 "Using Web Image Monitor"

Deleting a Virtual Printer

Use this procedure to delete a virtual printer.

• You must have Administrators privilege to delete a virtual printer. Log on using an account that has
Administrators privilege.

1. Log on to Web Image Monitor as an administrator.

2. In the menu area, click [Configuration], and then click [Virtual Printer Settings] in the "Printer"
category.

The list of available virtual printers appears.

3. Select the virtual printer that you want to delete, and then click [Delete].

The delete confirmation screen appears.

4. Click [OK].

• You cannot delete this printer's default virtual printer.

• [Delete] appears only if you have already added a virtual printer.

• For details about login user names and passwords, see "Using Web Image Monitor".

• p.197 "Using Web Image Monitor"

Printing Using a Virtual Printer

To print directly from a specified virtual printer, assign the virtual printer in the print command. If you use
the interrupt printing function, enter the name of the virtual printer that you configured for interrupt printing.
Before printing for the first time, specify the virtual printer you want to use.

1. Log on to Web Image Monitor in administrator mode.
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2. In the menu area, click [Configuration], and then click [Basic Settings] in the "Printer"
category.

3. Select [Active] in [Virtual Printer], and then click [OK].

4. Send a command from your computer.

lpr

C:\>lpr -S "printer's IP address" [-PVirtual Printer Name] [-ol] \path name\file name

rcp

c:> rcp [-b] \path name\file name [\path name\file name...] printer's host name:["Virtual Printer
Name"]

ftp

ftp> put \path name\ file name Virtual Printer Name

• When the ongoing job meets any of the following conditions, interrupt printing is not possible even if
you print with the virtual printer that is configured for interrupt printing. The printer waits to print a new
job until it finishes printing the current job.

• When the staple function is specified for the ongoing print jog

• When the ongoing print job is performed using the bypass tray

• When a function related to cover or slip paper is specified for the ongoing print job

• If a large amount of memory is used for the ongoing print job or a large number of sheets are being
printed, there may not be enough memory to process an interrupt print job, or only part of the interrupt
job may be printed. If this happens, certain functions for the interrupt job, such as stapling or storing
data onto the printer, can be canceled or sheets can be sorted in a number smaller than the standard
maximum capacity.

• For details about login user names and passwords, see "Using Web Image Monitor".

• p.197 "Using Web Image Monitor"
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Memory Capacity and Paper Size
Additional memory apart from the standard memory may be required depending on the paper size and
data type. The following tables provide primary examples of printable paper sizes.

One-sided printing (600 × 600 dpi)

Memory Capacity Printable paper sizes

512 MB (standard)
12" × 18", A3, B4, A4, B5, A5, 11" × 17",
81/2" × 14", 81/2" × 11", 216 × 432 mm, 297 ×
432 mm

768 MB (standard and 256 MB)
12" × 18", A3, B4, A4, B5, A5, 11" × 17",
81/2" × 14", 81/2" × 11", 216 × 432mm, 297 ×
432 mm, 305 × 1260 mm

1024 MB (standard and 512 MB)
12" × 18", A3, B4, A4, B5, A5, 11" × 17",
81/2" × 14", 81/2" × 11", 216 × 432mm, 297 ×
432 mm, 305 × 1260 mm

Duplex printing (600 × 600 dpi)

Memory Capacity Printable paper sizes

• 512 MB (standard)

• 768 MB (standard and 256 MB)

• 1024 MB (standard and 512 MB)

A3, B4, A4, B5, A5, 11" × 17", 81/2" × 14",
81/2" × 11"
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Black and White [Printing] when [Photograph]
or [DTP] is Selected for [Document type]
If you select [Photograph] or [DTP] for [Document type] in the [Printing Preferences] dialog box, black areas
of text and line art might be detected as color images, depending on the application you are using. If this
happens, the document might be printed and counted as a CMYK image.

To print and count the document as a Black and White image, use the following procedure to set the color
to black and white in the printer driver.

1. In the printer driver's [Printing Preferences] dialog box, click the [Print Quality] tab.

2. Select the [User settings] check box.

3. In the list box, select a user setting.

4. Click [Change User Settings...].

5. On the [Image Adjustments] tab, select a document type in the [Load document types:] list.

The following document types are selectable:

[Photograph (Quality)], [Photograph (Speed)], [Photograph (High Speed)], [DTP (Quality)], [DTP
(Speed)], and [DTP (High Speed)].

6. In the [Gray reproduction (Text/Line Art):] list, select [K (Black)].

The gray reproduction is set to pure black, and the [Load document types:] list becomes blank.

If you select the [Print as bitmap] check box on the [Misc.] tab, the gray reproduction setting is ignored,
and black areas of text and line art are printed and counted as CMYK images.

7. Click [OK].

• Black areas of text and line art that were produced using colors other than black and grey are printed
out and counted as CMYK images even if they appear as black or grey on the screen.

Black and White [Printing] when [Photograph] or [DTP] is Selected for [Document type]
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If Error Occurs with the Specified Paper Size and
Type
This section gives instructions for operating the printer when there is no tray for the selected paper size or
type, or when paper loaded in the printer has run out.

• The tray cannot be changed if the following functions are set:

• Duplex Print to a tray that does not support duplex printing

• Cover Sheet

• Slip Sheet

• If form feed is selected for a tray with the following settings, you can change the tray by canceling
the settings:

• Duplex Print

• Staple

• If [Auto Continue] is selected, form fed paper is printed after a set interval. For details, see System
Menu.

• p.166 "System Menu"

Printing from a Selected Tray

If the printer does not have a tray for the selected paper size or paper type, or if the selected paper loaded
in the printer has run out, a caution message appears. If this message appears, do the following procedure.

1. When the caution message appears, press [FormFeed].

A confirmation message appears.

2. Press the [OK] key.
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3. Select the tray for form feed using the [ ] or [ ] key from those that appear on the display
panel, and then press the [OK] key.

• If a tray with a smaller paper size is selected, the print job may be cut short, or other problems may
occur.

Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form feed appears.

1. Press [JobReset].

2. Press [Current].

The confirmation message appears.

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

4. Press [No] to return to the previous display.
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• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• Under Windows, If the printer is connected to the computer using a parallel cable, sent print jobs may
be canceled if the [Job Reset] key is pressed while "Waiting..." is displayed on the control panel. After
the interval set in [I/O Timeout] in [Host Interface] has passed, the next print job can be sent. A print
job sent from a different client computer will not be canceled in this case.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press the [Job Reset] key.

• A print job containing a large volume of data may take considerable time to stop.

• To stop data printing, see "Canceling a Print Job".

• p.129 "Canceling a Print Job"

2. Printing Documents
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3. Printing Stored Documents
This chapter explains how to print documents stored in the machine.

Using the Print Job Function
This describes how to print or delete files stored in the printer. There are following types of print files: Sample
Print, Locked Print, Hold Print, and Stored Print.

Print files sent from computers can be stored in the hard disk of the printer. Using the Print Job function, you
can print or delete the print files.

• To use this function, the optional hard disk must be installed on the printer.

• A hard disk is pre-installed in the HDD standard model.

Print Job screen

When the printer is turned on, the following screen appears if an optional hard disk is installed in the printer.

If you press [Prt.Jobs] on the initial screen, a screen prompting to select the type of print job appears.

After selecting a type, you can select print files in the list by pressing:

• [Job List]

Displays the Job List screen.

• [User ID]

Displays the User ID screen.

If you select Sample Print, Locked Print, and Hold Print, the print files saved in the printer are deleted after
printing is completed. If you select Stored Print, the files remain in the printer even after printing is finished.
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Job List Screen

BEK216S

1. The type of print jobs

Displays the type of the print job you select.

2. Page number

Displays the current page number. Each time pressing the [ ] or [ ] key, the screen switches.

3. User ID, Date/Time, and File Name display

• User ID shows the user's ID set by the printer driver.

• Date and Time show the time at which the print job was stored in the printer.

• File name shows the name of the file. However, "****" is shown instead of the file name for a Locked Print
file.

4. [Print]

Prints a selected file.

5. [Change]

Changes or clears the password of a file if a password is set. To change the password of a Locked/Stored Print
job, press [Change], enter the current password, and then enter the new password on the confirmation screen.
To clear the password, press [Change], leave the entering/confirming a new password box blank, and then
press the [OK] key.

You can also set passwords to the Stored Print files that do not currently have passwords.

6. [Delete]

Deletes a selected file.

• When you press [Change] to change or clear a password, you must first enter the existing password.
If the password you entered is incorrect, you cannot change or clear any current passwords.

• You can use [Change] to set or clear passwords only when Stored Print files are stored in the printer.

3. Printing Stored Documents

110

3



User ID Screen

BEK217S

1. The type of print jobs

Displays the type of the print job you select.

2. Page number

Displays the current page number. Each time pressing the [ ] or [ ] key, the screen switches.

3. User ID

• User ID shows the ID of the user who stored the selected type of files.

• User ID set by the printer driver is shown.

4. [PrintAll]

Prints all files stored by the user whose user ID has been selected.

5. [Job List]

Switches the screen to the [Job List] screen.

Displays the print jobs of the selected user only.

• To cancel selecting a file, press the [JobReset] key.

• The display is not updated if a new file is stored while the list of stored files is displayed. To update
the display, press the [Menu] key to return to the initial screen, and then press [Prt.Jobs] again.

• If a large number of print jobs are stored in the printer, processing may slow temporarily, depending
on which functions are used.

• For details about printing each type of print job, see the followings:

• p.112 "Sample Print"

• p.115 "Locked Print"

• p.118 "Hold Print"

• p.121 "Stored Print"

Using the Print Job Function
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Printing from the Print Job Screen
This section gives instruction about Sample Print, Locked Print, Hold Print, and Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you have checked the result,
remaining sets can be printed or canceled using the printer's control panel. This can reduce misprints due
to mistakes in content or settings.

• A Sample Print file cannot be stored if:

• the hard disk is not installed in the printer.

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• A hard disk is pre-installed in the HDD standard model.

• If a Sample Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the[ Auto Del.
Temp. Print Jobs] or [Auto Del Stored Print Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Sample Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• If the first set of the Sample Print files is not as you expected and you do not want to print remaining
sets, delete the Sample Print file using the display panel. If you print the remaining sets of the Sample
Print file, the job in the printer is deleted automatically.

• Sample Print files printed or deleted using Web Image Monitor, after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• For details about the error log on the display panel, see p.195 "Checking the Error Log".

3. Printing Stored Documents
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• For details about [Auto Del. Temp. Print Jobs] and [Auto Del Stored Print Jobs], see p.154
"Maintenance Menu".

Printing a Sample Print file

The following procedure describes how to print a Sample Print file with the PCL 6/5c, RPCS or PostScript
3 printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. From an application, select a command to print.

The Print dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

3. In the [Job type:] box, click [Sample Print].

When printing with the PostScript 3 printer driver, click [Sample Print] in the [Job type:] box on the
[Job Log] tab.

4. Click [Details...], and then enter a user ID in the [User ID:] box.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

5. Execute a command to print.

Make sure to set more than two copies.

The Sample Print job is sent to the printer, and the first set is printed.

6. On the printer's control panel, press [Prt.Jobs].

7. Select [Sample Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Sample Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

Printing from the Print Job Screen
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You can print files also by pressing [User ID].

8. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

Enter the new number of sets using the scroll keys. You can enter up to 999 sets.

Press the [Escape] key to correct any entry mistakes.

9. Press [Print].

The remaining sets are printed.

To cancel printing, press [Cancel].

• If the set quantity is changed when [User ID] is pressed in step 7, the changed quantity is applied to
all selected files.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about [User ID], see p.126 "Printing from the User ID Screen".

Deleting Sample Print files

If you are not satisfied with the sample printout, you can delete the Sample Print file, revise it and print it
again until the settings are suitable.

1. Press [Prt.Jobs].

2. Select [Sample Print Jobs] using the [ ] or [ ] key, and then press [Job List].

3. Printing Stored Documents
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A list of Sample Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The delete confirmation screen will appear.

4. Press [Delete].

The selected file is deleted.

To cancel printing, press [Cancel].

Locked Print

Use this function to maintain privacy when printing confidential documents on the printer over a shared
network. Usually, it is possible to print data using the display panel once it is stored in this printer. When
using Locked Print, it is not possible to print unless a password is entered on the printer's display panel.
Your confidential documents will be safe from being viewed by other people.

• A Locked Print file cannot be stored if:

• the hard disk is not installed in the printer.

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• A hard disk is pre-installed in the HDD standard model.

• If a Locked Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents remain. However, the [Auto Del. Temp. Print Jobs]
or [Auto Del Stored Print Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. Locked
Print jobs are automatically collated by the printer driver as default. If a collate option is selected in
the application print dialog box, more sets than intended may be printed.

• After the Locked Print file is printed, the job is automatically deleted.

Printing from the Print Job Screen
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• Locked Print files printed or deleted using Web Image Monitor, after you select [Locked Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Locked Print files.

• For details about the error log on the display panel, see p.195 "Checking the Error Log".

• For details about [Auto Del. Temp. Print Jobs] and [Auto Del Stored Print Jobs], see p.154
"Maintenance Menu".

Printing a Locked Print file

The following procedure describes how to print a Locked Print file with the PCL 6/5c, RPCS or PostScript
3 printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure the Locked Print in the printer driver's properties.

For details about configuring the printer drivers, see the corresponding Help files.

2. Start printing from the application's Print dialog box.

The Locked Print job is sent to the printer.

3. On the printer's control panel, press [Prt.Jobs].

4. Select [Locked Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Locked Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID].

3. Printing Stored Documents
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5. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The password screen appears.

6. Enter the password using the [ ], [ ],[ ] or [ ] key, and then press the [OK] key.

The print confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

If you forget your password, contact your administrator for help.

7. Press [Print].

The remaining sets are printed.

To cancel printing, press [Cancel].

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about [User ID], see p.126 "Printing from the User ID Screen".

Deleting Locked Print files

1. Press [Prt.Jobs].

Printing from the Print Job Screen
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1. Select [Locked Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Locked Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

2. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The password screen appears.

3. Enter the password using the [ ], [ ],[ ] or [ ] key, and then press the [OK] key.

The delete confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

If you forget your password, contact your administrator for help.

4. Press [Delete].

The selected file is deleted.

To cancel printing, press [Cancel].

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's control
panel later.

• A Hold Print file cannot be stored if:

3. Printing Stored Documents
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• the hard disk is not installed in the printer.

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• A hard disk is pre-installed in the HDD standard model.

• If a Hold Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Del.
Temp. Print Jobs] or [Auto Del Stored Print Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Hold Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Hold Print files printed or deleted using Web Image Monitor, after you select [Hold Print] using the
control panel will appear on the display panel. However, an error message will appear if you try to
print or delete those Hold Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily. If you enter the
document name on the printer driver's [Details...], that name appears on the display panel.

• It is possible, but not required, to set a file name or a password to a Hold Print file.

• For details about the error log on the display panel, see p.195 "Checking the Error Log".

• For details about [Auto Del. Temp. Print Jobs] and [Auto Del Stored Print Jobs], see p.154
"Maintenance Menu".

Printing a Hold Print file

The following procedure describes how to print a Hold Print file with the PCL 6/5c or RPCS printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure Hold Print in the printer driver's properties.

For details about configuring the printer drivers, see the relevant Help files.

2. Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a file name. The file name you set will be displayed on the printer's Job List screen.

Printing from the Print Job Screen
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3. Start printing from the application's Print dialog box.

The Hold Print job is sent to the printer and stored.

4. On the printer's control panel, press [Prt.Jobs].

5. Select [Hold Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Hold Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID].

6. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The confirmation screen appears.

7. Press [Print].

The Hold Print file is printed.

To cancel printing, press [Cancel].

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a Hold
Print file from Web Image Monitor. For details, see Web Image Monitor Help.

• For details about [User ID], see p.126 "Printing from the User ID Screen".

3. Printing Stored Documents
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Deleting Hold Print files

1. Press [Prt.Jobs].

2. Select [Hold Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Hold Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The confirmation screen appears.

4. Press [Delete].

The selected file is deleted.

To cancel printing, press [Cancel].

Stored Print

Use this function to store a file in the printer, and then print it from the computer or the printer's control panel
later.

Jobs are not deleted after they are printed, so the same job need not be resent in order to print multiple
copies.

• A Stored Print file cannot be stored if:

• the hard disk is not installed in the printer.

Printing from the Print Job Screen
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• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• A hard disk is pre-installed in the HDD standard model.

• If a Stored Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Del.
Temp. Print Jobs] or [Auto Del Stored Print Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Stored Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Stored Print files printed or deleted using Web Image Monitor, after you select [Stored Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Stored Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• If you enter the document name on the printer driver's [Details...], that name appears on the display
panel.

• For details about the error log on the display panel, see p.195 "Checking the Error Log".

• For details about [Auto Del. Temp. Print Jobs] and [Auto Del Stored Print Jobs], see p.154
"Maintenance Menu".

Printing a Stored Print file

The following procedure describes how to print a Stored Print file with the PCL 6/5c or RPCS printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure the Stored Print in the printer driver's properties.

You can select two ways for Stored Print:

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Store and Normal Print] (or [Store and Print])

Prints the file at once and also stores the file in the printer.

3. Printing Stored Documents
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For details about configuring the printer drivers, see the relevant Help files.

2. Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a password. The same password must be entered when printing or deleting.

You can also set a file name. The file name you set will be displayed on the printer's Job List screen.

3. Start printing from the application's Print dialog box.

The Stored Print job is sent to the printer.

4. On the printer's control panel, press [Prt.Jobs].

5. Select [Stored Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Stored Print files stored in the printer appears.

You can print files also by pressing [User ID].

6. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The confirmation screen appears.

If you set a password in the printer driver, a password confirmation screen appears. Enter the
password.

7. Press [Print].

The Stored Print file is printed.

To cancel printing, press [Cancel].

Printing from the Print Job Screen
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• When multiple files are selected without setting a quantity, one set less than the minimum number of
all settings is applied. If the least number of settings is one set, all selected files will be printed at one
set.

• If the number of set quantity is changed when [User ID] is pressed in step 5, the changed quantity is
applied to all selected files.

• To stop printing after printing has started, press the [Job Reset] key. A Stored Print file is not deleted
even if the [Job Reset] key is pressed.

• The Stored Print file that sent to the printer is not deleted unless you delete a file or select [Auto Del
Stored Print Jobs].

• You can set or delete a password after sending files to the printer. Select the file and press [Change]
in the Print Job List screen. To set a password, enter the new password. To delete the password, leave
the password box blank on entering or confirming the new password, and press the [OK] key.

• For details about the [Auto Del Stored Print Jobs], see p.154 "Maintenance Menu".

• For details about [User ID], see p.126 "Printing from the User ID Screen".

Deleting stored print files

1. Press [Prt.Jobs].

2. Select [Stored Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Stored Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Printing Stored Documents
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3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The delete confirmation screen will appear.

If you set the password in the printer driver, enter the password to delete.

If you forget your password, contact your administrator for help.

4. Press [Delete].

The selected file is deleted.

To cancel printing, press [Cancel].

Printing from the Print Job Screen
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Printing from the User ID Screen
This describes how to print the files saved in the printer from the User ID screen.

Printing the Selected Print Job

1. On the initial screen, press [Prt.Jobs].

2. Press [User ID].

A list of user IDs whose files are stored in the printer appears.

3. Select the user ID whose file you want to print using the [ ] or [ ] key, and then press [Job
List].

The print job list of the selected user ID appears.

4. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The confirmation screen appears.

5. Press [Print].

The selected file is printed.

3. Printing Stored Documents
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To cancel printing, press [Cancel].

• If you print a Sample, Locked, or Hold Print file, the print file saved in the printer is deleted after printing
is completed.

• For details about printing each type of print job, see the followings:

• p.112 "Sample Print"

• p.115 "Locked Print"

• p.118 "Hold Print"

• p.121 "Stored Print"

Printing All Print Jobs

1. On the initial screen, press [Prt.Jobs].

2. Select a type of print jobs you want to print using the [ ] or [ ] key, and then press [User
ID].

A list of user IDs whose files are stored in the printer appears.

3. Select the user ID whose file you want to print using the [ ] or [ ] key, and then press
[PrintAll].

The confirmation screen appears.

Printing from the User ID Screen
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4. Press [Print].

The selected files are printed.

To cancel printing, press [Cancel].

• If you print a Sample, Locked, or Hold Print file, the print file saved in the printer is deleted after printing
is completed.

• You cannot select a print job that is not stored under the selected user ID.

• When printing multiple Sample Print files without specifying the number of sets on the confirmation
screen, one set less than the least number of set specified on the computer is applied for every selected
document. If the number of sets specified on the computer is "1", one set each is printed for every
document.

• When printing multiple Stored Print files without specifying the number of sets on the confirmation
screen, the least number of set specified on the computer is applied for every selected document.

• If you select [Locked Print Jobs], enter the correct password. If there are multiple passwords, the printer
prints only files that correspond to the entered password.

• If you select Stored Print files, and some of these require a password, the printer prints files that
correspond to the entered password and files that do not require a password.

• For details about printing each type of print job, see the followings:

• p.112 "Sample Print"

• p.115 "Locked Print"

• p.118 "Hold Print"

• p.121 "Stored Print"

3. Printing Stored Documents
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Canceling a Print Job
You can cancel printing from either the printer or a client computer. Since canceling procedures vary
depending on the print job status, check the job status and cancel printing according to the following
procedure.

Canceling a Print Job Using the Control Panel

1. Press [JobReset].

A confirmation message appears.

2. Press [Current].

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not completed.

1. Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

2. Select the name of the job you want to cancel.

3. On the [Document] menu, click [Cancel].

Canceling a Print Job
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• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• If the printer is connected to the computer using a parallel cable, sent print jobs may be canceled if
[JobReset] is pressed while "Waiting..." is displayed on the control panel. After the interval set in [I/
O Timeout] in Printer Features has passed, the next print job can be sent. A print job sent from a different
client computer will not be canceled in this case.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.

Mac OS - Canceling a Print Job from the computer

1. Double-click the printer icon on the desktop.

A window appears showing all print jobs that are currently queuing to be printed. Check the current
status of the job you want to cancel.

Under Mac OS X, start Print Center.

2. Select the name of the job you want to cancel.

3. Click the pause icon, and then click the trash icon.

• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• If the printer is connected to the computer using a parallel cable, sent print jobs may be canceled if
[JobReset] is pressed while "Waiting..." is displayed on the control panel. After the interval set in [I/
O Timeout] in Printer Features has passed, the next print job can be sent. A print job sent from a different
client computer will not be canceled in this case.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.

3. Printing Stored Documents
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4. Direct Printing from a Digital Camera
(PictBridge)
This chapter explains how to print photographs directly from a digital camera by using a USB cable and
a camera direct print card.

What is PictBridge?
You can connect a PictBridge-compatible digital camera to this printer using a USB cable. This allows you
to print photographs taken using the digital camera directly by operating the digital camera.

BMV051S

Before you can use this function, the printer requires a camera direct print card.

• Check your digital camera is PictBridge-compatible.

• Up to 999 images can be sent from the digital camera to the printer during one print transaction. If
an attempt is made to send more images, an error message is sent to the camera and printing fails.

• Since printing conditions are specified on the digital camera, specifiable parameters depend on the
particular digital camera. For details, see your digital camera's manual.
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PictBridge Printing
Follow the procedure below to start PictBridge printing on this printer.

• Do not disconnect the USB cable while data is being sent. If you do, printing will fail.

• The USB host interface board is supplied with a USB cable and a hook onto which you can roll up
and hang the cable.

1. Check the printer and the digital camera are both switched on.

2. Connect a USB cable between the printer and the digital camera.

The Data In indicator on the printer blinks for several seconds, and “PctBrdg” is displayed on the
printer. This indicates that the printer has correctly recognized the digital camera.

3. On your digital camera, select the images you want to print, and specify the printing
conditions.

4. The printer receives settings from the digital camera and starts printing.

• Since printing conditions are specified on the digital camera, specifiable parameters depend on the
particular digital camera. For details, see the digital camera's manual.

• Some digital cameras require settings for manual PictBridge operation. For details, see your digital
camera's manual.

• For details about connection instructions, see Hardware Guide.

• To cancel printing, see p.129 "Canceling a Print Job".
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What Can Be Done on This Printer
This printer can perform the following functions using its PictBridge feature.

The settings available for these functions are as follows:

• Single image printing

• Selected image printing

• All image printing

• Index printing

• Trimming

• Date and file name printing

• Paper size

• Image print size

• Multi-Image-Layout

• Printing quality

• Color matching

• Paper type specification

• Form printing

• Camera memo printing

• This printer does not support the following settings:

• DPOF printing

• Margin-less printing

• The setting parameters and their names may vary depending on the digital camera. For details, see
your digital camera's manual.

Index Printing

A3 (297 × 420)

Horizontal images × vertical images (in) Paper orientation

12 × 16

What Can Be Done on This Printer
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A4 (210 × 297)

Horizontal images × vertical images (in) Paper orientation

8 × 12

12 × 8

A5 (148 × 210)

Horizontal images × vertical images (in) Paper orientation

5 × 8

8 × 5

Letter (81/2"×11")

Horizontal images × vertical images (in) Paper orientation

8 × 10

10 × 8

• Index printouts vary depending on the orientation of the paper placed on the specified size tray.

• Depending on the digital camera, a form feed may be inserted after one set of images belonging to
one type ends.

• The number of images in each size of paper is fixed.

Trimming

Use this function to print only the inside of the trimming area specified on the digital camera.
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BPD204S

In the above figure, “- - -“ (dashed lines) indicates the trimming area.

Date and File Name Printing

Use this function to print the date and/or file name under the image.

BPD205S

In the above figure, "aaaaa" indicates the file name and "bbbbb" indicates the date.

Paper Size

Use this function to print on paper with the size specified on the digital camera.

Paper size name Actual size

Postcard 148 mm × 100 mm

Letter (81/2"×11") 279.4 mm × 216 mm (8 1/2 × 11)

A3 420 mm × 297 mm

A4 297 mm × 210 mm

A5 210 mm × 148 mm
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Paper size name Actual size

A6 148 mm × 105 mm

B4 257 mm × 364 mm

B5 257 mm × 182 mm

B6 182 mm × 128 mm

• For details about specifying custom sizes, see Hardware Guide.

Image Print Size

Use this function to print images with the size specified on the digital camera.

BPD206S

indicates the image size specified on the camera.

You can specify the following image print sizes:

Fixed size

• 3.25" × 2.5"

• 5" × 2.5"

• 6" × 4"

• 7" × 5"

• 10" × 8"

• 254 mm × 178 mm

• 110 mm × 74 mm

• 89 mm × 55 mm

• 148 mm × 100 mm
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• 8 cm × 6 cm

• 10 cm × 7 cm

• 13 cm × 9 cm

• 15 cm × 10 cm

• 18 cm × 13 cm

• 21 cm × 15 cm

• 24 cm × 18 cm

• An error occurs if the specified size is larger than the actual paper size.

Multi-Image-Layout

Use this function to print multiple images on the specified paper.

BPD207S

The number of images that can be printed on one page is as follows:

Paper size Number of images that can be specified

Postcard 2, 4

Letter (81/2"×11") 2, 4, 8, 9, 16, 25, 32

A3 2, 4, 8, 9, 16, 25, 32, 36, 49, 64

A4 2, 4, 8, 9, 16, 25, 32

A5 2, 4, 8, 9, 16

A6 2, 4, 8

B4 2, 4, 8, 9, 16, 25, 32, 36, 49
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Paper size Number of images that can be specified

B5 2, 4, 8, 9, 16, 25

B6 2, 4, 8, 9

The number and arrangement of images that can be specified are as follows:

Number of images
Vertical images × horizontal

images
Paper orientation

2 2 × 1

4 2 × 2

8 4 × 2

9 3 × 3

16 4 × 4

25 5 × 5

32 8 × 4

36 6 × 6

49 7 × 7

64 8 × 8

• A form feed may be inserted between images depending on the digital camera in use.

• Printing in the specified way may not be possible depending on the specification for the number of
images to be printed.

Printing Quality

Use this function to print images at the selected printing quality.

If you select [Default] or [Normal], the printer prints in normal quality; if you select [Fine], the printer prints
in the best quality.
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Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the printer prioritizes gradation for color matching, if you select [ON], the
printer prioritizes saturation.

Paper Type Specification

This function sends the printer's paper type information to the digital camera. The names of paper types
displayed on the digital camera's screen are different to the names displayed on the printer. Use the table
below to match the paper types.

To display a paper type name on the digital camera's screen, use the printer's control panel to set the paper
type of the printer correctly.

The paper type detected by the digital camera The paper type of the printer

Default All type of paper

Plain Paper Plain or recycled paper

Fast Photo Paper Glossy paper

Form Printing

Use this function to print images in a predetermined layout format.

BPD208S

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the image.
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Exiting PictBridge
Follow the procedure below to quit the PictBridge mode.

• Do not disconnect the USB cable while data is being sent to the printer. If you do, printing will fail.

1. Check that "Ready" is displayed on the printer’s control panel.

2. Disconnect the USB cable from the printer.

4. Direct Printing from a Digital Camera (PictBridge)

140

4



When PictBridge Printing Does Not Work
This section explains likely causes and possible solutions for problems that can occur when PictBridge
printing.

Problem Cause Solution

PictBridge is not available. There is a problem with the USB
connection or the PictBridge
settings.

Use the following procedure to
check the connection and
settings:

1. Disconnect and then
reconnect the USB cable.

2. Check the PictBridge
settings are enabled.

3. Disconnect the USB cable,
and then turn off the printer.
Turn the printer back on.
When the printer has fully
booted up, reconnect the
USB cable.

When two or more digital
cameras are connected, the
second and subsequent cameras
are not recognized.

You have connected multiple
digital cameras.

Connect one digital camera only.

Do not connect multiple cameras.

Printing is disabled. The number of originals exceeds
the maximum number of pages
that can be printed at a time.

The maximum specifiable print
quantity at a time is 999.
Respecify the quantity to 999 or
less, and then retry printing.

Printing is disabled. There is no paper of the specified
size remaining.

There is no paper of the specified
size remaining.

If you have to use paper that is
not of the specified size, perform
Form Feed. To cancel printing,
perform Job Cancel.

Printing is disabled. The paper size setting for this tray
cannot be printed on the printer.

Select the paper size setting that
can be printed on the printer.

When PictBridge Printing Does Not Work
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Other Reference Information
For further details about printing on this printer, see Hardware Guide.
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5. Making Printer Settings Using the
Control Panel
This chapter explains the menu displayed on the control panel and how to change the printer's settings.

Menu Chart
This section explains how to change the default settings of the printer and provides information about the
parameters included in each menu.

Memory Erase Status

Displays data status inside the memory.

This menu can be selected only when the optional security card is installed.

Paper Input

Menu

Paper Size: Bypass Tray

Paper Size: Tray 2

Paper Size: Tray 3

Paper Size: Tray 4

Paper Size: Tray 5

Paper Type: Bypass Tray

Paper Type: Tray 1

Paper Type: Tray 2

Paper Type: Tray 3

Paper Type: Tray 4

Paper Type: Tray 5

Duplex Tray

Auto Tray Select

Tray Priority
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• Only installed trays appear on the display panel.

Maintenance

Menu

Quality Maintenance

General Settings

Timer Settings

HD Management

• [HD Management] appears only when the optional hard disk is installed.

List/Test Print

Menu

Multiple Lists

Config. Page

Error Log

Network Summary

Supply Info List

Menu List

Color Demo Page

PCL Config./Font Page

PS Config./Font Page

PDF Config./Font Page

Hex Dump

Operations Test
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System

Menu

Print Error Report

Auto Continue

Memory Overflow

Printer Language

Sub Paper Size

Default Printer Lang.

Energy Saver 1

Energy Saver 2

Print Compressed Data

Memory Usage

B&W Page Detect

Spool Printing

RAM Disk

Auto Email Notify

• [Spool Printing] appears only when the optional hard disk is installed.

• [RAM Disk] appears only when the optional hard disk is not installed.

Print Settings

Menu

Machine Modes

PCL Menu

PS Menu

PDF Menu

Menu Chart
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Security Options

Menu

Extended Security

Service Mode Lock

Firmware Version

Network Security Level

Auto Erase Memory Setting

Erase All Memory

Transfer Log Setting

Machine Data Encryption

• [Service Mode Lock] may not appear depending on the setting of the printer.

• [Auto Erase Memory Setting] and [Erase All Memory] appear when the optional security card is
installed.

• [Machine Data Encryption] appears only when the optional HDD encryption unit is installed.

Host Interface

Menu

I/O Buffer

I/O Timeout

Network

Wireless LAN

USB Settings

• [Wireless LAN] appears when the optional wireless LAN interface unit is installed.

Shutdown

Prepares the printer for power off. To prevent damage to the hard disk or memory leading to
malfunction, be sure to shutdown the printer properly before turning off the power switch.
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• For details about shutting down the printer, see "Turning off the Power", Hardware Guide.

Language

Menu

English

German

French

Italian

Dutch

Swedish

Norwegian

Danish

Spanish

Finnish

Portuguese

Czech

Polish

Hungarian

Russian

Menu Chart
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Memory Erase Status Menu
Displays data status inside the memory.

• The Memory Erase Status menu appears only when the optional security card is installed.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Memory Erase Status], and then press the [OK] key.

3. The current memory status is displayed.

[Data to erase remaining.] : Data remain inside the memory.

[Currently no data to erase.] : No data remain inside the memory.

[Erasing Data...] : Data are being deleted.

4. Press the [OK] key.

The menu screen appears.

5. Press the [Menu] key.

The initial screen appears.

5. Making Printer Settings Using the Control Panel

148

5



Paper Input Menu
This section explains about paper settings on the paper input menu such as paper sizes and types on each
tray.

Paper Input Menu Parameters

This section explains about parameters that can be set on the paper input menu.

Paper Size: Bypass Tray

You can specify the paper size for Bypass Tray.

• : Auto Detect,A3 , A4 , A5 , A6  B4 JIS ,

B5 JIS , B6 JIS , C5 Env. , C6 Env. , DL Env. , 12" × 18" , 11" × 17" , 81/2" ×
14" , 81/2" × 13" , 81/2" × 11" , 81/4" × 13" , 8" × 13" ,

71/4" × 101/2" , 51/2" × 81/2" , 41/8" × 91/2" , 37/8" × 71/2" , Custom Size

• : Auto Detect, 12" × 18" , 11" × 17" , 81/2" × 14" , 81/2" × 13" , 81/2" ×
11" , 81/4" × 13" , 8" × 13" , 71/4" × 101/2" , 51/2" × 81/2" ,

41/8" × 91/2" , 37/8" × 71/2" , A3 , A4 , A5 , A6 , B4 JIS , B5 JIS , B6 JIS
, C5 Env. , C6 Env. , DL Env. , 8K , 16K , Custom Size

• Default:

• : Auto Detect

• : Auto Detect

Paper Size: Tray 2 to 5

You can specify the paper size for Tray 2 to 5.

• : Auto Detect, A3 , A4 , A5 , B4 JIS , B5 JIS , 11" × 17" , 81/2" ×
14" , 81/2" × 13" , 81/2" × 11" , 81/4" × 13" ,

8" × 13" , 71/4" × 101/2" , Custom Size

• : Auto Detect, 11" × 17" , 81/2" × 14" , 81/2" × 13" , 81/2" × 11" ,
81/4" × 13" , 8" × 13" , 71/4" × 101/2" , A3 , A4 , A5 ,

B4 JIS , B5 JIS , 8K , 16K , Custom Size

• Default:

• : Auto Detect

• : Auto Detect

• Only installed trays appear on the display panel.

Paper Input Menu
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Paper Type: Bypass Tray

No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2, Special Paper 3, Color
Paper, Letterhead, Label Paper, OHP (Transparency), Envelope, Coated Paper: Gloss Print, Coated
Paper, Preprinted Paper, Bond Paper, Cardstock, Thin Paper, Middle Thick, Thick Paper 1, Thick
Paper 2, Thick Paper 3, +Custom1, +Custom2, +Custom3, +Custom4, +Custom5, +Custom6,
+Custom7, +Custom8

• Default : No Display (Plain Paper)

• For details about the types of paper that can be loaded in the Bypass Tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result might
not be proper.

Paper Type: Tray 1 to 5

No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2, Special Paper 3, Color
Paper, Letterhead, Label Paper, Coated Paper: Gloss Print, Coated Paper, Preprinted Paper, Bond
Paper, Cardstock, Middle Thick, Thick Paper 1, Thick Paper 2, Thick Paper 3, +Custom1, +Custom2,
+Custom3, +Custom4, +Custom5, +Custom6, +Custom7, +Custom8

• Default : No Display (Plain Paper)

• For details about the types of paper that can be loaded in each tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result might
not be proper.

• Only installed trays appear on the display panel.

Duplex Tray

You can set each tray for duplex printing. Only installed trays appear on the display panel.

• Tray 1 to Tray 5

• On

• Off

• Default: On

• Bypass Tray

• On

• Off

• Default: Off

Auto Tray Select

You can select whether to assign each tray to automatically print the paper size and type set by printer
driver.
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• Default: On (Tray 1 to 5), Off (Bypass Tray)

• When using custom size paper, if automatic tray selection is enabled, the size selected on the
control panel has priority. If this setting is disabled, the size selected from the printer driver has
priority.

• Only installed trays appear on the display panel.

• You can select multiple trays.

• If you need to have a tray locked, you must select the tray using both printer driver and control
panel.

• Bypass Tray

• On

• Off

• Default: Off

Tray Priority

You can set a tray to be checked first when automatic tray selection is enabled from the printer driver.
The tray selected here is used when no tray is selected for a print job.

• Default : Tray 1

• Only installed trays appear on the display panel.

• It is recommended that you load paper of the size and orientation you use most frequently in the
tray selected in this setting.

• JIS stands for "Japanese Industrial Standard".

Changing the Paper Input Menu

Automatic tray selection

Follow the procedure below to change the automatic tray selection setting.
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1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [AutoTray Select], and then press the [OK] key.

4. Press the [ ] or [ ] key to display the tray you want to select, and then press the [OK] key.

5. Press the [ ] or [ ] key to display [On], and then press the [OK] key.

Wait for one second. The [Auto Tray Select] screen appears.

6. Press the [Menu] key.

The initial screen appears.

Tray priority

Follow the procedure below to change the tray priority.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [Tray Priority], and then press the [OK] key.
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4. Press the [ ] or [ ] key to select a tray you want to use, and then press the [OK] key.

Wait for one second. The [Paper Input] screen appears.

5. Press the [Menu] key.

The initial screen appears.
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Maintenance Menu
You can set printing conditions such as density and calibration, and printer management such as deleting
temporary print jobs from the hard disk.

Maintenance Menu Parameters

This section explains about parameters that can be set on the maintenance menu.

Quality Maintenance

Color Registration

You can perform automatic adjustment of color registration.

Color Calibration

You can adjust the gradation of bright (highlighted parts) and medium areas (middle parts) for printing.

• Adjust Auto Density

You can print the gradation of auto density.

• Print Sheet 1

You can print gradation correction sheet 1.

• Print Sheet 2

You can print gradation correction sheet 2.

• Reset Setting

You can reset the gradation correction value to default.

• Only the installed trays appear on the display panel.

Registration

You can adjust the starting position of the printing page.

• Print Test Sheet

You can print the registration test sheet.

Tray 3, Tray 4, Tray 5

• Only the installed trays appear on the display panel.

• Adjustment

You can select the start position for printing on a page.
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Horizontal: Tray 3, Horizontal: Tray 4, Horizontal: Tray 5

• Only the installed trays appear on the display panel.

4 Color Graphic Mode

This mode adjusts levels of toner color overlap. If characters or lines blur, setting priority on text may
make them clearer. Under normal conditions, set priority on photo.

• Text Priority

• Photo Priority

• Default: Photo Priority

Image Area

You can select whether or not to enlarge print image to edges of paper.

• Do not enlarge

• Enlarge

• Default: Do not enlarge

General Settings

Plain Paper Setting

You can select the type of plain paper.

• Tray 1

Plain Paper 1, Plain Paper 2

• Tray 2

Plain Paper 1, Plain Paper 2

• Tray 3

Plain Paper 1, Plain Paper 2

• Tray 4

Plain Paper 1, Plain Paper 2

• Tray 5

Plain Paper 1, Plain Paper 2

• Bypass Tray

Plain Paper 1, Plain Paper 2
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• Default: Plain Paper 1

Letterhead Setting

You can select the letterhead printing mode.

• Tray 1

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 2

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 3

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 4

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 5

Letterhead 1, Letterhead 2, Letterhead 3

• Bypass Tray

Letterhead 1, Letterhead 2, Letterhead 3

• Default: Letterhead 1

Coated Paper Setting

You can select the coated paper printing mode.

• Tray 1

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 2

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 3

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 4

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 5
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Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Bypass Tray

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Default: Coated Paper 1

Replacement Alert

Use this function to specify the timing to notify user when supplies need to be replaced. Settings can
be made separately for photo conductor unit, intermediate transfer unit, or fusing unit.

• Photoconductor Unit

Notify Sooner, Normal, Notify Later

• Default: Normal

• Intermediate Transfer Unit

Notify Sooner, Normal, Notify Later

• Default: Normal

• Fusing Unit

Notify Sooner, Normal, Notify Later

• Default: Normal

Supply End Option

You can specify whether or not to continue printing after the photoconductor exceeds its service life.

• Continue Printing

• Stop Printing

• Default: Continue Printing

Display Supply Info

You can select whether or not to display the amount of toner on the initial screen.

• On

• Off
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• Default: On

Menu Protect

You can select whether or not to protect menu. When you enable this setting, specify protection level.

• Level 1

• Level 2

• Off

• Default: Level 2

• If you would like to lower the protection level, disable this setting or select [Level 1].

• You may not be able to change this setting depending on the setting of the printer.

List/Test Print Lock

You can select whether or not to prohibit List/Test printing.

• On

• Off

• Default: Off

• You may not be able to change this setting depending on the setting of the printer.

Unit of measure

You can specify the unit for measurement.

• mm

• inch

• Default:

• mm ( )

• inch ( )

Panel Key Sound

You can select whether or not to enable the panel key sound.

• On

• Off

• Default: On
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Warm-up Beeper

You can select whether or not to sound the beeper when the printer has completed a warm-up process.

• On

• Off

• Default: On

Display Contrast

You can specify the density of the display.

Key Repeat

You can specify whether or not to scroll the display panel when the [ ] or [ ] key is held down. When
you enable this setting, specify the scroll speed. (If repeat time is set to "Long", scroll speed becomes
slow.)

• Do not Repeat

• Normal

• Repeat Time: Medium

• Repeat Time: Long

• Default: Normal

Timer Settings

Auto Reset Timer

Specify whether or not to cancel settings made if no operation has been performed for a certain period
of time while changing configuration using the control panel. When set to on, specify how long the
printer is to wait before resetting configuration.

• On

• Off

• Default: On (60 seconds)

Set Date

You can set the date of the printer's internal clock using the [ ] or [ ] key.

Set Time

You can set the time of the printer's internal clock using the [ ] or [ ] key.
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HD Management

Specify the settings related to deletion of data saved on the hard disk. This menu appears only when the
optional hard disk is installed. A hard disk is pre-installed in the HDD standard model.

Delete All Temporary Jobs

Use this function to delete all temporary documents saved on the hard disk (Sample Print, Locked Print
and Hold Print data) at once.

Delete All Stored Jobs

Use this function to delete all Stored Print data saved on the hard disk at once.

Auto Delete Temporary Jobs

Specify whether or not to automatically delete temporary documents saved on the hard disk (Sample
Print, Locked Print and Hold Print data). When set to on, specify how long the printer is to wait before
deleting the documents.

• On

• Off

• Default: Off

• If you enable this setting, specify the timer in hours. (Default: 8 hours)

Auto Delete Stored Jobs

Specify whether or not to automatically delete Stored Print data saved on the hard disk. When set to
on, specify how long the printer is to wait before deleting the documents.

• On

• Off

• Default: On

• If you enable this setting, specify the timer in days. (Default: 3 days)

Changing the Maintenance Menu

This section explains changing the maintenance menu using examples.

Automatic deletion of temporary jobs in the hard disk

Follow the procedure below to set automatic deletion of temporary jobs stored in the hard disk.
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1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Maintenance], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [HD Management], and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Auto Del. Temp. Print Jobs], and then press the [OK] key.

5. Press the [ ] or [ ] key to select [On], and then press the [OK] key.

6. Press the [ ] or [ ] key to set automatic deletion timer in hours between 1 through 200.

7. Press the [OK] key.

Wait for one second. The hard disk management screen appears.

8. Press the [Menu] key.

The initial screen appears.
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List/Test Print Menu
You can print lists showing configurations on printer or the paper printings.

Also, you can check the types and characters of all the printable fonts.

List/Test Print Menu Parameters

This section explains about parameters that can be set on the list/test print menu.

Multiple Lists

You can print the configuration page and error log, network summary and supply list.

Config. Page

You can print the current configuration of the printer.

Error Log

You can print an error report.

Network Summary

You can print the network device status.

Supply Info List

You can print the supply status.

Menu List

You can print a menu list showing all available menus.

Color Demo Page

You can print a color demonstration page.

PCL Config./Font Page

You can print the current configuration and installed PCL font list.

PS Config./Font Page

You can print the current configuration and installed PostScript font list.

PDF Config./Font Page

You can print the current configuration and installed PDF font list.

Hex Dump

You can print the data sent by the computer using Hex Dump.

Operations Test

Use this to check the printer and its options for operability, including paper feed and output, punching
and stapling. Only settings of installed options are displayed. If a specified function fails, the printer
displays a message and stops printing. If the test is successful, the printer prints black frames.
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Printing a Configuration Page

Follow the procedure below to print the configuration page.

• The configuration page is printed on A4 or Letter (81/2"×11") size paper, so load them in the same
paper tray.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [List/Test Print], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [Config. Page], and then press the [OK] key.

After the configuration page is printed out, the screen returns to List/Test print menu.

4. Press the [Menu] key.

The initial screen appears.

Interpreting the Configuration Page

System Reference

Unit Number

Shows the serial number assigned to the board by its manufacturer.

Total Counter

Shows the total number of pages printed by the printer to date.

Firmware Version

• Printer

Shows the version number of the printer controller firmware.

• Engine
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Shows the version number of the printer engine firmware.

• NIB

Shows the version number of the network interface board.

Device Connection

Shows the names of device options installed in the printer.

HDD: Font / Macro Download

Shows the hard disk status

Printer Language

Shows the version number of the printer language.

Attached Equipment

Shows the options attached to the printer.

Paper Input

Shows the current Paper Input settings.

• For details, see p.149 "Paper Input Menu".

Maintenance

Shows the current Maintenance settings.

• For details, see p.154 "Maintenance Menu".

System

Shows the current System settings.

• For details, see p.166 "System Menu".

Machine Modes

Shows the current Machine Modes settings.

• For details, see p.171 "Print Settings Menu".

PCL Menu

Shows the current PCL settings.

• For details, see p.171 "Print Settings Menu".

PS Menu

Shows the current PS settings.
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• For details, see p.171 "Print Settings Menu".

PDF Menu

Shows the current PDF settings.

• For details, see p.171 "Print Settings Menu".

Host Interface

Shows the current Host Interface settings.

When DHCP is active on the network, the IPv4 address, subnet mask and gateway address appear
in parentheses.

• For details, see p.187 "Host Interface Menu".

Interface Information

Interface information is displayed.
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System Menu
The system menu allows you to set the printer's basic functions. Although you can operate the printer using
the default settings, you can also change its settings to better suit your printing needs. Changes made to
settings remain effective after power off.

System Menu Parameters

This section explains about parameters that can be set on the system menu.

Print Error Report

Select whether or not to print an error report when a printer error or memory error occurs.

• Off

• On

• Default: Off

Auto Continue

Specify whether or not to continue printing after a system error. When you enable this setting, specify
how long the printer is to display error before resuming print.

• Off

• Immediate

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

• Default: Off

• When [Auto Continue] is set to on, and a certain error occurs in the printer while printing, the
job might be cancelled, or printing will not be as intended. When a job is cancelled due to error,
the printer automatically begins the next job in the queue.

Memory Overflow

You can specify whether or not to print a memory overflow error report.

• Do not Print

• Error Information
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• Default: Do not Print

Printer Language

You can specify the printer language.

• Auto

• PCL

• PS

• PDF

• Default: Auto

Sub Paper Size

Specify whether or not to use paper of the alternate size automatically, if paper of the specified size
is not loaded. When this setting is set to off, the printer uses paper of any size loaded in the specified
tray.

• Auto

• Off

• Default: Off

Default Printer Lang.

Select the printer language to use when the printer fails to detect the printer language.

• PCL

• PS

• PDF

• Default: PCL

Energy Saver 1

Select whether or not to switch to Energy Saver 1 mode.

• On

• Off

• Default: On

• When set to on, the printer switches to Energy Saver 1 mode after printing is complete. Electric
power consumption is greater than in Energy Saver 2 mode, but the printer returns to Ready
mode in about 10 seconds.
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Energy Saver 2

In Energy Saver 2 mode, electric power consumption is reduced.

Energy Saver On/Off

Select whether or not to switch to Energy Saver 2 mode.

• On

• Off

• Default: On

• When the printer switches to Energy Saver 2 mode, the Power indicator is unlit, but the
Online indicator remains lit.

Energy Saver Timer

Specify the lead time needed to switch to Energy Saver mode.

• 1 minute

• 5 minutes

• 15 minutes

• 20 minutes

• 30 minutes

• 45 minutes

• 60 minutes

• Default: 20 minutes

Print Compressed Data

Specify whether or not to print compressed data.

• On

• Off

• Default: Off

Memory Usage

Select memory to be used from Font Priority or Frame Priority.

• Font Priority

• Frame Priority

• Default : Frame Priority
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B&W Page Detect

Specify whether to recognize black-and-white images by page or by document. Black-and-white
recognition function allows the printer to print monochrome images in monochrome mode even if
color printing is specified.

• Per Page

• Per Job

• Default : Per Job

Spool Printing

Specify whether or not to complete spooling before starting to print.

• On

• Off

• Default: Off

• Spooling stores a sent print job temporarily in the printer, and then prints it.

• This menu appears only when the optional hard disk is installed.

RAM Disk

If the optional hard disk is not installed for PDF Direct Print, select a value of 2 MB or higher.

• 0MB

• 2MB

• 4MB

• 8MB

• 16MB

• When the amount of SDRAM is small and [RAM Disk] is set to [16MB], printing may not be
possible depending on the print job and duplex printing may be canceled. If this happens,
increase the amount of SDRAM, or set [RAM Disk] to [8MB] or less.

• Default: 4MB

• This menu appears only when the optional hard disk is not installed.

• For details about the optional SDRAM module, see Hardware Guide.

Auto Email Notify

Specify whether or not to send an error message to a preset e-mail address when an error occurs in
the printer.
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• On

• Off

• After changing the setting, turn off the power of the printer briefly, and then turn it on again.

• Default: On

• For information, see Web Image Monitor Help.

Changing the System Menu

Follow the procedure below to change the settings for Energy Saver Timer.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press [ ] or [ ] key to display [System], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Energy Saver 2], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Energy Saver Timer], and then enter the [OK] key.

5. Press the [ ] or [ ] key to select the lead time needed to switch to Energy Saver mode.

6. Press the [OK] key.

Wait for one second. The Energy Saver 2 screen appears.

7. Press the [Menu] key.

The initial screen appears.
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Print Settings Menu
The system menu allows you to set conditions for printing.

Print Settings Menu Parameters

This section explains about parameters that can be set on the print settings menu.

Machine Modes

Copies

Specify the number of copies to print.

If the number of copies to print is specified by command or the printer driver, this setting is
overridden.

• 1 to 999

Page Size

Specify the default paper size.

: A3, A4, A5, A6, B4 JIS, B5 JIS, B6 JIS, C5 Env., C6 Env., DL Env., 12 × 18, 11 ×
17, 81/2 × 14, 81/2 × 13, 81/2 × 11, 81/4 × 13, 8 × 13, 71/4 × 101/2, 51/2 × 81/2,
41/8 × 91/2, 37/8 × 71/2, Custom Size

: 12 × 18, 11 × 17, 81/2 × 14, 81/2 × 13, 81/2 × 11, 81/4 × 13, 8 × 13, 71/4
× 101/2, 51/2 × 81/2, 41/8 × 91/2, 37/8 × 71/2, A3, A4, A5, A6, B4 JIS, B5 JIS, B6
JIS, C5 Env., C6 Env., DL Env., 8K, 16K, Custom Size

• Default:

• : A4

• : 81/2 × 11

• The default paper size is used when the paper size is not specified in the print data.

Edge to Edge Print

Select to whether or not to print using the whole area of paper, leaving no edge borders.

• On

• Off

• Default: Off

Duplex

Select whether or not to print on both sides of a sheet. When set to on, specify the binding method.
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• Off

• Long Edge Bind

• Short Edge Bind

• Default: Off

Output Tray

Specify output tray to be used when the output tray is not specified in the print data.

• Standard Tray

• Mailbox Tray 1 to 4

• Finisher Upper Tray

• Finisher Shift Tray

• Auto Output Tray Switching

• Default: Standard Tray

• Finisher trays appear only when an optional finisher is attached.

• [Mailbox Tray 1] to 4 appears when the mailbox is attached.

• [Auto Output Tray Switching] appears when the mailbox is attached and the finisher is not.
If you select [Auto Output Tray Switching] and print using the printer driver without
specifying which tray to output to, printing is outputted in the following order: Standard
Tray, Mailbox trays 1 through 4. This method allows a large volume of continuous printing
output.

Job Separation

Select whether to use job separation function when paper is output to an output tray capable of
job separation.

• On

• Off

• Default: Off

Rotate by 180 Degrees

Select whether or not to rotate image by 180 degrees when printing.

• On

• Off

• Default : Off
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Blank Page Print

Select whether or not to print blank pages.

• On

• Off

• Default: On

Letterhead Setting

Specify whether or not to print with the letterhead printing mode.

• Off

Not printing with the letterhead printing mode.

• Auto Detect

Print with the letterhead printing mode when the letterhead printing mode is selected.

• On (Always)

Print with the letterhead printing mode regularly.

• Default: Auto Detect

Bypass Tray Priority

When paper size/type setting does not match between the printer driver and the printer, you
can select which setting is used.

• Driver/Command

• Machine Settings

• Default: Driver/Command

Tray Switching

Select whether or not to automatically switch to a suitable tray when the setting of the current
tray does not match the paper size/type specified by the printer driver.

• On

• Off

• Default: Off

Collate Settings

Select a collate type.

• Collate
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• Shift Collate

• Default: Shift Collate

Staple Settings

Select a stapling type.

• Off

• Top Left Slant

• Top Right Slant

• Left 2

• Top 2

• Right 2

• Top Left

• Top Right

• Center

• Default: Off

Punch Settings

Select a punch type.

• Off

• Left 2

• Top 2

• Right 2

• Left 3

• Top 3

• Right 3

• Left 4

• Top 4

• Right 4

• Default: Off

Extend Auto Tray Switching

Select whether or not to automatically switch to a suitable tray when the current tray runs out of
paper.
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• On

• Off

• Default: Off

PCL Menu

You can set conditions when using PCL for printing.

Orientation

Select the page orientation.

• Portrait

• Landscape

• Default: Portrait

Form Lines

Specify the number of lines per page between 5 and 128.

• Default:

• : 64

• : 60

• The default paper size is used when the paper size is not specified in the print data.

Font Source

Specify the location of the default font.

• Resident

• RAM

• HDD

• SD

• SD Font Download

• Default: Resident

• When you select [RAM], you can select only fonts downloaded to the printer RAM.

• When you select [HDD], you can select only fonts downloaded to the optional hard disk.

• When you select [SD Font Download], you can select only fonts downloaded to the SD
card.
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Font Number

Specify the ID of the default font you want to use.

• 0 to 63 (Resident)

• 1 to X (Download; “X” is the number of downloaded fonts)

• Default: 0

Point Size

Specify the point size you want to use for the default font between 4 and 999.75 in 0.25
increments.

• Default: 12.00 points

• This setting is effective only for a variable-space font.

Font Pitch

Specify the number of characters per inch you want to use for the default font between 0.44 and
99.99 in 0.01 increments.

• Default: 10.00 pitch

• This setting is effective only for fixed-space fonts.

Symbol Set

You can specify the character set for the default font. Available sets are as follows:

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, Win L1, Win
L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-8, PS Math, VN Math, Pifont,
Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

• Default: PC-8

Courier Font

Select the type of courier font.

• Regular

• Dark

• Default: Regular

Ext. A4 Width

Select whether or not to extend the width of the printable area of A4 sheets, by reducing side
margins.
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• Off

• On

• Default: Off

Append CR to LF

Select whether or not to append a CR code to each LF code to print text data clearly.

• Off

• On

• Default: Off

Resolution

You can specify the print resolution in dots per inch.

• 300dpi

• 600dpi Fast

• 600dpi Std.

• 600dpi Hq.

• Default: 600dpi Std.

PS Menu

You can set conditions when using PostScript for printing.

Job Timeout

You can specify how long the printer waits (in seconds) before canceling the current job when
the job is interrupted while being processed.

• Use Driver/Command

• Use Machine Settings

• Default: Use Driver/Command

• If you select Use Machine Settings, enter a value between 0 and 999. (Default: 0)

Wait Timeout

You can specify how long the printer waits (in seconds) before it cancels receiving a job when
the printer cannot detect the end of the job.

• Use Driver/Command

• Use Machine Settings
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• Default: Use Driver/Command

• If you select Use Machine Settings, enter a value between 0 and 999. (Default: 300)

Data Format

Select the data format from Binary Data or TBCP.

This setting is ineffective when using a parallel or EtherTalk connection.

When using a parallel or USB connection, the print job is canceled if binary data is sent from
the printer driver.

When using an Ethernet connection, the print job is canceled if:

• The printer driver data format is TBCP and the data format selected using the control panel
is Binary Data.

• The printer driver data format is binary and the data format selected using the control panel
is TBCP.

• Default: TBCP

Resolution

Select the resolution.

• 600dpi Fast

• 600dpi Std.

• 600dpi Hq.

• 1200dpi

• Default: 600dpi Std.

Color Setting

Specify the RGB setting for the PDF file executing PDF Direct Print.

• None

• Fine

• Super Fine

• Default: Super Fine

Color Profile

Specify the color profile for the PDF file executing PDF Direct Print.

• Auto
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• Presentation

• Solid Color

• Photographic

• User Setting

• Default: Auto

Process Color Model

Specify the color model.

• Color

• Black and White

• Default: Color

Orientation Auto Detect

Specify auto detection of the print orientation.

• On

• Off

• Default: On

PDF Menu

You can set conditions when using PDF for printing.

Change PDF Password

Specify the password for the PDF file executing PDF Direct Print.

• If you do not set a PDF password, this menu does not appear.

• The password can be set using Web Image Monitor, but must be sent through the network.
For increased security, use this menu on the control panel to set the password directly.

PDF Group Password

Specify a group password specified using DeskTopBinder Lite.

• If you do not set a PDF group password, this menu does not appear.

• When you use a group password, the optional data protection unit must be installed.

• The password can be set using Web Image Monitor, but must be sent through the network.
For increased security, use this menu on the control panel to set the password directly.
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• Default: no password set

Resolution

Specify the resolution for the PDF file executing PDF Direct Print.

• 600dpi Fast

• 600dpi Standard

• 600dpi High Quality

• 1200dpi

• Default: 600dpi (Standard)

Color Setting

Specify the RGB setting for the PDF file executing PDF Direct Print.

• None

• Fine

• Super Fine

• Default: Super Fine

Color Profile

Specify the color profile for the PDF file executing PDF Direct Print.

• Auto

• Presentation

• Solid Color

• Photographic

• User Setting

• Default: Auto

Process Color Model

Specify the color model.

• Color

• Black and White

• Default: Color

Orientation Auto Detect

Specify auto detection of the print orientation.
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• On

• Off

• Default: On

Changing the Print Settings Menu

Follow the procedure below to change Bypass Tray Priority.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press [ ] or [ ] key to display [Print Settings], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Machine Modes], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Bypass Tray Priority], and then enter the [OK] key.

5. Press the [ ] or [ ] key to select the desired setting item, and then press the [OK] key.

Wait for one second. The [Machine Modes] screen appears.

6. Press the [Menu] key.

The initial screen appears.
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Security Options Menu
The system menu allows you to set conditions for printing.

Security Options Menu Parameters

This section explains about parameters that can be set on the security options menu.

Extended Security

Depending on the setting of the printer, some of the settings listed below may not appear.

Driver Encryption Key

Specify the driver encryption key.

Encrypt Address Book

Select whether or not to encrypt the printer's address book data.

• On

• Off

• Default: Off

Restrict User Info.Display

Select whether or not to display user information as “********” when checking job information
without being authenticated through user authentication.

• On

• Off

• Default: Off

Enhance File Protection

Select whether or not to automatically lock password-protected print files if an invalid password
is entered ten times. When a file is locked, you cannot select them even if the correct password
is entered.

• On

• Off

• Default: Off
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Settings by SNMPv1 and v2

Select whether or not to prohibit changes to the printer settings through access using SNMPv1,
v2 protocol.

• Prohibit

• Do not Prohibit

• Default: Do not Prohibit

Simple Encryption

Select whether or not to use apply simple encryption (restrict usage) when enhanced encryption
cannot be used.

• Restrict

• Do not Restrict

• Default: Do not Restrict

Authenticate Current Job

Select whether or not authentication is required for operations such as canceling jobs. If set to
[Login Privilege], only authorized users or your administrator can operate the printer. If set to
[Access Privilege], users who sent a print job or your administrator can operate the printer.

• Login Privilege

• Access Privilege

• Off

• Default: Off

Password Policy

Specify the format of passwords: types of characters to be used and minimum length.

Valid characters for passwords are upper-case letters, lower-case letters, decimal numbers, and
symbols such as #. If complexity is set to [Level 1], passwords must use two types of these
characters; if set to [Level 2], three types.

• Complexity Setting

• Default: Do not Restrict

• Minimum Character No.

Between 0 to 32
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• Default: 0

• If set to 0, minimum length is not specified.

@Remote Service

Select whether or not to prohibit @Remote Service.

• Prohibit

• Do not Prohibit

• Default: Do not Prohibit

• If you would like to set to Prohibit, contact your service representative.

Update Firmware

Select whether or not to prohibit Update Firmware.

• Prohibit

• Do not Prohibit

• Default: Do not Prohibit

• If you would like to set to Prohibit, contact your service representative.

Change Firmware Structure

Select whether or not to prohibit Change Firmware Structure.

• Prohibit

• Do not Prohibit

• Default: Do not Prohibit

• If you would like to set to Prohibit, contact your service representative.

Service Mode Lock

Select whether or not to prohibit entering service mode.

• On

• Off

• Default: Off

• This setting may not appear depending on the setting of the printer.

Firmware Version

Display the firmware version of the printer.
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Network Security Level

Specify the network security level.

• Level 0

• Level 1

• Level 2

• Default: Level 0

Auto Erase Memory Setting

Select whether or not to automatically delete memory. When set to on, specify the overwrite times.

• On

Number of Erase: Between 1 to 3

• Off

• Default: Off

• This setting appears only when the optional security card is installed.

Erase All Memory

Select to delete all data inside the memory. When deleting memory, specify the overwrite times.

• EraseNo.

Between 1 to 3

• This setting appears only when the optional security card is installed.

Transfer Log Setting

You can select whether or not to send log information to the log collection server.

• On (Only available from the log collection server.)

• Off

• Default: Off

Machine Data Encryption

Encrypt data stored on the hard disk. Once you encrypt the data, the following menus appear on the
control panel display.

• Update Encryption Key

Update the encryption key.

• Cancel Encryption
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Cancel the encryption settings.

• Print Encryption Key

Print the encryption key.

• This setting appears only when the optional HDD encryption unit is installed.

Changing the Security Options Menu

Follow the procedure below to erase data inside memory.

• This setting appears only when the optional security card is installed.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press [ ] or [ ] key to display [Security Options], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Extended Security], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Erase All Memory], and then press the [OK] key.

5. Press the [ ] or [ ] key to select [On], and then press [EraseNo.].

6. Press the [ ] or [ ] key to enter overwrite times, and then press the [OK] key.

7. Press the [ ] or [ ] key to select [On], and then press the [OK] key.

Wait for one second. The [Security Options] menu appears.

8. Press the [Menu] key.

The initial screen appears.
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Host Interface Menu
You can set configurations about network connections and communication when using parallel connection
between the printer and the computer. The changed configuration holds even if the printer is turned off.

Host Interface Menu Parameters

This section explains parameters that can be set on the host interface menu.

I/O Buffer

Select the size of I/O Buffer. Normally it is not necessary to change this setting.

• 128 KB

• 256 KB

• Default: 128 KB

I/O Timeout

Specify how many seconds the printer should wait before ending a print job. If printing operation is
frequently interrupted by data from other ports, you can increase the timeout period.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

• Default: 15 seconds

Network

You can make network-related settings.

Machine IPv4 Address

Select whether to set the IPv4 address automatically or manually.

• Auto-Obtain (DHCP)/Specify (Default: Auto-Obtain (DHCP))

When DHCP is set to on, the IPv4 address, subnet mask address, and gateway address
cannot be changed. To change them, set DHCP to off. Contact your administrator for
information about the network configuration.

• IP Add.

Manually specify the IPv4 address.
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• Default: 11.22. 33.44

• Subnet M

Manually specify the subnet mask.

• Default: 0.0.0.0

• Gateway

Manually specify the gateway address.

• Default: 0.0.0.0

IPv6 Stateless Setting

Select whether to enable or disable IPv6.

• Active

• Inactive

• Default: Active

IPsec

This is a security function. For details, contact your administrator.

• Active

• Inactive

• Default: Inactive

NW Frame Type

Specify the frame type for NetWare.

• Auto Select

• Ethernet II

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

• Default: Auto Select

5. Making Printer Settings Using the Control Panel

188

5



Effective Protocol

Specify the effective protocol.

• IPv4

Active, Inactive

• Default: Active

• IPv6

Active, Inactive

• Default: Inactive

• NetWare

Active, Inactive

• Default: Inactive

• SMB

Active, Inactive

• Default: Active

• AppleTalk

Active, Inactive

• Default: Inactive

Ethernet Speed

Specify the network speed to operate the printer.

• Auto Select

• 10Mbps Half Duplex

• 10Mbps Full Duplex

• 100Mbps Half Duplex

• 100Mbps Full Duplex

• Default: Auto Select
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IEEE802.1X Auth.(Ethernet)

Specify IEEE 802.1X Ethernet authentication.

• Active

• Inactive

• Default: Inactive

• For details about IEEE 802.1X authentication, see "Configuration", Hardware Guide.

Restr.IEEE802.1X Auth.Def.

Restore the default IEEE 802.1X setting.

LAN Type

Select Ethernet or Wireless LAN.

• Ethernet

• Wireless LAN

• Default: Ethernet

• This menu appears only when the optional wireless LAN interface unit is installed.

Parallel Interface

Specify parallel interface settings. This menu appears when the IEEE 1284 interface board is installed.

Parallel Timing

Specify the parallel interface timing.

• ACK inside

• ACK outside

• STB down

• Default: ACK outside

Parallel Communication Speed

Specify whether or not to use DMA transfer for receiving data.

• High Speed

• Standard

• Default: High Speed

Selection Signal Status

Specify the selection signal level of the parallel interface.
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• High

• Low

• Default: High

Input Prime

You usually do not need to change this setting.

• Active

• Inactive

• Default: Inactive

Bidirectional Communication

Specify whether to enable or disable bidirectional communication.

• On

• Off

• Default: On

Wireless LAN

Configure settings for wireless LAN. This menu appears only when the optional wireless LAN interface
unit is installed.

Communication Mode

Specify the transmission mode for wireless LAN.

• 802.11 Ad-hoc Mode

• Infrastructure Mode

• Default: Infrastructure Mode

SSID Setting

Specify an SSID in infrastructure mode and Ad-hoc Mode.

• SSID

• Default: blank (ASSID)

• Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the configuration page,
read it as [/].

• Characters used are ASCII 0x20-0x7e (32 bytes).
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• An SSID is set automatically to the nearest access point if no SSID has been set.

• If no SSID has been set for Ad-hoc Mode, an SSID is set automatically and the same SSID
is used for Ad-hoc Mode and infrastructure mode.

• If blank is specified in SSID for Ad-hoc Mode, “ASSID” appears.

• An SSID can also be set using Web Image Monitor. For details, see Web Image Monitor
Help.

Ad-hoc Channel

Select channels: 1-14, 36,40,44,48 ( )/1-11, 36,40,44,48 ( )

• Default: 11

Security Method

Select whether to enable encryption and specify the security type when the encryption is enabled.

• Off

• WEP

Change (HEX), Change (ASCII)

• WPA

Encryption Method (TKIP, CCMP(AES)), Authentication Method (WPA-PSK, WPA),
(WPA2-PSK), (WPA2)

• Default: Off

• WPA appears only when the optional wireless LAN interface unit is installed.

Wireless LAN Signal

You can check the signal strength when using wireless LAN.

Restore Defaults

Reset the wireless LAN to default.

USB Settings

Select speed for USB interface.

USB Speed

• Auto

• Full Speed

• Default: Auto

Fixed USB Port

• Level 1

5. Making Printer Settings Using the Control Panel
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• Level 2

• Off

• Default: Off

Changing the Host Interface Menu

Follow the procedure below to change the I/O Timeout setting.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Host Interface], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [I/O Timeout], and then press the [OK] key.

4. Press the [ ] or [ ] key to select the lead time needed to end a printing operation, and then
press the [OK] key.

Wait for one second. The [Host Interface] menu appears.

5. Press the [Menu] key.

The initial screen appears.

Host Interface Menu
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Language Menu
You can set a language to be displayed on the menu.

Language Menu Parameters

You can select the language you use. Available languages are as follows:

English, German, French, Italian, Dutch, Swedish, Norwegian, Danish, Spanish, Finnish, Portuguese,

Czech, Polish, Hungarian, Russian.

• Default: English

Changing the Language Menu

Follow the procedure below to change the interface language.

1. Press the [Menu] key.

BMW028S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Language], and then press the [OK] key.

3. Press the [ ] or [ ] key to select the language, and then press the [OK] key.

Wait for one second. The [Language] menu screen appears.

4. Press the [Menu] key.

The initial screen appears.

5. Making Printer Settings Using the Control Panel

194

5



Options Menu
Using the options menu, you can configure settings related to form feeding and error logs. This section
provides a list of the configurable settings and explains how to check error logs.

Options Menu Parameters

Form feed

Outputs data that are unprintable, due to errors such as the absence of a line-feed code.

Error log

If a document cannot be printed due to errors or other reasons, an error log is created. You can check
the error log using the control panel.

• All

• Sample Print Jobs

• Locked Print Jobs

• Hold Print Jobs

• Stored Print Jobs

Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors by checking the error log
on the control panel.

• The most recent 30 errors are stored in the error log. If a new error is added when there are 30 errors
already stored, the oldest error is deleted. However, if the oldest error belongs to one of the following
print jobs, it is not deleted. The error is stored separately until the number of those errors reaches 30.
You can check any of these print jobs for error log information.

• Sample Print Jobs

• Locked Print Jobs

• Hold Print Jobs

• Stored Print Jobs

• If the main power switch is turned off, the log is deleted.

Options Menu
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1. Press [Option].

2. Select [Error Log] using the [ ] or [ ] key, and then press the [OK] key.

3. Select a type of print jobs using the [ ] or [ ] key, and then press the [OK] key.

If you select [All], all error logs appears.

4. Select the error log you want to check using the [ ] or [ ] key.

Press the [Menu] key until the initial screen appears after checking the log.

• To print files that appear in the error log, resend them after stored files have been printed or deleted.
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6. Monitoring and Configuring the
Printer
This chapter explains how to use Web Image Monitor and other applications to monitor the printer or

change its settings.

Using Web Image Monitor
Using Web Image Monitor, you can check the printer status and change settings.

Introduction to Web Image Monitor

Available operations

The following operations can be remotely performed using Web Image Monitor from a client
computer.

• Displaying printer status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book

• Making printer settings

• Making network protocol settings

• Making security settings

Configuring the printer

To perform the operations from Web Image Monitor, TCP/IP is required. After the printer is configured
to use TCP/IP, operations from Web Image Monitor become available.

Recommended Web browser

• Windows:

Internet Explorer 5.5 SP2 or higher

Firefox 1.0 or higher

• Mac OS:

Firefox 1.0 or higher

Safari 1.0, 1.2, 2.0 (412.2) or higher

Web Image Monitor supports screen reader software. We recommend JAWS 7.0 or a later version.

197

6



• Safari cannot be used on Mac OS X 10.4.1.

• Display and operation problems can occur if you do not enable JavaScript and cookies, or if you are
using a non-recommended Web Browser.

• If you are using a proxy server, change the Web browser settings. Contact your administrator for
information about the settings.

• If you click your browser's back button but the previous page does not appear, click the browser's
refresh button and try again.

• Printer information is not automatically updated. To perform an update, click [Refresh] in the display
area.

• We recommend using Web Image Monitor in the same network.

• You cannot access to the printer from outside the firewall.

• When using the printer under DHCP, the IP address may be automatically changed by the DHCP
server settings. Enable DDNS setting on the printer, and then connect using the printer's host name.
Alternatively, set a static IP address to the DHCP server.

• If the HTTP port is disabled, connection to the printer using the printer's URL cannot be established.
SSL setting must be enabled on this printer. For details, contact your administrator.

• When using the SSL encryption protocol, enter “https://( printer's IP address or host name)/”.

• Internet Explorer must be installed on your computer. Use the most recent available version. We
recommend Internet Explorer 6.0 or later.

• When you are using Firefox, fonts and colors may be different, or tables may be out of shape.

• When using a host name under Windows Server 2003/2003 R2/2008 or Windows Vista with IPv6
protocol, perform host name resolution using an external DNS server. The host file cannot be used.

• To use JAWS 7.0 under Web Image Monitor, you must be running Windows OS and Microsoft
Internet Explorer 5.5 SP2, or a later version.

Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

• When entering an IPv4 address, do not begin segments with zeros. For example: If the address is
“192.168.001.010”, you must enter it as “192.168.1.10”.

1. Start your Web browser.

2. Enter “http://( printer's IP address or host name)/” in your Web browser's URL bar.

Top Page of Web Image Monitor appears.

If the printer's host name has been registered on the DNS or WINS server, you can enter it.

6. Monitoring and Configuring the Printer
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When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter “https://( printer's IP address or host name)/”.

Every Web Image Monitor page is divided into the following areas:

BMW038S

1. Menu area

If you select menu, its content will be shown on the work area, or the sub area.

2. Tab area

Details about each menu appear.

3. Header area

The dialog box for switching to the user mode and administrator mode appears, and each mode's menu will be
displayed.

The link to help and dialog box for keyword search appears.

4. Help

Use Help to view or download Help file contents.

5. Display area

Displays the contents of the item selected in the menu area.

Printer information in the display area is not automatically updated. Click [Refresh] at the upper right in the display
area to update the printer information. Click the Web browser's [Refresh] button to refresh the entire browser
screen.

• When using a host name under Windows Server 2003/2003 R2/2008 or Windows Vista with IPv6
protocol, perform host name resolution using an external DNS server. The host file cannot be used.

Using Web Image Monitor
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When User Authentication is Set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

1. Click [Login].

2. Enter a login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

• For user code authentication, enter a user code in [Login User Name], and then click [Login].

• The procedure may differ depending on the Web browser used.

Log off (using Web Image Monitor)

Click [Logout] to log off.

• When you log on and made the setting, always click [Logout].

About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and administrator mode.

Displayed Items may differ depending on the printer type.

Guest mode

In the guest mode, printer status, settings, and print job status can be viewed, but the printer settings
cannot be changed.

6. Monitoring and Configuring the Printer
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BMW039S

1. Home

The [Status], [Supplies], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed
on the work area.

2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs.

3. Job

Display all print files.

4. Configuration

Display current printer and network settings.

Administrator mode

In the administrator mode, you can configure various printer settings.

BMW040S

1. Home

The [Status], [Supplies], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed
on the work area.

Using Web Image Monitor
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2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs.

3. Job

Display all print files.

4. Address Book

User information can be registered, displayed, changed, and deleted.

5. Configuration

Make system settings for the printer, interface settings, and security.

6. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after the print job is completed.
This button is located on Top Page.

7. Reset Printer Job

Click to reset current print jobs and print jobs in queue. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator mode.

1. On Top Page, click [Login].

The window for entering the login user name and password appears.

2. Enter your login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

Displaying Web Image Monitor Help

When using Help for the first time, clicking the icon marked “? ” ( ) makes the following screen appear,
in which you can view Help in two different ways, as shown below:

Viewing Help on our Web site

Downloading Help to your computer.

Downloading and checking Help

You can download Help to your computer. As the Help URL, you can specify the path to the local file
to view the Help without connecting to the Internet.

• By clicking “?” ( ) in the header area, the contents of Help appear.

• By clicking “?” ( ), the Help icon in the display area, Help for the setting items in the display
area appears.

6. Monitoring and Configuring the Printer
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Downloading Help

1. In the [OS] list, select the operating system.

2. In the [Language] list, select the language.

3. Click [Download].

4. Download Help by following the instructions on the screen.

5. Store the downloaded compressed file in a given location, and then decompress the file.

To create a link for the Help button ( ), save the downloaded Help files on a Web server.

Linking the URL of the downloaded Help

You can link the URL of the help file on a Web server to the “?” button.

1. Log on to Web Image Monitor in the administrator mode.

2. In the menu area, click [Configuration].

3. Click [Webpage].

4. In the [Set Help URL Target] box, enter the URL of the help file.

If you saved the file to a Web server, and the URL of the index file is “http:// a.b.c.d/HELP/EN/
index.html”, enter “http://a.b.c.d/HELP/”.

5. Click [OK].

• If you save the Help files on your hard disk, you must access them directly - you cannot link to them
using the Help button ( ).

Using Web Image Monitor
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Registering Classification Codes
This section explains classification codes.

If you register classification codes, the printer logs the number of prints made under each code.

You can register classification codes to individual users and specified purposes, enabling you to monitor
printer usage by each.

For example, you can manage accounts according to individual clients or account titles.

Classification Code - Based Process (example)

BJF013S

1. Divisions, sections, departments, project teams, users, etc., to be managed.

2. The appropriate classification code for the print job is entered.

For details, see "Specifying Classification Code for Print Job".

3. The job is printed.

When printing in an environment where classification codes are required, print jobs that do not have a
classification code cannot be printed.

For details, see "Configuring Classification Codes".

4. Classification codes are collected and managed by an external log collection system.

6. Monitoring and Configuring the Printer
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Configuring Classification Codes

Use Web Image Monitor to specify whether or not to apply classification code requirement to print jobs.

• The configuration page can be printed at any time.

• The default setting for classification code requirement is "Optional".

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [Logs].

5. Check that [Required] or [Optional] is selected for [Classification Code] in the [Common
Settings for All Logs] column.

If "Required" is selected for the classification code requirement setting in Web Image Monitor, any
print job that without a classification code specified will not be printed.

6. Click [OK].

7. Click [Logout].

8. Quit Web Image Monitor.

Specifying the Classification Code for a Print Job

When printing in an environment where classification codes are required, a classification code must be
specified for each print job.

• The PostScript 3 printer driver does not support the classification codes and it cannot be used to print
under environment which the classification codes are required.

For the RPCS printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Print Settings] or [Setup] tab.

3. Select Job type in [Job type:] box.

4. Click [Details...].

If you select [Send to Job Binding] in the [Job type:] box, you cannot enter a classification code.

Registering Classification Codes
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5. Enter the classification code in the [Classification code:] box, and then click [OK].

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

6. Make any other necessary print settings, and then click [OK].

7. A confirmation message appears. Read it, and then click [OK].

8. Execute the print command.

9. The print job is sent to the printer.

For the PCL printer driver:

1. Open the printer properties dialog box after creating a document in an application.

2. Click the [Valid Access] tab.

3. Enter the classification code in the [Classification Code:] box.

This code identifies the user. The classification code can contain up to 32 alphanumeric (a-z, A-Z,
0-9, "-") characters.

4. Make any other necessary print settings, and then click [OK].

5. A confirmation message appears. Read it, and then click [OK].

6. Execute the print command.

7. The print job is sent to the printer.

• The specified classification code is stored in the printer driver.

• To switch between different classification codes, install the printer driver under different names, and
specify different classification code for each driver.

• For details about how to view the log collected using Classification Code, see the manual for the
external log collection system.

• p.24 "Installing the Printer Driver"

Address Book Backup and Restore - Web Image Monitor

Using Web Image Monitor, you can save or restore the printer’s address book data.

Backing Up Address Book Data

Follow the procedure below to save a copy of the printer’s address book data.

6. Monitoring and Configuring the Printer
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1. Log on to Web Image Monitor in the administrator mode.

For details about logging in, see “Monitoring and Configuring the Printer”.

2. Click [Address Book].

3. Click [Maintenance].

4. Enter the encryption key and click [Backup].

Enter the encryption key that was set when the address book was encrypted. For details, contact your
administrator.

• p.24 "Installing the Printer Driver"

Restoring Address Book Data

Follow the procedure below to restore previously saved address book data to the printer.

1. Log on to Web Image Monitor in the administrator mode.

For details about logging in, see “Monitoring and Configuring the Printer”.

2. Click [Address Book].

3. Click [Maintenance].

4. Click [Restore].

5. Select the file you want to restore.

The address data currently on the printer will be overwritten by the backed-up data. Also, user counters
will be reset.

• p.24 "Installing the Printer Driver"
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Using SmartDeviceMonitor for Admin
Using SmartDeviceMonitor for Admin, you can monitor the network printers. Also, you can change the
configuration of the network interface board using TCP/IP or IPX/SPX.

• IPv6 cannot be used on this function.

Introduction to SmartDeviceMonitor for Admin

Protocol stack provided with operating system

• Windows 2000

TCP/IP

IPX/SPX

NetWare

Novell Client for Windows 2000/XP

• Windows Server 2003

TCP/IP

IPX/SPX

• Windows XP

TCP/IP

IPX/SPX

Novell Client for Windows 2000/XP

• Windows Vista

TCP/IP

Novell Client for Windows 2000/XP/Vista

• Windows Server 2008

TCP/IP

IPX/SPX

Available operations

The following functions are available:

• Printer Information function

• Display the network settings and detailed information of the printer.

• Display the number of pages printed under each user code.

• Display the status of print jobs sent from computers.

6. Monitoring and Configuring the Printer
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• Change the printer network settings.

• Device Settings function

• Lock some of the setting items on the control panel so that they cannot be changed using
the control panel.

• Select type of paper loaded in the paper trays.

• Energy Saver function

• Enable or disable the Energy Saver mode.

• System Status function

• Display the information such as when paper is depleted during printing on a computer.

• Groups function

• Monitor multiple printers at the same time. When there are multiple printers to manage, you
can create groups and classify the printers to facilitate management.

• You can customize printer status according to groups, and send status notification e-mail
to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [SmartDeviceMonitor for Admin], and then click [Next>].

The software license agreement appears in the [License Agreement] dialog box.

5. After reading through its contents, click [Next>].

6. Follow the instructions on the screen.

A message appears when the installation is completed.

7. Click [OK].

A message about restarting the computer may appear. Restart the computer to complete installation.

• Auto Run may not work under certain operating system settings. In this case, launch “Setup.exe”
located on the CD-ROM root directory.

Using SmartDeviceMonitor for Admin
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• If you are required to restart the computer after installing SmartDeviceMonitor for Admin, restart the
computer and continue the configuration.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration using
SmartDeviceMonitor for Admin.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the window for entering the user name and password for the Web Image
Monitor administrator appears.

NIB Setup Tool starts. Follow the instruction on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

6. Configure settings using Web Image Monitor.

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• p.197 "Using Web Image Monitor"
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Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and password for the Web
Image Monitor administrator appears.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, contact your administrator.

The [System] page of Web Image Monitor appears.

6. On the [Protect Printer Display Panel], select [Level 1] or [Level 2].

7. Click [OK].

8. Click [Logout].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• p.197 "Using Web Image Monitor"

Changing the Paper Type

Follow the procedure below to change the paper type.

Using SmartDeviceMonitor for Admin
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1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the window for entering the login user name and password for the Web
Image Monitor administrator appears.

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

The [Paper] page appears.

Select a paper type in the [Paper Type] list for each tray.

6. Enter required setting items, and then click [OK].

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• For details about setting items, see Help in the [General Settings] on [Configuration] page.

• p.197 "Using Web Image Monitor"

Managing User Information

Follow the procedure below to manage the user's information using SmartDeviceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

1. Start SmartDeviceMonitor for Admin.

6. Monitoring and Configuring the Printer
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2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer you want to manage.

4. On the [Tools] menu, click [User Management Tool].

The dialog box for entering the user name and password appears.

5. Enter the user name and password, and then click [OK].

Enter the same user name and password you enter to log on to the Web Image Monitor. For details
about the user name and password, contact your administrator.

User Management Tool starts.

• For details about User Management Tool, see SmartDeviceMonitor for Admin Help.

Displaying the number of sheets printed

Follow the procedure below to display the number of sheets printed under each user.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user appears.

Using SmartDeviceMonitor for Admin
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3. Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages printed under each user
code as a ".csv" file.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [File] menu, click [Export User Statistics List].

4. Specify the save location and file name, and then click [Save].

5. Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0

Follow the procedure below to reset the number of pages printed under each user to 0.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

3. Select the user whose information you want to reset.

6. Monitoring and Configuring the Printer
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4. On the [Edit] menu, click [Reset User Counters].

5. Select the check box, and then click [OK].

A confirmation message appears.

6. Click [OK].

The count for the selected paper type becomes 0 and [Modified] is displayed for [Status].

7. On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

8. Click [Exit] on the [File] menu to quit User Management Tool.

Using SmartDeviceMonitor for Admin
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Restricting functions

Follow the procedure below to restrict use of individual functions.

1. Start SmartDeviceMonitor for Admin User Management Tool.

2. Click the [User Counter Information] tab of User Management Tool.

3. Click the user whose functions you want to restrict.

4. On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

5. Select the check box of the functions you want to restrict.

6. Click [OK].

A confirmation message appears.

7. Click [Yes].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

Setting applicable functions to new users

Follow the procedure below to add new users and set functions applicable to them.

1. Start SmartDeviceMonitor for Admin User Management Tool.
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2. Click the [Access Control List] tab of User Management Tool.

3. On the [Edit] menu, click [Add New User].

4. Enter the user code and user name.

5. Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function.

6. Click [OK].

The user is added, and [New] is displayed for [Status].

7. On the [Edit] menu, click [Apply Settings].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

• For details about setting restrictions, see SmartDeviceMonitor for Admin Help.

Using SmartDeviceMonitor for Admin
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select the printer whose settings you want to make.

To make settings for all printers in the selected group, select no printer.

4. Click the [Group] menu, point to [Energy Save Mode], [Set Individually], and then click
[On].

To select all the printers in the group, select [Set By Group].

To disable Energy Save mode, click [Off].

5. Quit SmartDeviceMonitor for Admin.

• For details about the setting for Energy Saver mode, see SmartDeviceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.
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Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the window for entering the login user name and password for the Web
Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instructions on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, contact your administrator.

Top Page of Web Image Monitor appears.

6. Click [Configuration].

7. Click [Program/Change Administrator] on the [Device Settings] area, and then change the
settings.

8. Click [OK].

9. Click [Logout].

10. Quit Web Image Monitor.

11. Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.
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3. To obtain status details, click the printer in the list, and then click [Open] on the [Device]
menu.

The printer status appears in the dialog box.

4. Click [System] or [Printer].

The printer status appears in the dialog box.

5. Quit SmartDeviceMonitor for Admin.

• For details about status icons and items in the dialog box, see SmartDeviceMonitor for Admin Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer in the list, and then click [NIB Setup Tool] on the [Tools] menu.

A Web browser opens and the window for entering the login user name and password for the Web
Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instructions on the screen.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

Top Page of Web Image Monitor appears.

5. Click [Configuration].

6. Click [System] on the [Device Settings] area, and then change the settings.

7. Click [OK].

8. Click [Logout].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

• In the [Device Name] box, enter a device name on the printer using up to 31 characters.

• In the [Comment] box, enter a comment on the printer using up to 31 characters.
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• For details about Web Image Monitor, see “Using Web Image Monitor”.

• p.197 "Using Web Image Monitor"

Address Book Backup and Restore - SmartDeviceMonitor for Admin

Using the Address Management Tool, you can save or restore the printer’s address book data.

Backing Up Address Book Data - SmartDeviceMonitor for Admin

Follow the procedure below to save a copy of the printer’s address book data.

1. Click [File].

2. Click [Backup Data].

3. Enter the encryption key and click [OK].

Enter the encryption key that was set when the address book was encrypted. For details, contact your
administrator.

4. Specify the save location.

Restoring Address Book Data - SmartDeviceMonitor for Admin

Follow the procedure below to restore previously saved address book data to the printer.

1. Click [File].

2. Click [Restore Data].

3. Select the file you want to restore and click [Open].

4. Enter the encryption key and click [OK].

5. Click [Send].

The address data currently on the printer will be overwritten by the backed-up data. Also, user counters
will be reset.

Viewing and Deleting Spool Print Jobs

1. Start SmartDeviceMonitor for Admin.
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2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the [Tools] menu.

A Web browser opens and the window for entering the login user name and password for the Web
Image Monitor administrator appears.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

[Spool Printing Job List] appears in the Web Image Monitor.

5. Click [Logout].

6. Quit Web Image Monitor.

7. Quit SmartDeviceMonitor for Admin.

• To display Spool Printing Job List, [Spool Printing] must be set to [Active] on Web Image Monitor in
advance.

• To delete the Spool Printing Job, select the document you want to delete and then click [Delete].

• For details, see Help in the [Spool Printing Job List] area.

• For details about Web Image Monitor, see “Using Web Image Monitor”.

• p.197 "Using Web Image Monitor"

Managing Address Information

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer in the list, and then click [Address Management Tool] on the [Tools] menu.

The dialog box for entering the login user name and password appears.

6. Monitoring and Configuring the Printer

222

6



4. Enter the login user name and password, and then click [OK].

For details about the login user name and password, contact your administrator.

[Address Management Tool] starts. Make the necessary settings.

5. Click [Exit].

6. Quit SmartDeviceMonitor for Admin.

• p.197 "Using Web Image Monitor"
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Using SmartDeviceMonitor for Client
To view the status of printers using SmartDeviceMonitor for Client, configure SmartDeviceMonitor for
Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, point to [Property], and then click
[Monitor Device Settings...].

2. On the [Printers Folder] tab, select the printer you want to monitor, and then select the [To
Be Monitored] check box in the Monitoring Information Settings area.

To display the name of the monitored printer on the task bar, you must first select the [Display on the
task bar menu] check box, and then select the [Displayed on Task Bar] check box.

3. Click [OK].

The dialog box closes and the configured printer is monitored.

• For details about status icons, see SmartDeviceMonitor for Client Help.
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Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, and then click the printer name on the
task bar.

The printer status appears in the dialog box.

• For details about items in the dialog box, see SmartDeviceMonitor for Client Help.

When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor for Client at a time. While
the network printer is printing, another user cannot access it until the job is finished. In this case,
SmartDeviceMonitor for Client tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times out, it will stop sending
the print job. In this case, you should cancel the paused status from the print queue window.
SmartDeviceMonitor for Client will resume access to the network printer. You can delete the print job
from the print queue window, but canceling a print job printed by the network printer might cause the
next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the network printer cancels
the job because something went wrong, send the print job again.

• Print jobs sent from another computer do not appear in the print queue window, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to network printers, the printing
order might not be the same as that in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is used for the
SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter “https://( printer's IP address or host name)/ ”. Internet Explorer must
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be installed on your computer. Use the highest version. Internet Explorer 6.0 or higher is
recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP to create or configure
an IPP port, or when printing, install the certificate. To select the certificate store location when using
Certificate Import Wizard, click [Place all certificates in the following store], and then click [Local
Computer] under [Trusted Root Certification Authorities].

• For details about SSL settings, contact your administrator.
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Printer Status Notification by E-Mail
Whenever a paper tray becomes empty or paper jams, a notification e-mail is sent to the registered
addresses.

You can make the timing and content settings for notification e-mail.

Configuring E-mail Notification

• Depending on your e-mail application, a phishing warning might appear after you receive an e-mail
message. To prevent phishing warnings appearing after you receive e-mail from a specified sender,
you must add the sender to your e-mail application's exclusion list. For details about how to do this,
see your e-mail application's Help.

• Service call.

• Toner is empty.

• Toner is nearly empty.

• Paper has jammed.

• Cover is open.

• Paper tray is empty.

• Paper tray is nearly empty.

• Paper tray error.

• Output paper tray is full.

• Unit connection error.

• Duplex unit error.

• Photoconductor unit needs replacing.

• Photoconductor unit needs replacing soon.

• Waste toner bottle is full.

• Waste toner bottle is nearly full.

• Stapler has no staples.

• Fusing unit needs replacing.

• Fusing unit needs replacing soon.

• Intermediate transfer unit needs replacing.

• Intermediate transfer unit needs replacing soon.

• Punch waste receptacle is full.
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• Memory for file storage is full soon.

• Log error.

1. Open a Web browser, and then enter "http://(printer's address)/" in the address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter "https://(printer's address)/".

2. Click [Login] on Top Page of Web Image Monitor.

The window for entering the login user name and password appears.

3. Enter the user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. In the menu area, click [Configuration].

5. On the [Device Settings] area, click [E-mail].

6. Make the following settings:

• Items in the Reception column: Make the necessary settings for sending and receiving e-mail.

• Items in the SMTP column: Configure the SMTP server. Check your mailing environment, and
then specify the necessary items. You can also perform mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check your mailing
environment, and then specify the necessary items. You can also perform mail authentication for
the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server. Check your mailing
environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be used for access to the
mail server.

• Items in the E-Mail Notification Account column: Specify these items if you want to use on-demand
e-mail notification.

7. Click [OK].

Auto E-mail Notification

1. Click [Configuration] in the menu area, and then click [Auto E-mail Notification] on the
[Device Settings] area.

The dialog box for making notification settings appears.

2. Make the following settings:

• Items in Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.
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• Items in the Groups to Notify column: E-mail notification addresses can be grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each notification type, such
as printer status and error.

To make detailed settings for these items, click [Edit] next to [Detailed Settings of Each Item].

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

On-demand E-mail Notification

1. Click [Configuration] in the menu area, and then click [On-demand E-mail Notification] on
the [Device Settings] area.

The dialog box for making notification settings appears.

2. Make the following settings:

• Notification Subject: Enter a text string to be added to the subject line of return e-mails.

• Items in Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.

• Items in the Access Restriction to Information column: Select whether to restrict accesses based
on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column: Enter an e-mail address
or domain name to use for requesting information by e-mail and to receive its return e-mail.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

SMTP authentication

Specify SMTP authentication.

When mail is sent to the SMTP server, authentication is performed using the SMTP AUTH protocol by
prompting the mail originator to enter the user name and password. This prevents illegal use of the
SMTP server.

1. In the menu area, click [E-mail]

2. Make the following settings:

Printer Status Notification by E-Mail

229

6



• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Auto Select]: If the authentication method is PLAIN, LOGIN, CRAM-MD5, or DIGEST-
MD5.

[Active]: If the authentication method is CRAM-MD5 or DIGEST-MD5.

[Inactive]: If the authentication method is PLAIN or LOGIN.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

POP before SMTP authentication

Select whether to log on to the POP3 server before sending e-mail.

1. In the menu area, click [E-mail].

2. Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before connecting to the SMTP
server after logging on to the POP server.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Sending On-demand E-mail

To use on-demand e-mail notification, perform the following configuration tasks in Web Image Monitor.

1. In the menu area, click [E-mail].

2. Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail notification.

• E-mail Notification User Name: Enter the administrator's user name as the mail originator name.
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• E-mail Notification Password: Enter the password of the mail notification user.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Format of on-demand e-mail messages

To use mail notification, you need to send an on-demand e-mail message to this printer.

Using your mail software, enter the following:

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For details,
see the table below.

From (Referred to as From) Specify a valid mail address. The device
information will be sent to the address specified
here.

Subject field

Format: devicestatus?parametername=parameter[&=parameter][& =parameter]...

Subject field coding examples

Coding example Action

devicestatus?request=sysconfig& format=text&
lang=en

The device's system configuration information
will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration information
will be sent in a preset format and language.

Parameters

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the format
preset for each mail address.

lang Language for mail body Mail will be sent in the
language preset for each mail
address.
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Parameters specifying the information to be obtained

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Parameters specifying the mail format

Mail format Parameter

Text text

HTML html

XML xml

Parameters specifying the language for mail body

Language for mail body Parameter

English en

French fr

German de

Italian it

Spanish es

Dutch nl

Danish da

Finnish fi

Norwegian no

Portuguese pt

Swedish sv
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Language for mail body Parameter

Czech cs

Polish pl

Hungarian hu

• A mail message must be within 1 MB in size.

• E-mail may be incomplete if sent immediately after power on.

• The Subject field is case-insensitive.

• Parameter names can be written in any order.

• HTML and XML can be selected for subject field, but output is text only.
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Remote Maintenance by telnet

• Remote Maintenance should be password-protected so that access is allowed to administrators only.

• The password is the same as the one of Web Image Monitor administrator. When the password is
changed using "mshell", other passwords change also.

• Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

• Only one user at a time can log on to perform remote maintenance.

1. Use the IP address or the host name of the printer to start telnet.

% telnet "IP_address"

2. Enter your user name and password.

Contact your administrator for information about the settings.

3. Enter a command.

4. Quit telnet.

msh> logout

The configuration message about saving the changes appears.

5. Enter "yes" to save the changes, and then press the [OK] key.

If you do not want to save the changes, enter "no", and then press the [OK] key. To make further
changes, enter "return" at the command line, and then press the [OK] key.

• If the message "Can not write NVRAM information" appears, the changes are not saved. Repeat the
procedure above.

• When the changes are saved, the network interface board is reset automatically with that changes.

• When the network interface board resets, the print job in print process will be printed. However, print
jobs in queue will be canceled.

8021x

Use "8021x" commands to display IEEE 802.1x related information.
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View settings

msh> 8021x

Configuration

msh> 8021x "parameter"

Parameter Value configured

eap {tls|ttls|leap|peap} {chap|mschap|
mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are
settings for the phase 2 method, and must be set
when using EAP-TTLS or PEAP.

Do not make these settings when using other EAP
authentication types.

If you select EAP-TTLS, you can select chap,
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or
tls.

username "character string" You can specify the login user name for the
Radius server.

Usable characters: ASCII 0x20-0x7e (31
bytes).

The default is blank.

username2 "character string" You can specify the phase 2 username for EAP-
TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31
bytes).

The default is blank.

domain "character string" You can specify the login domain name for the
Radius server.

The characters you can enter are ASCII
0x20-0x7e (31 bytes), but not "@" or "\".

The default is blank.
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Parameter Value configured

password "character string" You can specify the login for the Radius server.

Usable characters: ASCII 0x20-0x7e (128
bytes). The default is blank.

srvcert {on|off} You can set the server certificate. The default is
"off".

imca {on|off} You can enable or disable the certificate when
the intermediate certificate authority is present.
The default is "off".

srvid "character string" You can set the server ID and subdomain of the
certificate server.

Usable characters: ASCII 0x20-0x7e (128
bytes). The default is blank.

claer {a each command|all} Returns the selected setting to its default value.

If you specify "all", all settings will be restored to
their default values. However, IEEE 802.1x
Auth. status (enable or disable) for Ethernet and
wireless LAN will not be initialized.

access

Use the "access" command to view and configure access control. You can also specify two or more access
ranges.

View settings

msh> access

IPv4 configuration

msh> access [×] range "start-address end-address"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv4 addresses between 192.168.0.10 and 192.168.0.20:

msh> access 1 range6 192.168.0.10 192.168.0.20

IPv6 configuration

msh> access [×] range6 "start-address end-address"
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• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and 2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

IPv6 access mask configuration

msh> access [×] mask6 "base-address prefixlen"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses to 2001:DB8::/32

msh> access 1 mask6 2001:DB8:: 32

Access control initialization

msh> access flush

• Use the "flush" command to restore the default settings so that all access ranges become "0.0.0.0"
for IPv4, and ":: " for IPv6.

• The access range restricts computers from use of the printer by IP address. If you do not need to
restrict printing, make the setting "0.0.0.0" for IPv4, and "::" for IPv6.

• Valid ranges must be from lower (start address) to higher (end address).

• If you are running IPv4 or IPv6, up to five access ranges can be registered and selected.

• IPv6 can register and select the range and the mask for each access ranges.

• IPv6 mask ranges between 1 - 128 can be selected.

• Up to five access ranges can be specified. The entry is invalid if the target number is omitted.

• You cannot send print jobs, or access Web Image Monitor and diprint from a restricted IP
address.

appletalk

Use the "appletalk" command to view and configure Apple Talk parameters.

View settings

msh> appletalk

• [2] means "active" and [0] means "inactive".

• The default is [2].

Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.
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msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.

authfree

Use the "authfree" command to view and configure AuthFree parameters.

View settings

The following command displays the current AuthFree settings:

msh> authfree

• If print job authentication exclusion is not set, authentication exclusion control cannot be
displayed.

IPv4 address settings

msh> authfree "ID " range_addr1 range_addr2

IPv6 address settings

msh> authfree "ID " range6_addr1 range6_addr2

IPv6 address mask configuration

msh> authfree "ID " mask6_addr1 masklen

Parallel/USB settings

msh> authfree [parallel | usb] [on|off]

• To enable authfree, set to on. To disable authfree, set to off. Always specify the interface.

Authentication exclusion control initialization

msh> authfree flush

autonet

Use the "autonet" command to view and configure AutoNet parameters.

View settings

The following command displays the current AutoNet settings:

msh> autonet

Configuration

You can configure AutoNet settings.

msh> autonet {on|off}

• {on} means "active" and {off} means "inactive".
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Current interface priority configuration display

msh> autonet priority

Interface priority configuration

msh> autonet priority "interface_name"

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

• If an interface is not selected, the current interface connection settings remain in effect.

• For details about AutoNet, refer to autonet parameters.

bonjour

Use the "bonjour" command to display bonjour-related settings.

View settings

Bonjour settings are displayed.

msh> bonjour

Bonjour service name setting

You can specify the bonjour service name.

msh> bonjour cname "computer name"

• The computer name can be entered using up to 63 alphanumeric characters.

Bonjour Installation location information setting

You can enter information about the location where the printer is installed.

msh> bonjour location "location"

• Information about location can be entered using up to 32 alphanumeric characters.

Setting order of priority for each protocol

• diprint

msh> bonjour diprint [0-99]

• lpr
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msh> bonjour lpr [0-99]

• ipp

msh> bonjour ipp [0-99]

You can specify the order of priority for "diprint", "lpr", and "ipp". Smaller numbers indicate higher
priority.

IP TTL setting

msh> bonjour ip ttl {1-255}

You can specify the IP TTL (the number of routers a packet can pass through).

• The default is 255.

Resetting the computer name and location information

You can reset the computer name and location information.

msh> bonjour clear {cname | location}

• cname

Reset the computer name. The default computer name will be displayed when the computer is
restarted.

• location

Reset the location information. The previous location information will be deleted.

Interface configuration

msh> bonjour linklocal "interface_name"

• If many types of interface are installed, configure the interface that communicates with linklocal
address.

• If you do not specify an interface, the Ethernet interface is automatically selected.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface Interface configured

ether Ethernet interface

wlan Wireless LAN interface

btconfig

Use the “btconfig” command to make Bluetooth settings.

View settings

Bluetooth settings are displayed.
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msh> btconfig

Mode settings

You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private|public}

• The default is {public}.

devicename

Use the "devicename" command to display and change the printer name.

View settings

msh> devicename

Printer name configuration

msh> devicename name "string"

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

Printer name initialization

msh> device name clearname

Reset the printer name to its default.

dhcp

Use the "dhcp" command to configure DHCP settings.

View settings

The following command displays the current DHCP settings.

msh> dhcp

Configuration

You can configure DHCP.

msh> dhcp "interface_name" {on|off}

• Click {on} to enable DHCP. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be sure to click {on}.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface
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Interface name Interface configured

wlan Wireless LAN interface

Current interface priority configuration display

msh> dhcp priority

Interface priority configuration

msh> dhcp priority "interface_name"

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server or use the address set
by a user.

• To obtain the DNS server address from the DHCP server, specify "dhcp". To use the address set
by a user, specify "static".

Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the domain name set
by a user.

• To obtain the domain name from the DHCP server, specify "dhcp". To use the domain name set
by a user, specify "static".

dhcp6

Use the “dhcp6”command to display or configure DHCPv6 settings.

View settings

The following command displays the current DHCPv6 settings.

msh> dhcp6

DHCPv6-lite configuration and display

msh> dhcp6 “interface_name” lite {on|off}

Viewing and specifying DNS server address selection (obtained from the dhcpv6 server/user
specified value)

msh> dhcp6 dnsaddr {dhcp|static}

DUID(DHCP unique ID) deletion and display

msh> dhcp6 duid clear
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Viewing and specifying the time required to re-obtain the parameter obtained from dhcpv6

msh> dhcp6 ooption lifetime [0-65535]

• It can be entered between 0 and 65535 minutes.

• The default is 60 minutes.

• If you specify "0", you cannot re-obtain the value.

dns

Use the "dns" command to configure or display DNS (Domain Name System) settings.

View settings

The following command displays current DNS settings:

msh> dns

IPv4 DNS server configuration

The following command enables or disables the IPv4 DNS server address:

msh> dns "number" server "server address"

The following command displays a configuration using the IP address 192.168.15.16 on a DNS 1
server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can register up to three IPv4 DNS server numbers.

• You cannot use "255.255.255.255" as the DNS server address.

IPv6 DNS server configuration

The following command enables or disables the IPv6 DNS server address:

msh> dns "number" server6 "server address"

• You can register IPv6 DNS Server address.

• You can register up to three IPv6 DNS server numbers.

Dynamic DNS function setting

msh> dns "interface_name" ddns {on|off}

• You can set the dynamic DNS function "active" or "inactive".

• {on} means "active" and {off} means "inactive".

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface
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Interface name Interface configured

wlan Wireless LAN interface

Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update

To delete old records and register new records.

• add

To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means "active" and {off} means "inactive".

• The CNAME registered is the default name beginning with rnp. CNAME cannot be changed.

A records registration

msh> dns arecord {dhcp|own}

• {dhcp}

You can specify the method of registering an A record when the dynamic DNS function is enabled
and DHCP is used.

• {own}

To register an A record using the printer as the DNS client.

The DNS server address and the domain name already designated are used for the registration.

Record updating interval settings

msh> dns interval "time"

• You can specify the interval after which records are updated when using the dynamic DNS
function.

• The updating interval is specified hourly. It can be entered between 1 and 255 hours.

• The default is 24 hours.

domainname

Use the "domainname" command to display or configure the domain name settings.
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You can configure the Ethernet interface or wireless LAN interface.

View settings

The following command displays the current domain name:

msh> domainname

Interface domain configuration

msh> domainname "interface_name"

Setting the domain name

msh> domainname "interface_name" name "domain name"

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and wireless LAN interface will have the same domain name.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface Interface set

ether Ethernet interface

wlan Wireless LAN interface

Deleting the domain name

msh> domainname "interface_name" clear "name"

etherauth

Use "Ethernet" command to display or modify the authentication related parameters for Ethernet.

View settings

msh> etherauth

802.1x Configuration

msh> etherauth 8021x {on|off}

{on} means "active" and {off} means "inactive".

help

Use the "help" command to display the available command list and the procedures for using those
commands.

Command list display

msh> help
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Display of procedure for using commands

msh> help "command_name"

hostname

Use the "hostname" command to change the printer name.

View settings

msh> hostname

IPv4 Configuration

msh> hostname "interface_name" "printer_name"

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name starting with "RNP" or "rnp".

• The Ethernet interface and wireless LAN interface will have the same printer name.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Initializing the printer name for each interface

msh>hostname "interface_name" clear "name"

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet mask, broadcast address,
default gateway address) for the printer.

View settings

msh> ifconfig

IPv4 configuration

msh> ifconfig "interface_name" "parameter" "address"

• If you did not enter an interface name, it is automatically set to the Ethernet interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet Interface
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Interface name Interface configured

wlan wireless LAN Interface

The following explains how to configure an IPv4 address 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16

IPv6 configuration

msh> ifconfig ether inet6 "interface_name" "prefixlen"

The following explains how to configure a IPv6 address to 2001:DB8::100 with prefix length 64 on
the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

Netmask configuration

msh> ifconfig "interface_name" netmask "address"

The following explains how to configure a subnet mask 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

Broadcast address configuration

msh> ifconfig "interface_name" broadcast "address"

Changing the interface

msh> ifconfig "interface" up

You can specify either the Ethernet interface or wireless LAN interface when using the optional wireless
LAN interface unit is installed.

• To get the above addresses, contact your administrator.

• Use the default configuration if you cannot obtain setting addresses.

• The IP address, subnet mask and broadcast address are the same as that for the ethernet interface
and wireless LAN interface.

• TCP/IP configuration is the same for both Ethernet and wireless LAN interface. If interfaces are
changed, the new interface inherits the configuration.

• Use "0x" as the initial two letters of a hexadecimal address.

info

Use the "info" command to display printer information such as paper tray, output tray, and printer language.

Printer information display

msh> info
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• For details about displayed contents, see p.274 "Getting Printer Information over the Network".

ipsec

Use the "ipsec" command to view and configure IPsec settings.

Viewing settings

The following command displays the current IPsec settings:

msh> ipsec

• For details about displayed contents, see Security Guide.

ipp

Use the "ipp" command to view and configure IPP settings.

Viewing settings

The following command displays the current IPP settings:

msh> ipp

IPP timeout configuration

Specify how many seconds the computer waits before canceling an interrupted print job. The time
can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

IPP user authorization configuration

Use IPP user authorization to restrict users to print with IPP. The default is "off".

msh> ipp auth {basic|digest|off}

• User authorization settings are "basic" and "digest".

• Use "off" to remove a user's authorization.

• If user authorization is specified, register a user name. You can register up to 10 users.

IPP user configuration

Configure IPP users according to the following messages:

msh> ipp user

The following message appears:

msh> Input user number (1 to 10):

Enter the number, user name, and password.
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msh> IPP user name:user1

msh> IPP password:*******

After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the "ipv6" command to display and configure IPv6 settings.

View setting

msh> ipv6

IPv6 stateless address

msh> ipv6 stateless {on|off}

lpr

Use the “lpr” command to view and configure LPR settings.

View setting

msh> lpr

Checking host name when deleting the job

msh> lpr chkhost {on|off}

If “on” is selected, you can delete print jobs only from the IP address of the host that sent the print job.
If LPR is disabled, you can also delete print jobs sent from IP addresses other than that of the host.

Printer Error Detection Function

lpr prnerrchk {on|off}

If you set this to “on”, the printer stops receiving data and will wait until the error is resolved before
continuing processing a job.

netware

Use the "netware" command to configure the NetWare settings such as the print server name or file server
name.

Netware printer server names

msh> netware pname "character string"

• Enter the NetWare print server name using up to 47 characters.
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Netware file server names

msh> netware fname

• Enter the NetWare file server name using up to 47 characters.

Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

Remote printer number

msh> netware rnum {0-254}

Timeout

msh> netware timeout {3-255}

Printer server mode

msh> netware mode pserver

msh> netware mode ps

Remote printer mode

msh> netware mode rprinter

msh> netware mode rp

NDS context name

msh> netware context "character string"

SAP interval

msh> netware "sap_interval"

Setting login mode for file server

msh> netware login server

Setting login mode for NDS tree

msh> netware login tree

Setting login mode for NDS tree name

msh> netware tree "NDS name"

File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

If you do not specify the protocol, the current setting is displayed.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4
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Protocol Set Protocol

ipx IPX

passwd

Use the "passwd" command to change the remote maintenance password.

Changing the password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

Changing the Password of the administrators using the supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.

• Be sure not to forget or lose the password.

• The password can be entered using up to 32 alphanumeric characters. Passwords are case-sensitive.
For example, "R" is not the same as "r".

pathmtu

Use the "pathmtu" command to display and configure the PathMTU Discovery service function.

View settings

msh> pathmtu

Configuration

msh> pathmtu {on|off}

• The default is "on".

• If the MTU size of the sent data is larger than the router's MTU, the router will declare it
impassable, and communication will fail. If this happens, selecting the "pathmtu" to "off"
optimized the MTU size and prevents data output failure.

• Depending on the environment, information might not be obtained from the router, and
communication will fail. If this happens, select the "pathmtu" to "off".
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prnlog

Use the "prnlog" command to obtain printer log information.

Print logs display

msh> prnlog

• Displays 16 previous print jobs.

msh> prnlog "ID Number"

• Specify the ID number of the displayed print log information to display additional details about
a print job.

• For details about displayed contents, see p.274 "Getting Printer Information over the Network".

rhpp

Use the "rhpp" command to view and configure RHPP settings.

View settings

msh> rhpp

Changing rhpp port number

msh> rhpp [1024-65535]

• The default is 59100.

Setting timeout

msh> rhpp timeout [30-65535]

• The default is 300 seconds.

• “RHPP” is an abbreviation of “Reliable Host Printing Protocol”, which is a manufacturer-original
printing protocol.

route

Use the "route" command to view and control the routing table.

All route information display

msh> route get "destination"

• Specify the IPv4 address to destination.

"0.0.0.0" cannot be specified as destination address.
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Enabling/disabling specified IPv4 destination

msh> route active {host|net} "destination" {on | off}

• You can turn the specified destination on or off. Host becomes the default setting.

Adding IPv4 Routing Table

msh> route add {host|net} "destination" "gateway"

• Adds a host or network route to "destination", and a gateway address to "gateway" in the table.

• Specify the IPv4 address to destination and gateway.

• Host becomes the default setting.

Setting default IPv4 Gateway

msh> route add default gateway

Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} "destination"

• Host becomes the default setting.

• IPv4 address of destination can be specified.

Setting IPv6 Default Gateway

msh> route add6 default gateway

Adding a specified IPv6 destination to Routing Table

msh> route add6 "destination" "prefixlen" "gateway"

• Specify the IPv6 address to destination and gateway.

Deleting a specified IPv6 destination from Routing Table

msh> route delete6 "destination" "prefixlen"

• Specify the IPv6 address to destination and gateway.

Display information about a specified IPv6 route information

msh> route get6 "destination"

• Specify the IPv6 address to destination and gateway.

Enabling/disabling a specified IPv6 destination

msh> route active6 "destination" "prefixlen" {on | off}

Route initialization

msh> route flush

• The maximum number of IPv4 routing tables is 16.

• The maximum number of IPv6 routing tables is 2.

• Set a gateway address when communicating with devices on an external network.
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• The same gateway address is shared by all interfaces.

• "Prefixlen" is a number between 1 and 128.

set

Use the "set" command to set the protocol information display "active" or "inactive".

View settings

The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, Apple Talk, Netware, SCSI print, and
SMB appears.

msh> set parallel

msh> set usb

msh> set bluetooth

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6
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msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set bonjour6

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

Configuration

• Enter "up" enable protocol, and enter "down" to disable protocol.

You can set the protocol to "active" or "inactive".

msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http, bonjour, and sftp.

msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and sftp6.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}
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msh> set snmp {up | down}

msh> set ssl {up | down}

msh> set ssl6 {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not available for the
printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set bonjour6 {up | down}

msh> set ssh {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}

show

Use the "show" command to display network interface board configuration settings.

View settings

msh> show

• If "-p" is added, you can view settings one by one.

• For details about the information displayed, see p.281 "Understanding the Displayed Information".

slp

Use "slp" command to view and configure SLP settings.

msh> slp ttl "ttl_val"
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• You can search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1 and
Netware 6/6.5. Using the "slp" command, you can configure the value of TTL which can be used by
SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local segment. If the router does not
support multicast, the settings are not available even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the "smb" command to configure or delete the computer or workgroup name for SMB.

Computer Name settings

msh> smb comp "computer name"

• Set computer name using up to 15 characters. Names beginning with "RNP" or "rnp" cannot be
entered.

Working Group Name settings

msh> smb group "work group name"

• Set workgroup name using up to 15 characters.

Comment settings

msh> smb comment "comment"

• Set comment using up to 31 characters.

Notify print job completion

msh> smb notif {on | off}

• To notify print job completion, specify "on". Otherwise, specify "off".

Deleting Computer Nam

msh> smb clear comp

Deleting Group Name

msh> smb clear group

Deleting Comment

msh> smb clear comment

View Protocol

msh> smb protocol

snmp

Use the "snmp" command to display and edit SNMP configuration settings such as the community name.
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View settings

msh> snmp

• Default access settings 1 is as follows:

Community name:public

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-only

Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:

Community name:admin

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-write

Effective Protocol:IPv4/IPv6/IPX

• If "-p" is added, you can view settings one by one.

• To display the current community, specify its registration number.

Display

msh> snmp ?

Community name configuration

msh> snmp "number" name "community_name"

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor for
Client if "public" is not registered in numbers 1-10. When changing the community name, use
SmartDeviceMonitor for Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

Deleting community name

msh> snmp "number" clear name

Access type configuration

msh> snmp "number" type "access_type"

Access type Type of access permission

no not accessible

6. Monitoring and Configuring the Printer

258

6



Access type Type of access permission

read read only

write read and write

trap user is notified of trapmessages

Protocol configuration

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols "active" or "inactive": If you set a protocol "inactive",
all access settings for that protocol are disabled.

• Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.

• {on} means "active" and {off} means "inactive".

• All protocols cannot be turned off concurrently.

Configuration of protocol for each registration number

msh> snmp "number" active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command. However, if you have
disabled a protocol with the above command, activating it here has no effect.

Access configuration

msh> snmp "number" {ipv4|ipv6|ipx} "address"

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have IPv4, IPv6, and IPX
addresses with access types of "read-only" or "read-write". Enter "0" to have network interface
board accept requests from any host without requiring a specific type of access.

• Enter a host address to deliver "trap" access type information to.

• To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and then the IPv4 or IPv6
address.

• To specify IPX/SPX, enter "ipx" followed by a space, the IPX address followed by a decimal,
and then the MAC address of the network interface board.

sysLocation configuration

msh> snmp location

Deleting sysLocation

msh> snmp clear location

sysContact setting

msh> snmp contact
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Deleting sysContact

msh> snmp clear contact

SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify "on" to enable, and "off" to disable.

Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}

If a number from 1-5 is entered, settings are displayed for that number only.

Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} "address"

Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account "account_name"

Enter an account name using up to 32 alphanumeric characters.

Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}

Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

Set "auto" for automatic encryption configuration.

Set "on" for mandatory encryption configuration.
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sntp

The printer clock can be synchronized with a NTP server clock using Simple Network Time Protocol (SNTP).
Use the "sntp" command to change SNTP settings.

View settings

msh> sntp

NTP server address configuration

You can specify the IP address of the NTP server.

msh> sntp server "IP_address"

Interval configuration

msh> sntp interval "polling_time"

• You can specify the interval at which the printer synchronizes with the operator-specified NTP
server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After
that, the printer does not synchronize with the NTP server.

Time-zone configuration

msh> sntp timezone "+/-hour_time"

• You can specify the time difference between the printer clock and NTP server clock. The values
are between -12:00 and +13:00.

spoolsw

Use the "spoolsw" command to view and configure Job Spool settings.

You can only specify diprint, lpr, ipp, ftp, smb and sftp protocol.

View settings

The Job Spool setting appears.

msh> spoolsw

Job Spool setting

msh> spoolsw spool {on | off}

• Specify "on" to enable Job Spool, or "off" to disable it.

Resetting Job spool setting

msh> spoolsw clear job {on | off}
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• When the printer power is cut during job spooling, this determines whether to reprint the spooled
job.

Protocol configuration

msh> spoolsw diprint {on | off}

msh> spoolsw lpr {on | off}

msh> spoolsw ipp {on | off}

msh> spoolsw smb {on | off}

msh> spoolsw ftp {on | off}

msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, smb and sftp.

ssdp

Use the "ssdp" command to view and configure SSDP settings.

View settings

msh> ssdp

Setting effective time

msh> ssdp profile {1801-86400}

The default is 10800 seconds.

Advertise packet TTL settings

msh> ssdp ttl {1-255}

The default is 4.

ssh

Use the "ssh" command to view and configure SSH settings.

View settings

msh> ssh

Data compression communication settings

msh> ssh compression {on|off}

The default is "on".

SSH/SFTP communication port setting

msh> ssh port {22, 1024-65535}

The default is 22.
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SSH/SFTP communication timeout setting

msh> ssh timeout {0-65535}

The default is 300.

SSH/SFTP communication login timeout setting

msh> ssh logintimeout {0-65535}

The default is 300.

Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"

Create an open key for SSH/SFTP communication.

Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".

The default key length is 1024, and the character string is blank.

Deleting open key for ssh/sftp communication

msh> ssh delkey

• If you do not specify a character string, current setting is displayed.

status

Use the "status" command to display the printer status.

Messages

msh> status

• For details, see p.274 "Getting Printer Information over the Network".

syslog

Use the "syslog" command to display the information stored in the printer's system log.

View message

msh> syslog

• For details about the information displayed, see p.292 "Message List".
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upnp

Use the "upnp" command to display and configure the universal plug and play.

Public URL display

msh> upnp url

Public URL configuration

Msh< upnp url "string"

• Enter the URL string in the character string.

web

Use the "web" command to display and configure parameters on Web Image Monitor.

View Settings

msh> web

URL Configuration

You can set URLs linked by clicking URL on Web Image Monitor.

Specify "1" or "2" for x as the number corresponding to the URL. Up to two URLs can be registered
and specified.

msh> web url http://"The URL or IP address you want to register"/

Deleting URLs registered as link destinations

msh> web x clear url

Specify "1" or "2" for x as the corresponding number to the URL.

Link name configuration

You can enter the name for URL that appears on Web Image Monitor.

Specify "1" or "2" for x as the corresponding number to the link name.

msh> web name "Name you want to display"

Resetting URL names registered as link destinations

msh> web x clear name

Specify "1" or "2" for x as the number corresponding to the link name.

Help URL Configuration

You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://"Help URL or IP address"/help/

Deleting Help URL

msh> web clear help
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wiconfig

Use the "wiconfig" command to make settings for wireless LAN.

View settings

msh> wiconfig

View wireless LAN settings

msh> wiconfig cardinfo

• If wireless LAN is not working correctly, its information is not displayed.

Configuration

msh> wiconfig "parameter"

Parameter Value configured

mode {ap|802.11adhoc} You can set infrastructure mode (ap), or 802.11
ad hoc mode (802.11adhoc).

The default is infrastructure mode.

ssid "ID value" You can make settings for the SSID in the
infrastructure mode.

Usable characters are ASCII 0x20-0x7e (32
bytes).

An SSID value is set automatically to the nearest
access point if no setting is made.

If no setting is made for the ad hoc mode, the
same value as for the infrastructure mode or an
ASSID value is automatically set. The default is
blank.

channel "channel no." You can enable or disable the WEP function. To
enable the WEP function, specify [on]; to disable
it, specify [off].

To start the WEP function, enter the correct WEP
key. The default is "11".
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Parameter Value configured

key "key value" val {1|2|3|4} You can specify the WEP key when entering in
hexadecimal.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key, the WEP
specified by key phrase is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other. Put "0x" on the front of WEP key.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.
The default is blank.

keyphrase "phrase" val {1|2|3|4} You can specify the WEP key when entering in
ASCII.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key phrase, the
WEP specified by key is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.

encval {1|2|3|4} You can specify which of the four WEP keys is
used for packet encoding. "1" is set if a number
is not specified.
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Parameter Value configured

wepauth [open|shared] You can set an authorization mode when using
WEP. The specified value and authorized mode
are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto|11m|5.5m|2m|1m] You can set the wireless LAN transmitting speed.

The speed you specify here is the speed at which
data is sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc  {tkip|ccmp} You can specify WPA encryption key when using
WPA encryption.

tkip: TKIP (default)

ccmp: CCMP (AES)

wpaauth {wpapsk | wpa} You can specify the WPA authentication mode
when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA(802.1X) authentication

psk "character string" You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63
bytes).

The default is blank.
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Parameter Value configured

eap {tls|ttls|leap|peap} {chap|mschap|
mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are
settings for the phase 2 method, and must be set
when using EAP-TTLS or PEAP.

Do not make these settings when using other EAP
authentication types.

If you select EAP-TTLS, you can select chap,
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or
tls.

username "character string" You can specify the login user name for the
Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes)
other than "@". The default is blank.

username2 "character string" You can specify the phase 2 username for EAP-
TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 bytes)
other than "@". The default is blank.

domain "character string" You can specify the login domain name for the
Radius server.

Usable characters: ASCII0x20-0x7e (31 bytes)
other than "@". The default is blank.

password "character string" You can specify the login password for the
Radius server.

Usable characters: ASCII 0x20-0x7e(128
bytes). The default is blank.

srvcert {on | off} You can set the server certificate. The default is
"off".
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Parameter Value configured

imca {on | off} You can enable or disable the certificate when
the intermediate certificate authority is present.
The default is "off".

srvid "character string" You can set the server ID and subdomain of the
certificate server.

• You can use this command only when the wireless LAN interface unit is installed.

wins

Use the "wins" command to configure WINS server settings.

Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 address, the DHCP address
is the valid address.

Configuration

msh> wins "interface_name" {on | off}

• {on} means "active" and {off} means "inactive".

• Be sure to specify the interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Address configuration

Use the following command to configure a WINS server IP address:

msh> wins "interface_name" {primary|secondary} "IP address"

• Use the "primary" command to configure a primary WINS server IPv4 address.

• Use the "secondary" command to configure a secondary WINS server IPv4 address.

• Do not use "255.255.255.255" as the IPv4 address.
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NBT (NetBIOS over TCP/IP) Scope ID Selection

You can specify the NBT scope ID.

msh> wins "interface_name" scope "scope ID"

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

wsmfp

Use the “wsmfp” command to view and configure WS-MFP settings.

View settings

msh> wsmfp

Comment settings

msh> wsmfp comments “comment”

• If you do not specify a comment, current setting is displayed.

Location configuration

mah> wsmfp location “location”

• If you do not specify a comment, current setting is displayed.

Presentation URL configuration

msh> wsmfp url “URL”

• Ebter the URL string in the “URL”.

WS-Device TCP port configuration

msh> wsmfp devport “port_number”

• The Default is 53000.

WS-Printer TCP port configuration

msh> wsmfp prnport “port_number”

• The Default is 53001.

Timeout configuration

msh> wsmfp prntimeout [30-65535]

6. Monitoring and Configuring the Printer

270

6



• The default is 900 seconds.

Comment initialization

msh> wsmfp clear comments

Location initialization

msh> wsmfp clear location

Presentation URL initialization

msh> wsmfp clear url
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SNMP
Using the SNMP manager, you can get information about the printer.

The SNMP agent operating on UDP and IPX is incorporated into the built-in Ethernet board and optional
wireless LAN interface unit of this printer.

This printer also supports SNMPv3, which increases user authentication, data encryption, and access
control security.

To encrypt communication by SNMPv3, you must specify the printer's encrypted password.

• If you changed the printer's community name, change the configuration of the connected computer
accordingly, using SNMP Setup Tool. For details, see SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB information using these community
names.

Start SNMP Setup Tool

• Windows XP/Vista:

Click the [Start] button.

Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.

Click [SNMP Setup Tool].

Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• IPv6-TCP-MIB

• IPv6-UDP-MIB

• IPv6-MIB

• IPv6-ICMP-MIB

• RicohPrivateMIB

Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• IPv6-TCP-MIB

• IPv6-UDP-MIB

• IPv6-MIB

6. Monitoring and Configuring the Printer

272

6



• IPv6-ICMP-MIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network
This section explains details of each item displayed in the printer status and information.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the "lpq" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "status" command.

Messages Description

Add staples (Booklet: Back) The staple of booklet finisher (back) is
exhausted.

Add staples (Booklet: Both) The staple of booklet finisher is exhausted.

Add staples (Booklet: Front) The staple of booklet finisher (front) is exhausted.

Adjusting... The printer is initializing or calibrating.

Call Service Center There is a malfunction in the printer.

Canceling Job... The job is being reset.

Configuring... Setting is being changed.

Cover Open: Bridge Unit Left The left cover of the Bridge Unit is open.

Cover Open: Bridge Unit Right The right cover of the Bridge Unit is open.

Cover Open: Duplex Unit The cover of the duplex unit is open.

Cover Open: Finisher Front The front cover of Finisher is open.

Cover Open: Finisher Upper The upper cover of Finisher is open.

Cover Open: Front The front cover is open.

Cover Open: Lower Right The lower right cover is open.

Cover Open: Lower Right Cover The lower right cover is open.

Cover Open: Mailbox The cover of the mailbox is open.

Cover Open: Upper Right Cover The upper right cover of the duplex unit is open.
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Messages Description

Current Job Suspended Current job is suspended.

Empty: Black Toner The black toner cartridge is almost empty.

Empty: Cyan Toner The cyan toner cartridge is almost empty.

Empty: Magenta Toner The magenta toner cartridge is almost empty.

Empty: Yellow Toner The yellow toner cartridge is almost empty.

Energy Saver Mode The printer is in Energy Saver Mode.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Optional Font An error has occurred in the font file of the printer.

Error: Optional RAM An error has occurred in the optional memory
unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description
language.

Error: Rem. Certificate Renewal An error has occurred in the remote certificate
renewal.

Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Board An error has occurred in the wireless board.

Error: Wireless Card Wireless card is not inserted during start up, or
the wireless LAN interface unit or the wireless
card is taken out after start up.

Exceed Booklet Stapling Limit The printing has exceeded the stapling limit of
the booklet finisher.

Full: Finisher Booklet Tray Booklet tray of Finisher is full.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Finisher Upper Tray The upper tray of Finisher is full.

Full: Hole Punch Receptacle Punch Chip receptacle for hole punch is full.
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Messages Description

Full: Mailbox Tray 1 Tray 1 of the mailbox is full.

Full: Mailbox Tray 2 Tray 2 of the mailbox is full.

Full: Mailbox Tray 3 Tray 3 of the mailbox is full.

Full: Mailbox Tray 4 Tray 4 of the mailbox is full.

Full: Output Tray(s) All the output paper trays are full.

Full: Standard Tray Standard output tray is full.

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode.

Independent-supplier Toner Toner that is not recommended is set.

Jobs Suspended All jobs are suspended.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Cyan Toner The cyan toner cartridge is not set correctly, or
toner is almost running out.

Low: Magenta Toner The magenta toner cartridge is not set correctly,
or toner is almost running out.

Low: Yellow Toner The yellow toner cartridge is not set correctly, or
toner is almost running out.

Malfunction: Booklet Processor There is a problem with booklet finisher.

Malfunction: Finisher There is a problem with Finisher.

Malfunction: Output Tray There is a problem with output tray.

Malfunction: Staple Unit There is a problem with the staple unit.

Malfunction: Tray 1 There is a problem with tray 1.

Malfunction: Tray 2 There is a problem with tray 2.

Malfunction: Tray 3 There is a problem with tray 3.
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Messages Description

Malfunction: Tray 3 (LCT) There is a problem with the large capacity tray.

Malfunction: Tray 4 There is a problem with tray 4.

Malfunction: Tray 5 There is a problem with tray 5.

Mismatch: Paper Size Indicated paper tray does not contain paper of
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of
selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of
selected type.

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Near Replacing: Color PCU Prepare the new color photoconductor unit.

Near Replacing: Fusing Unit Prepare the new fusing unit.

Near Replacing: Int. Transfer Prepare the new transfer unit.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

Need more Staples Stapler has almost run out of staples.

No Paper: Selected Tray There is no paper in specified tray.

No Paper: Tray 1 There is no paper in tray 1.

No Paper: Tray 2 There is no paper in tray 2.

No Paper: Tray 3 There is no paper in tray 3.

No Paper: Tray 3 (LCT) There is no paper in the large capacity tray.

No Paper: Tray 4 There is no paper in tray 4.

No Paper: Tray 5 There is no paper in tray 5.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Cyan Toner Cyan toner is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.
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Messages Description

Not Detected: Intermediate Transfer Unit The transfer unit is not correctly set.

Not Detected: Magenta Toner Magenta toner is not correctly set.

Not Detected: PCU (C) The photoconductor unit (cyan) is not correctly
set.

Not Detected: PCU (K) The photoconductor unit (black) is not correctly
set.

Not Detected: PCU (M) The photoconductor unit (magenta) is not
correctly set.

Not Detected: PCU (Y) The photoconductor unit (yellow) is not correctly
set.

Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: Tray 3 (LCT) The large capacity tray is not correctly set.

Not Detected: Tray 4 Tray 4 is not correctly set.

Not Detected: Tray 5 Tray 5 is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Detected: Yellow Toner Yellow toner is not correctly set.

Offline Printer is offline.

Paper in Finisher The paper remains in Finisher.

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit.

Paper Misfeed: Input Tray The paper has jammed in the input tray.

Paper Misfeed: Internal/Output The paper has jammed inside the printer.

Paper Misfeed: Mailbox The paper has jammed in the mailbox.

Printing... Printing is in progress.

Proxy User/Password Incorrect Proxy user name or Password is incorrect.
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Messages Description

Ready The printer is ready to print.

Renewing Remote Certificate Remote Certificate is Renewing.

Replace Black PCU It is time to replace the black photoconductor
unit.

Replace Fusing Unit It is time to replace the fusing unit.

Replace Int. Transfer Unit It is time to replace the transfer unit.

Replace PCU (Color) It is time to replace the photoconductor unit
(color).

SD Card Authentication failed SD card authentication failed.

Supplies Order Call failed The supply order call has failed.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex
printing.

Warming Up... The printer is warming up.

• For details about UNIX commands, see UNIX Supplement.

• Check the error contents that may be printed in the configuration page. For details about printing a
configuration page, see p.162 "List/Test Print Menu".

Printer Configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer language.

• UNIX: Use the "info" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "info" command.

Input Tray

Item Description

No. ID number of the paper tray
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Item Description

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal: Normal

• NoInputTray: No tray

• PaperEnd: No paper

Output Tray

Item Description

No. ID number of the output tray

Name Name of the output tray

status Current status of the output tray

• Normal: Normal

• PaperExist: Paper exist

• OverFlow: Paper is full

• Error: Other errors

Emulation

Item Description

No. ID number of the printer language used by the
printer

Name Name of the printer language used in the printer

Version Version of the printer language

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see p.234 "Remote Maintenance by telnet".
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Understanding the Displayed Information
This section explains how to read status information returned by the network interface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the "info" command and "rsh", "rcp", and "ftp" parameters.

• mshell: Use the "info" command.

Item Description

Rank Print job status.

• Active

Printing or preparing for printing.

• 1st, 2nd, 3rd, 4th...

Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see p.234 "Remote Maintenance by telnet".

Print Log Information

This is a record of the most recent 16 jobs printed.

Use the following command to display print log information:

• UNIX: Use the "prnlog" command and "rsh", "rcp", and "ftp" parameters.

• telnet : Use the "prnlog" command. See p.234 "Remote Maintenance by telnet".
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Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result

Print Request Result

Communication Result

• OK

Print was completed normally. However, the
print result may not be as required due to
printer problems.

• NG

Printing was not completed normally.

• Canceled

An "rcp", "rsh", or "lpr" command print request
was canceled, possibly due to the printing
application. Not applicable to the "ftp" or
"rprinter" command.

Time Time the print requested was received.

Time of print request reception

User ID
Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName
Name of the document for printing

Appears when the print request ID is specified.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see p.234 "Remote Maintenance by telnet".

Configuring the Network Interface Board

Use the following command to display network interface board settings:
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• telnet : Use the "show" command.

Item Description

Common

Mode

Protocol Up/Down Protocol Settings

AppleTalk

IPv4

IPv6

IPsec

NetWare

SMB

PictBridge

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk settings

Mode
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Item Description

Net

Object

Type

Zone

TCP/IP TCP/IP settings

Mode(IPv4)

Mode(IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

bonjour

ssl

nrs

rfu

nbt

ssdp

ssh
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Item Description

sftp

WSD (Device)

WSD (Printer)

rhpp

IPv4

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless

Manual

Gateway

DHCPv6-lite

DUID

DHCPv6 option lifetime

IPsec

Manual Mode

Excluded Protocol

https

dns

dhcp

wins

EncapType
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Item Description

Host name

DNS Domain

Access Control Access Control settings

IPv4

AccessEntry[X] X can be set between 1 and 5.

IPv6

AccessEntry[X] X can be set between 1 and 5.

SNTP Server Time settings

Time Zone

SNTP Server polling time

SYSLOG server Websys settings

Home page URL1

Home page linkname1

Home page URL2

Home page linkname2

Help page URL

RHPP Port

RHPP timeout

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch
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Item Description

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name

Transfer Protocol

SMB SMB settings

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

Protocol

Wireless LAN Wireless LAN settings

Host Name

Communication Mode

SSID

Channel

Security
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Item Description

WEP Authentication

WEP Encryption key number

WEP Encryption keys [X] X can be set between 1 and 4.

WPA Encryption

WPA Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert.

Intermediate CA

Server ID

Sub domain

MIC check

Ethernet

802.1X Authentication

DNS DNS settings

IPv4

Server[X] X can be set between 1 and 3.

Selected IPv4 DNS Server

IPv6
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Item Description

Server[X] X can be set between 1 and 3.

Selected IPv6 DNS Server

Resolver Protocol

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

Bluetooth

Bluetooth mode

SSDP SSDP settings

UUID

Profile

TTL

UPnP UPnP settings

URL

Bonjour Bonjour (Rendezvous) settings
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Item Description

Computer Name (cname)

Local Hostname (ether)

Local Hostname (wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for Multi I/F

IPP Port

SNMP SNMP settings

SNMPv1v2

SNMPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remote Setting

SNMPv3 Privacy

ssh ssh settings

Compression

Port

TimeOut

Login TimeOut

AuthFree Authfree settings
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Item Description

IPv4

AuthFreeEntry[X] X can be set between 1 and 5.

IPv6

AuthFreeEntry[X] X can be set between 1 and 5

Parallel

USB

LPR

lprm check host

lpr prnerrchk

Certificate

Verification

IEEE 802.1X

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert.

Intermediate CA

Server ID

Sub domain

Shell mode Remote maintenance tool mode
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Message List
This is a list of messages that appear in the printer's system log. The system log can be viewed using the
"syslog" command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the "syslog" command and "rsh", "rcp", "ftp", and "sftp" parameters.

• telnet: Use the "syslog" command.

Message Problem and solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print server
on the NetWare server on the password was
incorrect.

(In the print server mode) Login to the file server

failed. Make sure that the print server is registered
on the file server. If a password is specified for the
print server, delete it.

account is unavailable: encryption is impossible. Encryption is not possible and account is disabled.
This could be because:

• Security option is not installed.

• Encryption password has not been specified.

account is unavailable: same account name be
used.

User account is disabled. This could be because it
uses the same account name as the administrator
account.

account is unavailable: The authentication
password is not set up.

User account is disabled. This could be because the
authentication password is not set, and only the
encryption account is set.

add_sess_IPv4: bad trap addr:<IPv4 address>,
community:<community name>

The IPv4 address (0.0.0.0.) is unavailable when the
community access type is TRAP. Specify the host
IPv4 address for the TRAP destination.

add_sess_IPv4: community<community name>
already defined.

The same community name already exists. Use
another community name.

add_sess_IPv6: bad trap addr:<IPv6 address>,
community:<community name>

The IPv6 address [::] is unavailable when the
community access type is TRAP. Specify the host
IPv6 address for the TRAP destination.
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Message Problem and solutions

add_sess_IPv6: community <community name>
already defined.

The same community name already exists. Use
another community name.

add_sess_IPX: bad trap addr:<IPX
address>community <community name>

The IPX address (00:00:00:00:00:00) is
unavailable when the community access type is
TRAP. Specify the host IPX address for the TRAP
destination.

add_sess_IPX: community <community name>
already defined.

The same community name already exists. Use
another community name.

adjust time server <NTP server> offset:XX sec. ncsd tells you the timing of the NTP server and
whether or not the time system clock is set.

Attach FileServer =<file server> Connection to the file server as the nearest server
has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the print
queue.

btd is disabled. Communication via Bluetooth is unavailable
because btd is disabled in the security mode.

Enable the btd in the security mode.

centrod is disabled. Communication via parallel connections
unavailable because centrod is disabled in the
security mode.

Enable centrod in the security mode.

child process exec error! (process name) The network service failed to start. Turn the printer
off and then on. If this does not work, contact your
service or sales representative.

Connected DHCPv 6 server (IPv 6 address) The IP address was successfully received from the
DHCPv 6 server.

connection from <IP address> A user logged in from the host <IP address>.

Could not attach to FileServer <error number> (In the remote printer mode) Connection to the file
server has not been established. The file server has
refused the connection. Check the file server
configuration.
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Message Problem and solutions

Could not attach to PServer <printer server name> (In the remote printer mode) Connection to the print
server has not been established. The print server
has refused the connection. Check the print server
configuration.

Current Interface Speed: <EhternetI/F speed> Speed of the Ehternet interface (10Mbps, 100
Mbps, or 1Gbps).

Current IPX address <IPX address> Current IPX address

DHCPv6 server not found. The DHCPv6 server was not found. Make sure that
the DHCPv6 is on the network.

Duplicate IP=<IP address>(from<MAC address>). The same IP address (IPv4, or IPv6 address) was
used. Each IP address (IPv4, or IPv6 address) must
be unique. Check the address of the device
indicated in <MAC address>.

Established SPX Connection with PServer ,
(RPSocket=<socket number>,
connID=<connection ID>)

(In the remote printer mode) Connection to the print
server has been established.

Exit pserver (In the print server mode) The print server function
is disabled because the necessary print server
settings have not been made.

Frametype=<frame type name> The frame type name is configured to be used on
NetWare.

IEEE 802.11 <communication mode> mode Displays Wireless LAN communication mode
(infrastructure, or 802.11 ad hoc).

IEEE 802.11 Card does NOT support WPA . A wireless card that does not support WPA is
installed. Install a wireless card that supports WPA.

IEEE 802.11 Card Firmware REV.<version> Displays the version number of the 802.11 card's

firmware.

IEEE 802.11 current channel <channel number> Displays the current channel number of the active

wireless card (in ad hoc and infrastructure mode).

IEEE 802.11 MAC Address = <MAC address> Displays the MAC address of the wireless interface.
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Message Problem and solutions

IEEE 802.11 SSID <ssid> (AP MAC Address
<MAC address>)

The MAC address and SSID of the access point are
connected in infrastructure mode.

(IKE phase-1) mismatched authentication type:
local=<authentication type 1>
remote=<authentication type 2>

This machine's <authentication type 1> in IKE phase
1 does not match the communicating host's
<authentication type 2>, Make sure this machine's
ISAKMP SA authentication type matches that of the
communicating host.

(IKE phase-1) mismatched DH group: local=<DH
group number 1> remote=<DH group number 2>

This machine's ISAKMP SA Oakley group <DH
group number 1> in IKE phase 1 does not match
the communicating host's ISAKMP SA Oakley
group <DH group number 2>, Make sure this
machine's ISAKMP SA Oakley group matches that
of the communicating host.

(IKE phase-1) mismatched encryption type:
local=<encryption algorithm 1>
remote=<encryption algorithm 2>

This machine's ISAKMP SA Oakley group
<encryption algorithm 1> in IKE phase 1 does not
match the communicating host's ISAKMP SA
Oakley group < encryption algorithm 2>, Make
sure this machine's ISAKMP SA Oakley group
matches that of the communicating host.

(IKE phase-1) mismatched hash type: local=<Hash
Algorithm 1> remort=<Hash Algorithm 2>

This machine's ISAKMP SA <Hash Algorithm 1> in
IKE phase 1 does not match the communicating
host's ISAKMP SA <Hash Algorithm 2>, Make sure
this machine's ISAKMP SA Hash Algorithm matches
that of the communicating host.

IKE[%s] is disable, set PSK text.

inetd start. The inetd service has started.

< Interface > started with IP: < IP address > IP address (IPv4, or IPv4 address) has been set for
the interface and is operating.

job canceled. jobid=<job ID>.
The spooled job was canceled due to error or user
request.

LeaseTime=< lease time >(sec), RenewTime=<
renew time >(sec).

The resource lease time received from the DHCP
server is displayed in < lease time > in seconds. The
renewal time is displayed in < renew time > in
seconds.
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Message Problem and solutions

Login to fileserver <file server name>(<IPX|
IP>,<NDS|BINDERY>)

(In the print server mode) Login to the file server is
in the NDS or BINDERY mode.

Manual[%s] is disable, set authentication key.

Manual[%s] is disable, set encryption key.

Name registration failed. name=<NetBIOS name>
Name registration of <NetBIOSName> failed.

Change to different NetBIOS name.

Name registration success . WINS Server =<WINS
server address> NetBIOS Name=<NetBIOS
name>

Name registration of <NetBIOS Name> to <WINS
server address> was successful.

Name registration success in Broadcast name
=<NetBIOS name>

Name registration by Broadcast name of
<NetBIOS Name> was successful.

npriter start. (NetWare)
(In the remote printer mode) The NetWare service
has started.

Open log file <file name>
(In the print server mode) The specified log file has
been opened.

Print queue <print queue name> cannot be serviced
by printer 0, <print server name>

(In the print server mode) The print queue cannot
be established. Make sure that print queue exists
on the specified file server.

Print server <print server name> has no printer
(In the print server mode) The printer is not assigned
to the print server. Using NWadmin, assign the
printer, and then restart it.

print sessions full
No more print jobs can be accepted. Wait a while

before sending any more print jobs.

Printer <printer name> has no queue
(In the print server mode) The print queue is not
assigned to the printer. Using NWadmin, assign the
print queue to the printer, and then restart it.

pserver start. (NetWare)
(In the print server mode) The NetWare service has
started.

Required file server (<file server name>) not found The required file server is not found.
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Message Problem and solutions

sap enable, saptype=<SAP type>, sapname=<SAP
name>

The SAP function has started. The SAP packet is
issued to advertise the service on the SAP table on
the NetWare server.

session_IPv4 <community name> not defined. The requested community name is not defined.

session_IPv6 <community name> not defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

Set context to <NDS context name> An NDS context name has been set.

shutdown signal received. network service
rebooting...

The smbd service has started.

Smbd start. (NetBIOS) SMBD (ServerMessageBlockDaemon) has been
started.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This could be
because no connection to the network has been
established, or the network configuration is
incorrect, so there is no response from the SMTP
server, or the specified SMTP server name is
incorrect, or the specified SMTP server IP address
could not be found in the DNS server, or a server
other than the SMTP server has been specified, or
the specified SMTP server port number is incorrect.
Check the DNS Server's IP address and SMTP
server's IP address, or the SMTP server name and
SMTP port number, or the SMTP server's SMTP port
number, or the network connection and
configuration.

SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to
timeout. This could be because the specified SMTP
server name is incorrect, or no connection to the
network has been established, or the network
configuration is incorrect, so there is no response
from the SMTP server. Check the SMTP server
name, or the network connection and
configuration.
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Message Problem and solutions

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be obtained.
This could be because:

• The specified DNS server could not be found.

• No connection to the network has been
established.

• The specified DNS server could not be found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address could
not be found in the DNS server.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to no
response from SMTP. This could be because a
server other than the SMTP server has been
specified, or the specified SMTP server port number
is incorrect. Check the SMTP server name, port
number, or the SMTP server port number.

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This could
be because server other than the SMTP server has
been specified, or the specified SMTP server port
number is incorrect. Check the SMTP server name,
port number, or the SMTP server port number.

SMTPC: username or password wasn't correct.
[response code] (information)

Connection to the SMTP server failed, because the
specified SMTP user name is incorrect, or the
specified SMTP password is incorrect. Check the
SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over IPX is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.

The print server received error <error number>
during attempt to log in to the network. Access to
the network was denied . Verify that the print server
name and password are correct .

Login to the file server failed. The print server is not
registered or a password is specified. Register the
print server without specifying a password.
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Message Problem and solutions

trap account is unavailable. v3Trap cannot be sent. This could be because the
Trap destination account is different from the
account specified by the printer.

Updated (option name) (value) via DHCPv6 Server The parameter obtained from the DHCP server has
been updated.

WINS name registration: No response to server
(WINS server address)

There was no response from the WINS server.

Check the correct WINS server address is entered.
Alternatively, check the WINS server is functioning
properly.

WINS wrong scopeID =< scopeID > An invalid scope ID was used. Use a valid scope
ID.

write error occurred.(diskfull) A "diskfull" error occurred while the printer was
writing to the spool file. Wait for the current print
job to finish. When it finishes, more HDD space will
be available. Only page that were spooled when
the error occurred will be printed.

write error occurred.(fatal) A fatal error occurred while the printer was writing
to the spool file. Turn off the power of the printer,
and then turn it on again. If the error recurs, contact
your service representative. The print job that was
being spooled when the error occurred will not be
printed.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about "syslog" command, see p.234 "Remote Maintenance by telnet".
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7. Using a Printer Server
This chapter explains how to configure this printer to work as a network printer.

Preparing Printer Server
This section explains how to configure the printer as a Windows network printer. The printer is configured
to enabling network clients to use it. When the network printer is connected via SmartDeviceMonitor for
Client, you can set the printing notification function to notify clients of the results of their print jobs.

• Under Windows XP Professional or Windows Server 2003/2003 R2, to change printer properties
in the [Printer] folder, you need Printer Management access authentication; under Windows Vista or
Windows Server 2008, Full Control access authentication. Log on to the file server as an Administrator
or member of the PowerUsers group.

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties]. The printer
properties appear.

3. On the [Sharing] tab, click [Share this printer].

4. To share the printer with users using a different version of Windows, click [Additional
Drivers...].

If you have installed an alternative driver by selecting [Share As:] during the printer driver installation,
this step can be ignored.

5. Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification function of
SmartDeviceMonitor for Client.

Setting the print server

• Under Windows XP Professional or Windows Server 2003/2003 R2, to change printer properties
in the [Printer] folder, you need Printer Management access authentication; under Windows Vista or
Windows Server 2008, Full Control access authentication. Log on to the file server as an Administrator
or member of the PowerUsers group.
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1. On the [Start] menu, point to [All Programs], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Print Server Setting].

The print server setting dialog box appears.

2. Select the [Notify client PCs of printout/data-transmission] check box, and then click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog box content, and click
[OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting.

3. Click [OK].

The print server setting is completed. Each client must be set to receive print notification.

• Current printing jobs restart from the beginning after the spooler pauses briefly.

• When the expansion function is not used, the function is automatically set as available.

• If you log on using an account that does not have Administrator privileges, the client may not be
notified.

• For details, see "Using SmartDeviceMonitor for Client".

• p.224 "Using SmartDeviceMonitor for Client"

Setting a client

1. On the [Start] menu, point to [All Programs], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

2. Select the [Notify of printout/data-transmission when using print server] check box.

3. Click [OK].

The client setting is completed.

• Set the printing notification function on the printer driver as well as on SmartDeviceMonitor for
Client.
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Using NetWare
This section describes the setting procedure for network printers in the NetWare environment. In the
NetWare environment, you can connect the printer as a “print server” or “remote printer”.

• IPv6 cannot be used on this function.

Setting procedure

• When using the printer as a print server

1. Installing SmartDeviceMonitor for Admin

2. Setting the network interface board.

3. Turning the printer off and then back on.

• When using the printer as a remote printer

1. Installing SmartDeviceMonitor for Admin.

2. Setting the network interface board.

3. Setting NetWare.

4. Starting the print server.

• This procedure assumes an environment is already prepared for normal NetWare running
the printing service setting.

• The procedure is explained with the following example settings:

• File server's name ...CAREE

• Print server's name ...PSERV

• Printer's name ...R-PRN

• Queue name ...R-QUEUE

Using SmartDeviceMonitor for Admin

To use the printer in a NetWare environment, use SmartDeviceMonitor for Admin to set the NetWare
printing environment.

Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin lists printers connected to the network. If you cannot identify the printer
you want to configure, print configuration page, and then check the printer name.

• The NetWare Client provided by Novell is required to set the printing environment using
SmartDeviceMonitor for Admin under the following environments:

• NDS or Bindery mode in Windows 2000/XP
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• For details about SmartDeviceMonitor for Admin, see "Using SmartDeviceMonitor for Admin".

• p.208 "Using SmartDeviceMonitor for Admin"

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using NetWare 3.x.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use up
to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote printer.
Enter the same number as the number of the printer to be created on the print server (0 to 254
characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer cannot
detect when a print job ends. Therefore, the printer terminates printing when a certain period of
time has elapsed since it last received print data (i.e., when it has not received print data for a
certain period of time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.
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5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several before restarting Web Image Monitor.

6. Click [Logout].

• To check the configuration is correct, enter the following from the command prompt:

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see "Test
Printing", Quick Installation Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Guide, which is the administrator's
manual.

• p.197 "Using Web Image Monitor"

Setting Up as a Print Server (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to connect the printer as a print server using NetWare 4.x, NetWare 5 / 5.1,
or NetWare 6 / 6.5.

• When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5,
set it to the NDS mode.

• When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print server.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.
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6. Click [Logout].

7. Quit Web Image Monitor.

• To check the configuration is correct, enter the following from the command prompt:

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see "Test
Printing", Quick Installation Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Guide, which is the administrator's
manual.

• p.197 "Using Web Image Monitor"

Using Pure IP in the NetWare 5 / 5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP environment of NetWare
5 / 5.1 or NetWare 6 / 6.5.

• When creating a queued print server in a pure IP environment of NetWare 5 / 5.1 or NetWare 6 /
6.5, create a print queue on the file server using NetWare Administrator.

• This printer is not available as a remote printer for use in a pure IP environment.

• To use the printer in a pure IP environment, set it to IPv4.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Select the object in which the print queue is located in the directory tree, and then click
[Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].
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6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Select the object in which the printer is located, and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name.

11. Select the [Define additional properties] check box, and then click [Create].

12. Click [Assignments], and then click [Add] in the [Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK].

16. Check the settings, and then click [OK].

17. Select a context specified, and then click [Create] on the [Object] menu.

18. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Server (Non NDPS)].

19. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using SmartDeviceMonitor for Admin.

20. Select the [Define additional properties] check box, and then click [Create].

21. Click [Assignments], and then click [Add] in the [Assignments] area.

22. In the [Available objects] box, click the queue you created, and then click [OK].

23. Check the settings, and then click [OK].

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver print_server_name

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.
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3. Enter the user login user name and password, and then click [Login].

For details about the login name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see "Test
Printing", Quick Installation Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Guide, which is the administrator's
manual.

• p.197 "Using Web Image Monitor"

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare 3.x.

Setting up using PCONSOLE

1. Enter “PCONSOLE” from the command prompt.

F:> PCONSOLE

2. Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

3. From the [Available Options] menu, select [Print Queue Information], and then press the
[Enter] key.

4. Press [Insert] key, and then enter a print queue name.

5. Press [Esc] key to return to the [Available Options] menu.

6. Set up the network connection to a printer.

7. On the [Available Options] menu, click [Print Server Information], and then press the [Enter]
key.
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8. To create a new print server, press the [Insert] key, and then enter a print server name.

For a currently defined print server, select a print server in the [Print Server] list.

Use the same printer name specified using SmartDeviceMonitor for Admin.

9. From the [Print Server Information] menu, select [Print Server Configuration].

10. From the [Print Server Configuration] menu, select [Printer Configuration].

11. Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using SmartDeviceMonitor for
Admin.

12. To change the printer name, enter a new name.

A name “printer x” is assigned to the printer. The “x” stands for the number of the selected printer.

13. As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

14. Press the [Esc] key, and then click [Yes] on the confirmation message.

15. Press the [Esc] key to return to [Print Server Configuration Menu].

16. Assign print queues to the created printer.

17. From [Print Server Configuration Menu], select [Queues Serviced By Printer].

18. Select the printer created.

19. Press the [Insert] key to select a queue serviced by the printer.

You can select several queues.

20. Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

21. Press the [Esc] key until “Exit?” appears, and then select [Yes] to exit PCONSOLE.

22. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver print_server_name

If the printer works as configured, the message “Waiting for job” appears.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.
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3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see "Test
Printing", Quick Installation Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Guide, which is the administrator's
manual.

• p.197 "Using Web Image Monitor"

Setting Up as a Remote Printer (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to use the printer as a remote printer under NetWare 4.x, 5 / 5.1 and 6 /
6.5.

• To use the printer as a remote printer under NetWare 4.x, 5 / 5.1, 6 / 6.5, set it to NDS mode.

• Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Set up the network connection to a print queue. Select the object in which the print queue is
located in the directory tree, and then click [Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].
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6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Set up the network connection to a printer. Select the object in which the printer is located,
and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name.

11. Select the [Define additional properties] check box, and then click [Create].

12. Assign print queues to the created printer. Click [Assignments, and then click [Add] in the
[Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK]. Check the
settings, and then click [OK].

16. Set up the network connection to a print server. Select a context specified, and then click
[Create] on the [Object] menu.

17. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

18. In the [Print Server Name:] box, enter the print server name.

Use the same print server name specified using SmartDeviceMonitor for Admin.

19. Select the [Define additional properties] check box, and then click [Create].

20. Assign the printer to the created print server. Click [Assignments], and then click [Add] in
the [Assignments] area.

21. In the [Available objects] box, click the queue you created, and then click [OK].

22. In the [Printers] area, click the printer you assigned, and then click [Printer Number].

23. Enter the printer number, and then click [OK]. Check the settings, and then click [OK].

Use the same printer number specified as the remote printer number using SmartDeviceMonitor for
Admin.

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To exit

CAREE: unload pserver

To start

CAREE: load pserver print_server_name
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25. Enter the printer server name as the context name, and then press the [Enter] key.

26. Select the printer name on the context menu, and then press the [Enter] key.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the user login name and password, and then click [Login].

For details about the login user name and password, contact your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [Device Name].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

7. Quit Web Image Monitor.

• If you cannot identify the printer you want to configure, check the printer name against the
configuration page printed from the printer. For details about printing a configuration page, see "Test
Printing", Quick Installation Guide.

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• For details about Web Image Monitor, see "Using Web Image Monitor".

• For details about login user names and passwords, see Security Guide, which is the administrator's
manual.

• p.197 "Using Web Image Monitor"
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8. Mac OS Configuration
This chapter explains how to use this printer with a Mac.

Mac OS 9
This section explains how to configure a Mac OS to use AppleTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual
of the Mac OS you are using for details.

• For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

• The PostScript 3 printer driver is stored in “Mac OS 8 and 9:PS Driver:(language):Disk1” on the CD-
ROM.

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD) files to print from a Mac
OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 and
higher.

PostScript 3 Printer Driver

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [PS Driver] folder.

5. Double-click the folder of the language you use.

6. Open [Disk1], and then double-click the installer icon.

7. Follow the instructions on the screen.

PPD Files

1. Double-click the CD-ROM drive icon.

2. Double-click the [Mac OS 8 and 9] folder.

3. Double-click the [Printer Descriptions] folder.

4. Double-click the folder of the language you use.
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5. Open the [Disk1] folder.

6. Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions] under [System
Folder].

7. Restart the Mac OS.

Setting Up PPD Files

• Make sure that the printers are connected to an AppleTalk network before performing the following
procedure.

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.

3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

4. Click [Create].

5. Click the printer you want to use, and then click [Select].

6. A PPD file is set up and the Adobe PS icon appears at the left of the printer name in the list.

Creating a Desktop Printer Icon

• Make sure that printers are connected to the USB before performing the following procedure.

To use a printer connected by USB, create a desktop printer icon.

1. Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

2. Click [AdobePS] in [With], click [Printer (USB) in] Create Desktop, and then click [OK].

3. Click [Change] in [USB Printer Selection].

4. Select the model you are using in [Select a USB Printer:], and then click [OK].

5. Click [Create].

6. Enter the printer name, and then click [Save].

7. Quit Desktop Printer Utility.

Setting Up Options

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.
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3. In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and
then click [Setup...].

4. Click [Configure].

A list of options appears.

5. Select the option you want to set up, and then select an appropriate setting for it.

6. Click [OK].

The list of options closes.

7. Click [OK].

The [Chooser] dialog box appears.

8. Close the [Chooser] dialog box.

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the computer display. You must
install the ColorSync profile to use this function.

Follow the procedure below to install the ColorSync profiles.

1. Start a Mac OS.

2. Double-click the hard disk icon, and then open the appropriate folder for installing the
ColorSync profiles.

The location of the appropriate folder may vary depending on the version of the Mac OS. The
following are examples:

• System: Preferences: ColorSync profiles

• System: ColorSync profiles

3. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

4. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

5. Double-click the [Mac OS 8 and 9] folder.

6. Double-click the [ColorSync Profiles] folder.

7. Drag the file to the [ColorSync Profiles] folder under [System Folder].

The ColorSync profiles are installed.

Mac OS 9

315

8



The ColorSync profiles are consistent with color characteristics defined by the International Color
Consortium (ICC).

For some computer displays, particular settings need to be created by ColorSync. For details, see the
appropriate manuals for your computer display.

Installing Adobe Type Manager

• Quit all applications currently running before installation. Install ATM after you restart the computer.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

3. Double-click the CD-ROM drive con.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [ATM] folder.

6. Double-click the ATM 4.6.2 installer icon.

7. Follow the instructions on the screen.

8. When the procedure is complete, restart the computer. ATM will be completely installed only
after restarting.

9. On the [Apple] menu, open [Control Panel], and then click [~ATM].

The ATM control panel opens.

• For details about installation, see the operating instructions in the ATM folder.

Installing Screen Fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

3. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [Fonts] folder.
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6. Double-click the [ScreenFonts] folder.

7. Double-click the [TrueType] or Type1 folder.

Select the font type you want to use.

8. Copy the fonts you want to install in Fonts under [System Folder].

9. A confirmation message appears.

10. Click [OK].

The fonts are installed.

11. Restart the Mac OS.

Changing to AppleTalk

Follow the procedure below to configure to a Mac OS to use AppleTalk.

1. Open [Control Panel], and then double-click the AppleTalk icon.

2. On the [Connect via:] pop-up menu, click [Ethernet].

3. If you change zones, select a name on the [OK] pop-up menu.

4. Close the AppleTalk control panel.

5. Restart the computer.

• The procedures used to configure Mac OS may vary depending on the Mac OS version. The
following describes how to configure Mac OS 9.1. If you are using a different version of Mac
OS, use the following procedures as a reference and see the manuals for your Mac OS version.

• Confirm the Connection to the Printer with TCP/IP.

• For information about installing applications required for AppleTalk, see the Mac OS manuals.
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Mac OS X
This section explains how to configure a Mac OS X to use AppleTalk and USB.

Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the
manual of the Mac OS X you are using for details.

• For Mac OS X 10.1 or higher.

• The PPD files are stored in “Mac OS X:PPD Installer”on the CD-ROM.

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, contact your administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the [MacOSX PPD Installer] folder.

5. Double-click the installer icon.

6. Follow the instructions on the screen.

Setting Up the PPD File

1. Start Printer Setup Utility.

Under Mac OS X 10.5, start System Preferences and click [Print & FAX].

2. Click Add.

Mac OS X 10.5

Click [Default]. If the printer name is not displayed, select the icon that corresponds to your
network environment such as AppleTalk.

When several AppleTalk zones exist on the network, select the zone the printer belongs to.

Mac OS X 10.4 or later

Click [More Printers...]. Then select the zone from the second pop-up menu.
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Other Mac OS X

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.

3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, select the printer you are using from the [Print Using] popup menu.

Under Mac OS X 10.5, select the printer you are using from the [Printer Name] list.

A list of printer types appears.

4. Select the PPD file for the model you are using, and then click Add.

5. Quit Printer Setup Utility.

Setting Up Options

1. Start System Preferences.

2. Click [Print & Fax].

3. In the [Printer] list, click the name of the printer you want to use, and then click [Printer
Setup...].

4. Select the option you want to set up, and then select an appropriate setting for it.

5. Click [Apply Changes].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Using USB Interface

Follow the procedure below to setup USB connection.

1. Start Printer Setup Utility.

Under Mac OS X 10.5, start System Preferences and click [Print & FAX].

2. Click Add.

Mac OS X 10.5

Click [Default].

Mac OS X 10.4 or later

Click a printer that has "USB" indicated in the "Connection" column.

Other Mac OS X

Click [USB] on the pop-up menu.
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The connected printer appears.

3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.

A list of printer types appears.

Under Mac OS X 10.5, select the printer you are using from the [Printer Name] list, and [kind] of USB.

4. Select the connected printer from the list of printer models, and then click Add.

5. Quit Printer Setup Utility.

• When printing with a USB connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto]
or [PS] before printing.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour

Follow the procedure below to print using Bonjour under Mac OS X 10.2.3 or higher. Ethernet, wireless
LAN connections can also be used.

1. Start Printer Setup Utility.

Under Mac OS X 10.5, start System Preferences and click [Print & FAX].

2. Click Add.

Mac OS X 10.5

Click [Default]. If the printer name is not displayed, select the icon that corresponds to your
network environment such as AppleTalk.

When several AppleTalk zones exist on the network, select the zone the printer belongs to.

Mac OS X 10.4 or later

Click a printer that has "Bonjour" indicated in the "Connection" column.

Other Mac OS X

Click [Rendezvous] on the pop-up menu.

3. Select the name of the connected printer from the list of printer models, and then click Add.

Under Mac OS X 10.4 or later, Installable Options window appears. Select the option you want to
set up, and then select an appropriate setting for it, and then [Continue].

Under Mac OS X 10.5, select the printer you are using from the [Printer Name] list, and [kind] of
bonjour.
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4. Quit Printer Setup Utility.

When printing with a Rendezvous connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto] or
[PS] before printing.

Changing to AppleTalk

Follow the procedure below to configure a Mac OS X to use AppleTalk.

• You need an administrator name and a password (phrase). For details, contact your administrator.

1. Open [System Preference], and then click the Network icon.

2. Click [Built-in Ethernet] in the [Show:] list box.

3. Click the [AppleTalk] tab.

4. Select the [Make AppleTalk Active] check box.

5. To change Apple Talk zones, select a name from the [AppleTalk Zone:] pop-up menu.

6. When the settings are made, click [Apply Now].

7. Quit [System Preference].

• For information about installing applications required for AppleTalk, see the Mac OS manuals.
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Configuring the Printer
Use the control panel to enable Apple Talk. (The default is active.)
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Using PostScript 3

Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

Normal Print

Select this for normal printing. The print job starts immediately after the print command is given.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the printer. The saved job can be printed from the printer's control panel.
You can also delete the saved job.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.

Locked Print

Use this function to save documents in the printer memory with a password, and then edit and print
them as you want.

• The "User ID:" can contain to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
must be 4-8 digits.

• Entering the "User ID:" helps you distinguish your print job from others.

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's
control panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.
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Stored Print

Use this function to store a file in the printer, and then print it from the computer or the printer's control
panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Store and Print

Use this function to prints the file at once and also stores the file in the printer.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Using sample print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print, Hold Print and
Stored Print.

• Sample Print files will not appear on the display panel if they have already been executed or deleted
using the Web browser before you select [Sample Print] from the control panel.

• Sample Print files printed or deleted using Web Image Monitor after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, sample print jobs are automatically collated by the printer driver. If the collate option is
selected in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.
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• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Set the number of copies to two or more.

The sample print job is sent to the printer, and one set is printed.

3. In the pop-up menu, click [Job Log].

4. On the [Job Type:] pop-up menu, select [Sample Print].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his/her jobs.

6. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete a saved job, see "Sample Print".

7. On the printer's control panel, press [Prt.Jobs].

8. Select [Sample Print Jobs], and then press [Job List].

A list of sample print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

9. Select the file you want to print by pressing it.

A list of print files stored in the printer appears.

10. Press [Print] to change the number of sets to be printed.

11. Enter the new number of sets using the number keys.

If you do not want to change the set quantity, perform the following steps.

You can enter up to 999 sets.

Press [Escape] to correct any entry mistakes.

12. Press [Print].

The remaining sets are printed.

• Press [Cancel] to cancel printing.

• When printing finishes, the stored file is deleted.

• To stop printing after printing has started, press [JobReset]. The file will be deleted.

• If there is a print job outstanding, this is printed before the sample print job.
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• p.112 "Sample Print"

Deleting a Sample Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Sample Print Jobs], and then press [Job List].

A list of sample print files stored in the printer appears.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

Only one file can be selected at a time.

4. Press [Delete].

A confirmation screen appears.

5. Press [Delete] to delete the file.

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using locked print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print and Hold Print.

• Locked Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Locked Print] using the control panel.

• Locked Print files printed or deleted using Web Image Monitor after you have selected [Locked Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Locked Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, locked print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.
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• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Locked Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see "Locked Print".

6. On the printer's control panel, press [Prt.Jobs].

7. Select [Locked Print Jobs], and then press [Job List].

A list of locked print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

8. Select the file you want to print by pressing it.

A list of print files stored in the printer appears.

9. Press [Print].

The password screen appears.

10. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

11. Press [Print].

The locked file is printed.

• Press [Cancel] to cancel printing.

• When printing finishes, the stored file is deleted.

• To stop printing after printing has started, press [JobReset]. The file will be deleted.

• p.115 "Locked Print"
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Deleting a Locked Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Locked Print Jobs], and then press [Job List].

A list of locked print files stored in the printer appears.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

Only one file can be selected at a time.

4. Press [Delete].

A password screen appears.

5. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

When multiple files are selected, the printer deletes only files that correspond to the entered password.
The number of files to be deleted is displayed on the confirmation screen.

6. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using hold print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print and Hold Print.

• Hold Print files will not appear on the display panel if they have already been printed or deleted using
Web Image Monitor before you select [Hold Print] using the control panel.

• Hold Print files printed or deleted using Web Image Monitor after you have selected [Hold Print] using
the control panel will still appear on the display panel. However, an error message will appear if you
try to print or delete those Hold Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Hold print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

8. Mac OS Configuration

328

8



• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Hold Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. File Name can also be set.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see "Hold Print".

1. On the printer's control panel, press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Hold Print Jobs], and then press [Job List].

A list of hold print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

3. Select the file you want to print by pressing it.

4. Press [Print].

The hold print file is printed.

• Press [Cancel] to cancel printing.

• To stop printing after printing has started, press [JobReset]. The file will be deleted.

• When printing is completed, the stored file is deleted.

• p.118 "Hold Print"

Deleting a Hold Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.
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2. Select [Hold Print Jobs], and then press [Job List].

A list of hold print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

Only one file can be selected at a time.

4. Press [Delete].

A confirmation screen appears.

5. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using stored print

• You need Mac OS X v10.2 or higher to use this function.

• Stored Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Stored Print] using the control panel.

• Stored Print files printed or deleted using Web Image Monitor after you have selected [Stored Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Stored Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Stored print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].

• [Stored Print]
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Stores the file in the printer and print it later using the control panel.

• [Store and Print]

Prints the file at once and also stores the file in the printer.

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box. File Name can also
be set.

The user ID associates the user with his/her jobs.

You can assign a password to a saved document, but password assignment is not mandatory.

The password must be entered when printing or deleting.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see "Stored Print".

6. On the printer's control panel, press [Prt.Jobs].

A list of print files stored in the printer appears.

7. Select [Stored Print Jobs], and then press [Job List].

A list of Stored Print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

Depending on the security settings, certain print jobs may not be displayed.

8. Select the file you want to print by pressing it.

9. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

10. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

11. Press [Print].

The Stored Print file is printed.

• Press [Cancel] to cancel printing.

• Stored Print files sent to the printer is not deleted unless you delete them in the printer, or enable
automatic deletion of Stored Print files.
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• p.121 "Stored Print"

Deleting a Stored Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Stored Print Jobs], and then press [Job List].

A list of Stored Print files stored in the printer appears.

3. Select the file you want to delete by pressing it.

4. Press [Delete].

A confirmation screen appears.

5. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

6. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

• If you have already set a password in the printer driver, enter it to delete.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to check
the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Mac OS Select the [Enable User Code] check box, and then
enter a user code in the [User Code] box on [Job
Log] in the print dialog box.

Mac OS X Select the [Enable User Code] check box, and then
enter a user code in the [User Code] box on [Job
Log] in the print dialog box.
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Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper:] on the [Page Attributes] tab in the Page
Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

• For details about the paper sizes supported by this printer, see Hardware Guide.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

Mac OS [Fit to Paper] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Fit to Paper] on the [Features x] tab on [Printer
Features] in the print dialog box.

Prompt User

Print is performed with the size of document to be printed unchanged.

Nearest Size and Scale

If the paper size is smaller than the selected paper size, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

Nearest Size and Crop

When the paper size is smaller than the size of document to be printed, print is adjusted to meet the
paper size.

Input Slot

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.
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Mac OS [Paper Source:] on [General] in the print dialog
box.

Mac OS X [Paper Feed] in the print dialog box.

• For details about the paper sources, see Hardware Guide.

Resolution

Use this to set the resolution types.

The following table shows the tabs or menus where you can select this function.

Mac OS [Resolution] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Resolution] on the [Features x] tab on [Printer
Features] in the print dialog box.

• For more information about the resolution types, see Hardware Guide.

Orientation Override

Use this to set the paper orientation.

The following table shows the tabs or menus where you can select this function.

Mac OS [Orientation Override] on [Printer Specific
Options] in the print dialog box.

Mac OS X [Orientation Override] on the [Feature Sets: X] tab
on [Printer Features] in the print dialog box.

You can select the following items:

• Off

• Landscape

• Portrait
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Duplex Printing

Use this function to select duplex printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Print on Both Sides] on [Layout] in the print dialog
box.

Mac OS X • 10.3 or higher

The [Two Sided Printing] check box on
[Layout] in the print dialog box.

• Other Mac OS X

The [Print on both Sides] check box on
[Duplex] in the print dialog box.

None

Disables duplex printing.

Flip on Long Edge

Prints so you can open it to the long edge when bound along the long edge.

Flip on Short Edge

Prints so you can open it to the short edge when bound along the short edge.

Color Mode

Use this function to select whether the document is printed in color or black and white.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Mode] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Mode] on the [Features x] tab on [Printer
Features] in the print dialog box.

Color

Prints color documents in full color.

• Color images are printed using CMYK toner: Cyan, Magenta, Yellow, and Black. CMYK
represents the three primary subtractive colors.
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• If you want to adjust the print color, use the settings in the Advanced dialog box accessed from
the Advanced button on the [Print Quality] tab.

Black and White

Prints everything, including color documents, in black and white. Black and White printing is faster
than Color. To stop black and white areas being printed with CMYK toner, select [Black and White]
in the printer driver as well as in the application.

Gradation

Use this function to select a type of gradation suited to your requirements.

The following table shows the tabs or menus where you can select this function.

Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features x] tab on [Printer
Features] in the print dialog box.

Fast

Prints quickly but loses smoothness.

Standard

Prints with good gradation.

Color Profile

Use this function to select the color profile pattern.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Profile] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer
Features] in the print dialog box.

Auto

Use this setting to automatically configure the best color profile pattern based on the appearance of
the document to be printed.

Photographic

Use this setting to enhance reproduction of photos and graphics that include midtones.
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Presentation

Use this setting to enhance reproduction of documents containing text and graphics. This CRD is best
for printing colored charts, graphs, presentation materials and so on. If you use this CRD for printing
photographs, color and gradation might not reproduce so well.

Solid Color

Use this setting to print specific single colors, logos and so on.

User Setting

Use this setting to print images using a CRD downloaded from your application.

CLP Simulation

Prints the output colors similar to the colors displayed on the computer screen.

• Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching,
so you should select the appropriate CRD for the document you are printing. The selected CRD is also
referred to when [Fine] or [Fine] is selected for "Colour Setting". The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

Color Setting

Use this function to select the correction method used for color conversion.

• The color rendering dictionary selected in the Color Profile setting is used.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Profile] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer
Features] in the print dialog box.

Off

No modification to the color setting.

Fine

Select this setting to perform color matching based on the printer's built-in color rendering dictionaries,
and to perform CMYK conversion. This setting performs printing at an output target of Monitor g =
1.8.

Using PostScript 3

337

8



Super Fine

Select this setting to use a color rendering dictionary similar to the Fine setting but is capable of
producing output that is more vivid. Use this setting to emphasize lighter colors. This setting performs
printing at an output target of Monitor g = 2.2.

• Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching,
so you should select the appropriate CRD for the document you are printing. The selected CRD is also
referred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

Toner Saving/Level Color

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Toner Saving] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Toner Saving] on the [Features: Set x] tab on
[Printer Features] in the print dialog box.

• For details about this function, see printer driver Help.

Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of multiple-
page documents.

• Make sure that the following check boxes have not been selected.

• Mac OS

The [Collate] check box in the print dialog box.

• Mac OS X

• The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.
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Mac OS [Collate] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Collate] on the [Features: Set x] tab on [Printer
Feature] in the printer dialog box.

Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper Type:] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Paper Type] on the [Feature Set: x] tab on [Printer
Features] in the print dialog box.

• For details about the media type supported by this printer, see Hardware Guide.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Black Over Print] on [Printer Specific Options] in
the print dialog box.

Mac OS X [Black Over Print] on the [Features: Set x] tab on
[Printer Features] in the print dialog box.

Image Smoothing

Use this to select the image smoothing type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Image Smoothing] on [Printer Specific Options] in
the print dialog box.
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Mac OS X [Image Smoothing] on the [Feature Set: x] tab on
[Printer Features] in the print dialog box.

Off

Disables image smoothing.

On

Performs image smoothing unconditionally.

Auto

Performs image smoothing automatically for images that have a resolution less than 25% of supported
printer resolution.

Less than 90 ppi - Less than 300 ppi

Performs image smoothing only when the image has an image resolution (pixels per inch) less than
the respective value you have selected in the list.

• When Auto is selected, data processing may take a long time.

• When [Image Smoothing] is used for a mask image, this function may have an undesired effect on
the print result.

Separate into CMYK

Use this to select the print separation type.

You can separate the printing data into CMYK to specify a specific color combination.

Mac OS [Separate into CMYK] on [Printer Specific Options]
in the print dialog box.

Mac OS X [Separate into CMYK] on the [Features: Set x] tab
on [Printer Features] in the print dialog box.

CMYK Simulation Profile

You can simulate the color tone of the printing ink.

You can select the printing ink standard from US OffsetPrint, Euroscale, JapanColor and PaletteColor.

Mac OS [CMYK Simulation Profile] on [Printer Specific
Options] in the print dialog box.
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Mac OS X [CMYK Simulation Profile] on the [Features: Set x]
tab on [Printer Features] in the print dialog box.

Dithering

Use this function to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Mac OS Dithering: on Printer Specific Options in the print
dialog box.

Mac OS X Dithering: on the Feature Set: x tab on Printer
Features in the print dialog box.

You can select the following items:

Auto

Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

Photographic

Performs dithering using an appropriate pattern for photographs.

Text

Performs dithering using an appropriate pattern for text.

User Setting

Use this setting to print images set in half tone in your application.

Gray Reproduction

Use this function to select Black Color mode for text and line art.

The following table shows the tabs or menus where you can select this function.

Mac OS [Gray Reproductions (Text/LineArt)] on [Printer
Specific Options] in the print dialog box.

Mac OS X [Gray Reproductions (Text/LineArt)] on the
[Features: Set x] tab on [Printer Features] in the print
dialog box.
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Black by K

Select this setting to use a black toner.

Black/Gray by K

Black portions are printed in gray.

CMY+K

Select this setting to use all toners.

Black/Gray by K (Text only)

Prints black text in gray.

Black by K (Text only)

Prints text using black toner.

Color Matching

Use this function to select whether or not you want the colors in the documents to be adjusted before printing,
so that the printed page matches the colors on the screen closer.

Image Color Control

Open the [Image Color Matching] dialog box, and then click this button to specify exactly how you
want the colors on your screen adjusted before printing.
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Printer Utility for Mac
By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

• If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x
and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the printer.

1. Start the Macintosh.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

3. Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS 8 and 9] icon to open it.

Under Mac OS X, double-click the [Mac OS X] folder.

5. Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for
Mac] file, and then drop it into the Macintosh hard disk.

6. Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic environment is
supported.)

• Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

Mac OS

• Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple
menu.

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

Printer Utility for Mac will take a few seconds to start.

Mac OS X

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

3. In the [Available Printers:] box, select the printer you want to use.

If you change zones, select a name from [Available Network Zones:].

Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

4. Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

5. Click [Choose].

Printer Utility for Mac Functions

Downloading PS fonts

You can download the PS fonts to the printer memory or hard disk drive.

• The following procedure to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

• During the download, do not turn off the power switch, operate the panel or open or close the cover.

• If the printer restarts, all the printer settings return to the defaults.
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• Confirm that a Macintosh and the printer are connected with Apple Talk.

1. Select [Download PS Fonts...] on the [File] menu.

2. Click [Add to list].

The dialog box to select fonts appears.

3. Select the desired font files, and then click [Open].

The list of selectable font names appears.

4. After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

5. Click [Download].

The fonts begin to download, and the download status is shown.

6. When the completion message appears, click [OK].

7. Click [Cancel].

• Some fonts cannot be downloaded.

• Before downloading, read the documentation about the fonts you want to use.

Displaying printer fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer memory and
hard disk drive can be displayed.

1. Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

2. Select [Printer's memory] or [Printer's disk].

3. Click [OK].

• The fonts displayed in italics are the default fonts.

Deleting fonts

You can delete fonts from the printer's memory or hard disk drive.

• You cannot delete the fonts displayed in italic.

1. Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.
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2. Select [Printer's memory] or [Printer's disk].

3. Select the fonts you want to delete.

4. Click [Delete].

A confirmation message appears.

5. Confirm the fonts you want to delete and the printer name from which you want to delete
the fonts.

6. Click [Continue], and then click [OK].

7. Click [OK].

Initializing the printer disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard disk drive are deleted.
Before initializing, be sure to check the fonts on the hard disk drive.

• When initializing the printer hard disk drive from the control panel, all of the data on the printer hard
disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

• Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might be
damaged.

1. Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears. To cancel initialization, click [Cancel].

2. Click [Execute].

Initializing starts.

3. When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print "Print Fonts Catalogue" and "Prints Fonts Sample".

1. Select [Page Setup...] on the [File] menu.

2. Select the paper size.

3. Click [OK].

Printing font catalog

You can print the names of fonts available on the printer.

1. Select [Print Fonts Catalog...] on the [File] menu.
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2. Click [Print].

• The paper selected under [Page Setup] is used.

Printing font sample

You can print samples of fonts downloaded to the hard disk drive or memory.

1. Select [Print Fonts Sample...] on the [File] menu.

2. Click [Print].

• Print by using the paper selected on [Page Setup].

Renaming the printer

You can change the printer name displayed under Apple Talk. If you connect several printers on the
network, assign different names so you can identify them. If several printers have the same name, a digit
appears next to the printer name in [Chooser].

• You can enter up to 31 digits and letters.

• Do not use symbols, for example "*", ":", "=", "@", "~".

Mac OS

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. Select the printer whose name you changed, and then close the [Chooser] dialog box.

If there are several Apple Talk zones, select the zone the printer belongs to.

Mac OS X

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.
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3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone for the Macintosh in use.

7. In the [Available Printers:] list, select the printer whose name you changed, and then click
[Choose].

Restarting the printer

You can restart the printer.

1. Select [Restart Printer] on the [File] menu.

2. Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

The fonts downloaded in the printer memory will be deleted.

If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript files

You can download a PostScript file to the printer.

1. Select [Download PostScript File...] on the [Utility] menu.

2. Select the file name to download, click the file name, and then click [Open].

3. Type the log file name, and then click [Save].

The selected file is downloaded.

Errors are recorded in the log file.

Selecting the zone

You can change the zone to which the printer belongs under Apple Talk.

• Confirm that a Macintosh and printer are connected with Apple Talk.

Mac OS

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.
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2. Select the zone in which you want to locate the printer, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. In the [AppleTalk zone:] list, select the zone you changed.

8. In the [Select a PostScript Printer:] list, select the printer you want to use.

9. Close the [Chooser] dialog box.

Mac OS X

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

2. Select the zone which you want to locate the printer in, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone you changed.

7. In the [Available Printers:] list, select the model of printer in use, and then click [Choose].

Displaying the printer status

You can display and confirm the current status of the printer.

1. Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

2. Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status and
available space on the hard disk drive. You can also confirm the zone to which the printer belongs.

3. Click [OK].

Printer Utility for Mac
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Launching the dialogue console

You can create and edit a PostScript file for printing, and then download it to the printer.

• "Launch Dialogue Console" is recommended for users with an understanding of PostScript.

• Do not download any file other than PostScript files to the printer.

• "Launch Dialogue Console" must be used at your own responsibility.

1. Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

2. Type the PostScript command in the editor screen.

To edit a PostScript file, select [Open] on the [File] menu to open it.

You can search or replace a character string by using the [Search] menu.

3. After editing the PostScript file, select [Download Top Window] on [Console] menu to start
printing.

The PostScript file is sent to the printer.

The [Reply from Printer] box opens, depending on the PostScript file you sent.

4. Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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9. Appendix

Software and Utilities Included on the CD-ROM
This section explains the software and utilities included on the "Printer Drivers and Utilities" CD-ROM that
comes with this printer.

Font Manager

For installing new screen fonts, or organizing and managing fonts already in the system. For details
about Font Manager, see the manual on the CD-ROM labeled "Printer Drivers and Utilities".

SmartDeviceMonitor for Admin

For the system administrator to manage network printers.

DeskTopBinder - SmartDeviceMonitor for Client

For users to manage their network print status.

Printer Utility for Mac

This utility allows users to download and manage a variety of fonts as well as manage printers. For
details about this utility, see "Printer Utility for Mac".

• Some documentation about using the machine is included on the CD-ROM in PDF format. For details
about using Adobe Acrobat Reader/Adobe Reader, see Adobe Acrobat Reader/Adobe Reader
online Help.

• For details, see p.343 "Printer Utility for Mac".

Viewing the Contents of the CD-ROM

This section explains how to view the contents of the CD-ROM.

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

This section explains printer drivers for this printer.
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• You can install the PCL printer drivers (PCL 5c and PCL 6), the RPCS printer driver, and the Adobe
PostScript printer drivers from the CD-ROM provided with this machine or download them from the
supplier's Web site. If your operating system is Windows XP x64/Vista x64, Windows Server
2003/2003 R2/2008 x64, you must download the printer drivers from the supplier's Web site.
Select this machine and the operating system you are using, and then download them.

Printing requires installation of a printer driver for your operating system. The following drivers are included
on the CD-ROM labeled “Printer Drivers and Utilities”.

Printer Language PCL 6 PCL 5c RPCS PostScript 3

Windows 2000 *1 OK OK OK OK

Windows XP *2 OK OK OK OK

Windows Vista *3 OK OK OK OK

Windows Server
2003/2003 R2/2008 *4

OK OK OK OK

Mac OS 9 *5 OK

Mac OS X *6 OK

*1 Microsoft Windows 2000 Professional /Microsoft Windows 2000 Server/Microsoft Windows 2000
Advanced Server

*2 Microsoft Windows XP Professional/Microsoft Windows XP Home Edition

*3 Microsoft Windows Vista Ultimate/Microsoft Windows Vista Enterprise/Microsoft Windows Vista Business/
Microsoft Windows Vista Home Premium/Microsoft Windows Vista Home Basic

*4 Microsoft Windows Server 2003/2003 R2/2008 Standard Edition/Microsoft Windows Server 2003/2003
R2/2008 Enterprise Edition/Microsoft Windows Server 2003/2003 R2/2008 Web Edition/Microsoft
Windows Server 2003/2003 R2/2008 Datacenter Edition/Microsoft Windows Server 2003/2003
R2/2008 Standard Edition/Microsoft Windows Server 2003/2003 R2/2008 Enterprise Edition/Microsoft
Windows Server 2003/2003 R2/2008 Datacenter Edition

*5 Versions 8.6 to 9.2 of the Mac OS 9 (Mac OS X Classic mode is supported.)

*6 Mac OS X 10.1 or later (Native mode)

PCL printer drivers

Two kinds of PCL printer driver (PCL 5c and PCL 6) are included. These drivers allow your computer
to communicate with this machine via a printer language. To use these drivers, the Printer Enhance
Option is required.
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RPCS printer driver

This printer driver allows the computer to communicate with the printer using a printer language. In
addition to the conventional user interface, another preset user interface is provided. In addition to
the conventional user interface, another preset user interface is provided.

Adobe PostScript Printer Drivers and PPD files

Adobe PostScript printer drivers allow the computer to communicate with the printer using a printer
language. PPD files allow the printer driver to enable specific printer functions. These drivers require
the PostScript 3 Unit.

PPD files

PPD files allow the printer driver to enable specific printer functions.

• Some applications may require installation of the PCL 5c printer driver. In this case, you can install
PCL 5c without having to install PCL 6.

• For details, see p.21 "Preparing for Printing", p.63 "Printing Documents".

SmartDeviceMonitor for Admin

This section describes the file path and available functions of SmartDeviceMonitor for Admin.

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX to monitor network printers.
It can monitor multiple network printers using IP address. We recommend that the administrators use this
application.

File path

SmartDeviceMonitor for Admin is stored in the following folder in the CD-ROM:

\NETWORK\DEVMON\ADMIN\DISK1

Operating system Protocol stack

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Software and Utilities Included on the CD-ROM
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Operating system Protocol stack

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows Vista

Windows Server
2003/2003 R2/2008

TCP/IP provided with Windows Server 2003/2003 R2/2008

IPX/SPX provided with Windows Server 2003/2003 R2/2008

NetWare Client provided with Windows Server 2003/2003
R2/2008

Novell Client provided with Windows Server 2003/2003
R2/2008

Available functions

SmartDeviceMonitor for Admin has the following functions to check the followings:

• Printer supplies such as paper or toner

• Results of print jobs executed from the computer

• For information about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for Admin Help.

DeskTopBinder - SmartDeviceMonitor for Client

This section describes the file path and system requirements of DeskTopBinder-SmartDeviceMonitor for
Client.

SmartDeviceMonitor for Client has the following functions. We recommend that users install this application.

• Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows 2000/XP/Vista or Windows
Server 2003/2003 R2/2008.

• Constantly monitoring the status of devices on the network using TCP/IP and IPX/SPX.

• To perform Recovery or Parallel printing, the same options that are installed on the original printer
must be installed on the other printers also. Printers that lack a required option cannot be used for
Recovery or Parallel printing.

• To perform Recovery or Parallel printing, the same paper loaded in the original printer must be loaded
in the other printers also. Load all printers with the same paper as that loaded in the tray selected for
printing.

• Results of Recovery or Parallel Printing might differ, depending on the model of the other printer and
the options installed on it.

• If you select Sample Print or Locked Print, you cannot select Recovery Printing or Parallel Printing.
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File path

SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.

NETWORK\DEVMON\CLIENT\DISK1

Operating system Protocol stack

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows Vista

Windows Server
2003/2003 R2/2008

TCP/IP provided with Windows Server 2003/2003 R2/2008

IPX/SPX provided with Windows Server 2003/2003 R2/2008

NetWare Client provided with Windows Server 2003/2003
R2/2008

Novell Client provided with Windows Server 2003/2003
R2/2008

Available functions

SmartDeviceMonitor for Client has the following functions.

• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a print server.

• Prints on a substitute printer when there are too many jobs waiting on the specified printer,
or when an error disables printing (Recovery Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).

• Executes prior group registration of printers specified for Recovery Printing or Parallel
Printing.

• Notification function

• Displays an error message when there is an error on the specified printer while transferring
or printing data.

Software and Utilities Included on the CD-ROM
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• Notifies a print completion. You can also be notified of the print condition, such as displaying
the notice only when Recovery Printing is executed.

• Monitoring function

• Checks printer supplies such as paper or toner.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of printers.

• Enables you to check the print job log using the user ID.

• For details about using SmartDeviceMonitor for Client, see SmartDeviceMonitor for Client Help.

Manuals

The supplied "Manuals" CD-ROMs contain HTML format manuals and PDF manuals.

Depending on the printer model, PDF manuals may not be supplied.

HTML Format Manuals

File path: MANUAL_HTML

PDF Format Manuals

File path: MANUAL_PDF
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Printing Files Directly from Windows
You can print files directly using Windows commands. For example, you can print PostScript files for
PostScript 3.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

You can print files directly using "lpr", "rcp", or "ftp" command.

• To use “sftp” commands, use an sftp client software that is compatible with ssh v2.

Setup

Follow the procedure below to make network environment settings.

1. Enable TCP/IP with the control panel, and then set up the printer's network environment
about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

2. Install a TCP/IP in Windows to set up the network environment.

Contact your administrator for the local setting information.

3. To print under Windows 2000/XP/Vista or Windows Server 2003/2003 R2/2008, install
"Printing service for UNIX" as the network application.

• For details about setting up IPv4 address, see Hardware Guide.

• For details about setting the IPv4 address of the printer using DHCP, see p.364 "Using
DHCP".

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of IPv4 address. The host
names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

Printing Files Directly from Windows
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When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

• For details about printing a configuration page, see p.162 "List/Test Print Menu".

In other cases

Add the IPv4 address and host name of the network printer to the hosts file on the computer used for printing.
Methods of addition vary depending on operating systems.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2/2008

1. Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows 2000/XP/Vista, Windows
Server 2003/2003 R2/2008.

2. Add an IPv4 address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.

3. Save the file.

• When using a host name under Windows Server 2003/2003 R2/2008 with IPv6 protocol,
perform host name resolution using an external DNS server. The host file cannot be used.

Printing Commands

The following explains printing operations using the "lpr", "rcp", and "ftp" commands.

Enter commands using the command prompt window. The location of the command prompts varies
depending on operating systems:

• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]

• Windows XP, Windows Vista, Windows Server 2003/2003 R2/2008

[Start] - [All Programs] - [Accessories] - [Command Prompt]
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• Match the data format of the file to be printed with the emulation mode of the printer.

• If the message "print requests full" appears, no print jobs can be accepted. Try again when sessions
end. For each command, the amount of possible sessions is indicated as follows:

• lpr: 10

• rcp, rsh: 5

• ftp: 3

• Enter the file name in a format including the path from the directory executing commands.

• The "option" specified in a command is an intrinsic printer option and its syntax is similar to printing
from UNIX. For details, see UNIX Supplement.

lpr

When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass name\file name

When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file name

When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named "file 1" located in the "C:
\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...] printer's host name:

[option]

When using a printer with the host name "host" to print a PostScript file named "file 1" or "file 2" located in
the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

• In file names, "*" and "?" can be used as wild cards.

• When printing a binary file, add the "-b" option.

Printing Files Directly from Windows
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ftp

Use the "put" or "mput" command according to the number of files to be printed.

When one file is printed

ftp> put \pass name\file name [option]

When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...] [option]

1. Formulate the printer's IP address or the host name of the hosts file printer as an argument
and use the "ftp" command.

% ftp printer's IP address

2. Enter the user name and password, and then press the [OK] key.

For details about the user name and password, contact your administrator.

User:

Password:

3. When printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

4. Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1" in the "C:\PRINT"
directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS

ftp> mput C:\PRINT\file1 C:\PRINT\file2

5. Quit ftp.

ftp> bye

• "=", ",", "_", and ";"cannot be used for filenames. File names will be read as option strings.

• For "mput" command, option can not be defined.

• For "mput" command, "*" and "?" can be used as wild cards in file names.

• When printing a binary file in ASCII mode, print may not come out correctly.

sftp

To use the “sftp” command, a client software is required.

Use the client software that is compliant with ssh ver2.
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1. Start the client software.

“psftp>open “host name”” appears.

2. Enter the host name, and then press the [Enter] key.

“Login as: “user name”” appears.

3. Enter the user name, and then press the [Enter] key.

When you access the “sftp” command initially, “Store key in cache? (y/n)”

message appears. Select whether or not to store the key and key information,

and then press the [Enter] key.

The entered “user name” and “host name” appears.

4. Enter the password, and then press the [Enter] key.

The entered password will not appear.

• Not all client can use this function.

• For details, see the client software help or the manual help.

Printing Files Directly from Windows
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When Using Windows Terminal Service/Citrix
Presentation Server(MetaFrame)
The following explains how to use Windows Terminal Service and Citrix Presentation Server(MetaFrame).

Operating Environment

The following operating systems and MetaFrame versions are supported.

Windows 2000 Server/Advanced Server

• MetaFrame 1.8 SP3/FR1+SP3/SP4

• MetaFrame XP 1.0 SP1/SP2/SP3/SP4/FR1/FR2/FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Windows Server 2003/2003 R2/2008

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

When Windows Terminal Service is operating

• PCL printer drivers

• PostScript 3

• RPCS drivers

• Some RPCS printer driver functions do not work if Windows Terminal Service is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

Windows Terminal Service

In an environment where Windows Terminal Service is installed, some printer driver functions are
unavailable, even if no Windows Terminal Service functions are used. Use the install mode to install
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SmartDeviceMonitor for Client in an environment where Terminal Service is running on a Windows
2000 Server family computer. The following are the two methods of installation using the install mode:

1. Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor for Client.

2. Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL

To quit the install mode, enter the following command in the MS-DOS command prompt:

CHANGE USER /EXECUTE

• For more information, see Windows Help.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers], you can select a logical printer created by copying the client's
local printer data to the MetaFrame server. We strongly recommend testing this function in your
network environment before using it for your work.

• The settings for optional equipment will not be stored in the server after the equipment is
disconnected. The settings for optional equipment will be restored to its defaults each time the
client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a WAN environment over
dial-up lines such as ISDN, printing may not be possible or errors may occur, depending on
data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making settings in [Client
Printer bandwidth] under [Citrix Management Console] according to the environment.

• If a print error occurs on the server and the print job or a printer created in [Auto-creating client
printers] cannot be deleted, we recommend the following:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details, see the Readme
file provided with MetaFrame.

• MetaFrame XP 1.0 FR2

Make settings in [Delete pending print jobs at logout] under [Printer Properties
Management] of Citrix Management Console.

MetaFrame's [Printer driver replication]

Using [Printer driver replication], you can distribute printer drivers across all servers in a server farm.
We strongly recommend testing this function in your network environment before using it for your
work.

• If the printer drivers are not properly copied, install them directly onto each server.

When Using Windows Terminal Service/Citrix Presentation Server(MetaFrame)
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Using DHCP
You can use the printer in a DHCP environment. You can also register the printer NetBIOS name on a
WINS server when it is running.

• Printers that register the printer NetBIOS name on a WINS server must be configured for the WINS
server.

• Supported DHCP servers are Microsoft DHCP Server included with Windows 2000 Server, Windows
Server 2003, and the DHCP server included with NetWare and UNIX.

• If you do not use the WINS server, reserve the printer's IP address in the DHCP server so the same IP
address is assigned every time.

• To use the WINS server, change the WINS server setting to “active” using the control panel.

• Using the WINS server, you can configure the host name via the remote network printer port.

• DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via ISDN, it will result
in increased line charges. This is because your computer connects to the ISDN line whenever a packet
is transferred from the printer.

• If there is more than one DHCP server, use the same setting for all servers. The machine operates using
data from the DHCP server that responds first.

• DHCP servers can operate in an IPv6 environment, but they cannot be configured to allocate IPv6
addresses or obtain host names.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a temporary IP address starting
with 169.254 and not used on the network can be automatically selected by the printer.

• The IP address assigned by the DHCP server is given priority over that selected by AutoNet.

• You can confirm the current IPv4 address on the configuration page. For more information about the
configuration page, see Quick Installation Guide.

• When AutoNet is running, the NetBIOS name is not registered on the WINS server.

• The machine cannot communicate with devices that do not have the AutoNet function. However, this
machine can communicate with Macintosh computers running Mac OS X 10.2.3. or higher.
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Configuring the WINS Server
The printer can be configured to register its NetBIOS name with a WINS server when the power is turned
on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin even
in a DHCP environment.

This section explains configuring the WINS server.

• The WINS server is supported with Windows 2000 Servers WINS Manager.

• For details about the WINS server settings, see Windows Help.

• If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.

• The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.

2. Enter “http://(printer's IP address or host name) /” in the address bar to access the printer
whose settings you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The dialog box for entering the user name and password appears.

4. Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the left area, click [Configuration], and then click [Network].

6. Click [TCP/IP].

7. Check that [Enable] is selected for [WINS] in the [Ethernet + Wireless LAN] column, and then
enter the WINS server IPv4 address in [Primary WINS Server] and [Secondary WINS
Server].

8. Click [Apply].

9. Quit Web Image Monitor.

Using telnet

You can also use telnet to configure WINS.

Configuring the WINS Server

365

9



Using the Dynamic DNS Function
Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record, AAAA
record, CNAME, and PTR record) managed by the DNS server. When a DNS server is part of the network
environment to which this printer, a DNS client, is connected, records can be dynamically updated using
this function.

Updating

Updating procedure varies depending on whether the printer IP address is static or acquired by DHCP.

• Dynamic update using message authentication (TSIG, SIG(0)) is not supported.

For a static IPv4 setting

If the IP address or host name is changed, the A and PTR records are updated. If the A record is
registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and wireless LAN

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

However, if CNAME (PRNXXXXXX) overlaps with the host name, CNAME will not be registered.

For DHCPv4 settings

As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:

• When the printer acquires the IP address from the DHCP server, the DHCP server updates the A
and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer updates the A record,
and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and wireless LAN

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

For IPv6 settings

This printer updates the AAAA record and PTR record.

It also updates CNAME when the AAAA record is updated.

When a stateless address is newly set, it is automatically registered on the DNS server also.

• When the dynamic DNS function is not used, records managed by the DNS server must be updated
manually, if the printer's IP address is changed.

• To update the record using the printer, the DNS server has to have one of the following:
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• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits updating.

DNS Servers Targeted for Operation

For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• BIND 8.2.3 or higher

For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

For IPv6 setting

• Microsoft DNS servers with standard Windows Server 2003 features

• BIND 9.2.3 or higher

DHCP Servers Targeted for Operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as
follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions)/
Windows Server 2003 features

• ISC DHCP 3.0 or higher

• DHCP server with standard NetWare 5 features

Setting the Dynamic DNS Function

Make settings with telnet using the “dns” command.

• For details, see "Remote Maintenance by telnet".

Using the Dynamic DNS Function
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• p.234 "Remote Maintenance by telnet"
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Precautions
Please pay attention to the following when using the network interface board. When configuration is
necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets are sent back and forth
continuously, possibly incurring communications charges. Because packet transmission is a feature of
NetWare, you need to change the configuration of the router. If the network you are using does not allow
you to configure the router, configure the printer instead.

Configuring the router

Filter packets so they do not pass over the dial-up router.

Configuring the printer with NetWare

1. Following the setup method described earlier in this manual, configure the file server.

2. Set the frame type for NetWare environment.

Configuring the printer without NetWare

1. When not printing, the network interface board sends packets over the network. Set
NetWare to “inactive”.

• The MAC address of the filtering printer is printed on the printer configuration page. For more
information about printing a configuration page, see “Test Printing”, Quick Installation Guide.

• For more information about configuring the printer if the router cannot be configured, see the following
instructions.

• For more information about selecting a frame type, see “Ethernet Configuration”, Hardware Guide.

• For more information about selecting a protocol, see “Ethernet Configuration”, Hardware Guide.

When the Wireless LAN Interface Unit Is Installed

When using the wireless LAN interface on the network, note the following:

When moving the printer

Detach the antennas when relocating the printer locally.
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After moving the printer, reattach the antennas, ensuring that:

• The antennas are positioned clear of obstacles.

• There is 40 to 60 mm between the antennas, so that they do not touch.

If the network area provides poor radio environment

Where radio wave conditions are bad, the network may not function due to interrupted or failed
connections. When checking the wireless LAN signal and the access point, follow the procedure
below to improve the situation:

• Position the access point nearer to the printer.

• Clear the space between access point and printer of obstructions.

• Move radio wave generating appliances, such as microwaves, away from the printer and access
point.

• For information about how to check radio wave status, see “Wireless LAN Configuration”, Hardware
Guide.

• For more information about access point radio wave conditions, refer to the access point manual.
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Security Measures Provided by this Printer

Using Authentication and Managing Users

This section explains how to improve this printer's security.

The setting can be done only by the administrator.

Enabling Authentication

To control administrators' and users' access to the printer, perform administrator authentication and
user authentication using login user names and login passwords. To perform authentication, the
authentication function must be enabled.

Specifying Authentication Information to Log on

Users are managed using the personal information managed in the printer's address book.

Enabling user authentication limits usage of printer to people registered in the address book to use
the printer. Users can be managed in the address book by the administrator.

Specifying Which Functions are Available

This can be specified by the administrator. Specify the functions available to registered users. By
making this setting, administrators can limit the functions available to users.

Preventing Information Leaks

Guarding Against Unauthorized Copying (Unauthorized Copy Prevention)

Using the printer driver, mask and pattern can be embedded in the printed document.

Guarding Against Unauthorized Copying (Data security for copying)

Using the printer driver with the data security for the copying function, a document can be printed
with an embedded pattern of hidden text.

To gray out the copy or stored file of a copy-guarded document when the document is copied or
stored, the optional security module is required.

Printing confidential files

Using the printer's Locked Print, files can be stored in the printer as confidential files and then print
them. Those file can be printed using the printer's control panel and collected on the spot to prevent
others from seeing it.

Preventing Data Leaks Due to Unauthorized Transmission

You can specify in the address book which users are allowed to send files using the scanner or fax
function.

You can also limit the direct entry of destinations to prevent files from being sent to destinations not
registered in the address book.
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Protecting Registered Information in the Address Book

This function allows administrator to specify which users have permission to access the data in the
address book. Usage of the data in the address book by unregistered users can be prevented.

Administrator can also encrypt the data in the address book to protect the data from unauthorized
reading.

Managing Log Files

Data security can by improved by deleting log files stored in the printer. By transferring the log files,
administrator can check the history data and identify unauthorized access.

To transfer the log data, the log collection server is required.

Overwriting the Data on the Hard Disk

Before disposing of the printer, make sure all data on the hard disk is deleted. Prevent data leakage
by automatically deleting transmitted printer jobs from memory.

To overwrite the hard disk data, the optional ipp unit is required.

Limiting and Controlling Access

Preventing Modification or Deletion of Stored Data

Users with access permission to stored files can be specified. Permit selected users who have to access
permissions to stored files to modify or delete the files.

Preventing Modification of Printer Settings

The printer settings that can be modified depend on the type of administrator account.

Register the administrators so that users cannot change the administrator settings.

Limiting Available Functions

This function allows administrator to specify which users have accessibility to each of the printer's
functions, to prevent unauthorized operation.

Enhanced Network Security

Preventing Unauthorized Access

Limit IP addresses or disable ports to prevent unauthorized access over the network and protect the
address book, stored files, and default settings.

Encrypting Transmitted Passwords

Prevent login passwords, group passwords for PDF files, and IPP authentication passwords being
revealed by encrypting them for transmission.

Also, encrypt the login password for administrator authentication and user authentication.
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Configuring SSL Encryption

When you access the printer using a Web Image Monitor or IPP, you can establish encrypted
communication using SSL.

When you access the printer using an application such as SmartDeviceMonitor for Admin, you can establish
encrypted communication using SNMPv3 or SSL. To protect data from interception, analysis, and
tampering, you can install a server certificate in the printer, negotiate a secure connection, and encrypt
transmitted data.

SSL (SSL (Secure Sockets Layer)Secure Sockets Layer)

BBC003S

1. To access the printer from a user's computer, request for the SSL server certificate and public key.

2. The server certificate and public key are sent from the printer to the user's computer.

3. Create shared key from the user's computer, and then encrypt it using public key.

4. The encrypted shared key is sent to the printer.

5. The encrypted shared key is decrypted in the printer using private key.
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6. Transmit the encrypted data using the shared key, and then decrypt the data at the printer to
attain secure transmission.
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Copyright Information about Installed
Applications

expat

• The software including controller, etc. (hereinafter "software") installed on this product uses the expat
under the conditions mentioned below.

• The product manufacturer provides warranty and support to the software of the product including the
expat, and the product manufacturer makes the initial developer and copyright holder of the expat,
free from these obligations.

• Information relating to the expat is available at:

http://expat.sourceforge.net/

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Centre, Ltd. and Clark Cooper.

Copyright (c) 2001, 2002 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

NetBSD

1. Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright
notice applicable for each of the files/binaries, the source code tree must be consulted.
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A full source code can be found at http://www.netbsd.org/.

Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

2. Authors Name List

All product names mentioned herein are trademarks or registered trade-marks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in
this document:

• This product includes software developed by the University of California,Berkeley and its contributors.

• This product includes software developed by the NetBSD Foundation.

• This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

• This product includes software developed for the NetBSD Project. See http://www.netbsd.org/ for
information about NetBSD.

• This product contains software developed by Ignatios Souvatzis for the NetBSD project.

• This product contains software written by Ignatios Souvatzis and MichaelL. Hitch for the NetBSD
project.

• This product contains software written by Michael L. Hitch for the NetBSD project.

• This product includes cryptographic software written by Eric Young(eay@cryptsoft.com)
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• This product includes cryptographic software written by Eric Young(eay@mincom.oz.au)

• This product includes software designed by William Allen Simpson.

• This product includes software developed at Ludd, University of Lulea,Sweden and its contributors.

• This product includes software developed at Ludd, University of Lulea.

• This product includes software developed at the Information Technology Division, US Naval Research
Laboratory.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by David Jones and Gordon Ross

• This product includes software developed by Gordon W. Ross and Leo Weppelman.

• This product includes software developed by Hellmuth Michaelis and Joerg Wunsch

• This product includes software developed by Internet Research Institute, Inc.

• This product includes software developed by Leo Weppelman and Waldi Ravens.

• This product includes software developed by Mika Kortelainen

• This product includes software developed by Aaron Brown and Harvard University.

• This product includes software developed by Adam Ciarcinski for the NetBSD project.

• This product includes software developed by Adam Glass and Charles M.Hannum.

• This product includes software developed by Adam Glass.

• This product includes software developed by Advanced Risc Machines Ltd.

• This product includes software developed by Alex Zepeda, and Colin Wood for the NetBSD Projet.

• This product includes software developed by Alex Zepeda.

• This product includes software developed by Alistair G. Crooks.

• This product includes software developed by Alistair G. Crooks. for the NetBSD project.

• This product includes software developed by Allen Briggs

• This product includes software developed by Amancio Hasty and Roger Hardiman

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Bill Paul.

• This product includes software developed by Bodo Moeller. (If available, substitute umlauted o for
oe)

• This product includes software developed by Boris Popov.

• This product includes software developed by Brad Pepers

• This product includes software developed by Bradley A. Grantham.

• This product includes software developed by Brini.

• This product includes software developed by Causality Limited.
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• This product includes software developed by Charles D. Cranor and Seth Widoff.

• This product includes software developed by Charles D. Cranor and Washington University.

• This product includes software developed by Charles D. Cranor, Washington

• University, and the University of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor, Washington University, the University
of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor.

• This product includes software developed by Charles Hannum.

• This product includes software developed by Charles M. Hannum, by the University of Vermont and
State Agricultural College and Garrett A.Wollman, by William F. Jolitz, and by the University of
California,Berkeley, Lawrence Berkeley Laboratory, and its contributors.

• This product includes software developed by Charles M. Hannum.

• This product includes software developed by Christian E. Hopps, Ezra Story, Kari Mettinen, Markus
Wild, Lutz Vieweg and Michael Teske.

• This product includes software developed by Christian E. Hopps.

• This product includes software developed by Christian Limpach

• This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

• This product includes software developed by Christopher G. Demetriou.

• This product includes software developed by Christos Zoulas.

• This product includes software developed by Chuck Silvers.

• This product includes software developed by Colin Wood for the NetBSD Project.

• This product includes software developed by Colin Wood.

• This product includes software developed by Cybernet Corporation and Nan Yang Computer
Services Limited

• This product includes software developed by Daishi Kato

• This product includes software developed by Dale Rahn.

• This product includes software developed by Daniel Widenfalk and Michael L. Hitch.

• This product includes software developed by Daniel Widenfalk for the NetBSD Project.

• This product includes software developed by Darrin B. Jewell

• This product includes software developed by David Miller.

• This product includes software developed by Dean Huxley.

• This product includes software developed by Eduardo Horvath.

• This product includes software developed by Eric S. Hvozda.

• This product includes software developed by Eric S. Raymond
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• This product includes software developed by Eric Young (eay@@mincom.oz.au)

• This product includes software developed by Eric Young (eay@cryptsoft.com)

• This product includes software developed by Eric Young (eay@mincom.oz.au)

• This product includes software developed by Ezra Story and by Kari Mettinen.

• This product includes software developed by Ezra Story, by Kari Mettinen and by Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, Michael Teske and by
Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, and Michael Teske.

• This product includes software developed by Ezra Story.

• This product includes software developed by Frank van der Linden for the NetBSD Project.

• This product includes software developed by Gardner Buchanan.

• This product includes software developed by Gary Thomas.

• This product includes software developed by Gordon Ross

• This product includes software developed by Gordon W. Ross

• This product includes software developed by HAYAKAWA Koichi.

• This product includes software developed by Harvard University and its contributors.

• This product includes software developed by Harvard University.

• This product includes software developed by Herb Peyerl.

• This product includes software developed by Hubert Feyrer for the NetBSD Project.

• This product includes software developed by Iain Hibbert

• This product includes software developed by Ian F. Darwin and others.

• This product includes software developed by Ian W. Dall.

• This product includes software developed by Ichiro FUKUHARA.

• This product includes software developed by Ignatios Souvatzis for the NetBSD Project.

• This product includes software developed by Internet Initiative Japan Inc.

• This product includes software developed by James R. Maynard III.

• This product includes software developed by Jared D. McNeill.

• This product includes software developed by Jason L. Wright

• This product includes software developed by Jason R. Thorpe for And Communications, http://
www.and.com/

• This product includes software developed by Joachim Koenig-Baltes.

• This product includes software developed by Jochen Pohl for The NetBSD Project.

• This product includes software developed by Joerg Wunsch

• This product includes software developed by John Birrell.
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• This product includes software developed by John P. Wittkoski.

• This product includes software developed by John Polstra.

• This product includes software developed by Jonathan R. Stone for the NetBSD Project.

• This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD
Project.

• This product includes software developed by Jonathan Stone.

• This product includes software developed by Jukka Marin.

• This product includes software developed by Julian Highfield.

• This product includes software developed by Kazuhisa Shimizu.

• This product includes software developed by Kazuki Sakamoto.

• This product includes software developed by Kenneth Stailey.

• This product includes software developed by Kiyoshi Ikehara.

• This product includes software developed by Klaus Burkert,by Bernd Ernesti, by Michael van Elst,
and by the University of California, Berkeley and its contributors.

• This product includes software developed by LAN Media Corporation and its contributors.

• This product includes software developed by Leo Weppelman for the NetBSD Project.

• This product includes software developed by Leo Weppelman.

• This product includes software developed by Lloyd Parkes.

• This product includes software developed by Luke Mewburn.

• This product includes software developed by Lutz Vieweg.

• This product includes software developed by MINOURA Makoto, Takuya Harakawa.

• This product includes software developed by Manuel Bouyer.

• This product includes software developed by Marc Horowitz.

• This product includes software developed by Marcus Comstedt.

• This product includes software developed by Mark Brinicombe for the NetBSD project.

• This product includes software developed by Mark Brinicombe.

• This product includes software developed by Mark Murray

• This product includes software developed by Mark Tinguely and Jim Lowe

• This product includes software developed by Markus Wild.

• This product includes software developed by Martin Husemann and Wolfgang Solfrank.

• This product includes software developed by Masanobu Saitoh.

• This product includes software developed by Masaru Oki.

• This product includes software developed by Mats O Jansson and Charles D.Cranor.

• This product includes software developed by Mats O Jansson.
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• This product includes software developed by Matt DeBergalis

• This product includes software developed by Matthew Fredette.

• This product includes software developed by Matthias Pfaller.

• This product includes software developed by Michael Graff for the NetBSD Project.

• This product includes software developed by Michael Graff.

• This product includes software developed by Michael L. Hitch.

• This product includes software developed by Michael Shalayeff.

• This product includes software developed by Michael Smith.

• This product includes software developed by Mike Glover and contributors.

• This product includes software developed by Mike Pritchard.

• This product includes software developed by Minoura Makoto.

• This product includes software developed by Nan Yang Computer Services Limited.

• This product includes software developed by Niels Provos.

• This product includes software developed by Niklas Hallqvist, Brandon Creighton and Job de Haas.

• This product includes software developed by Niklas Hallqvist.

• This product includes software developed by Onno van der Linden.

• This product includes software developed by Paul Kranenburg.

• This product includes software developed by Paul Mackerras.

• This product includes software developed by Per Fogelstrom

• This product includes software developed by Peter Galbavy.

• This product includes software developed by Phase One, Inc.

• This product includes software developed by Philip A. Nelson.

• This product includes software developed by Philip L. Budne.

• This product includes software developed by RiscBSD.

• This product includes software developed by Roar Thronaes.

• This product includes software developed by Rodney W. Grimes.

• This product includes software developed by Roger Hardiman

• This product includes software developed by Roland C. Dowdeswell.

• This product includes software developed by Rolf Grossmann.

• This product includes software developed by Ross Harvey for the NetBSD Project.

• This product includes software developed by Ross Harvey.

• This product includes software developed by Scott Bartram.

• This product includes software developed by Scott Stevens.
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• This product includes software developed by Shingo WATANABE.

• This product includes software developed by Softweyr LLC, the University of California, Berkeley, and
its contributors.

• This product includes software developed by Soren S. Jorvang.

• This product includes software developed by Stephan Thesing.

• This product includes software developed by Steve Woodford.

• This product includes software developed by Takashi Hamada

• This product includes software developed by Takumi Nakamura.

• This product includes software developed by Tatoku Ogaito for the NetBSD Project.

• This product includes software developed by Terrence R. Lambert.

• This product includes software developed by Tetsuya Isaki.

• This product includes software developed by Thomas Gerner

• This product includes software developed by Thomas Klausner for the NetBSD Project.

• This product includes software developed by Tobias Weingartner.

• This product includes software developed by Todd C. Miller.

• This product includes software developed by Tohru Nishimura and Reinoud Zandijk for the NetBSD
Project.

• This product includes software developed by Tohru Nishimura for the NetBSD Project.

• This product includes software developed by Tohru Nishimura. for the NetBSD Project.

• This product includes software developed by TooLs GmbH.

• This product includes software developed by Toru Nishimura.

• This product includes software developed by Trimble Navigation, Ltd.

• This product includes software developed by WIDE Project and its contributors.

• This product includes software developed by Waldi Ravens.

• This product includes software developed by Wasabi Systems for Zembu Labs, Inc. http://
www.zembu.com/

• This product includes software developed by Winning Strategies, Inc.

• This product includes software developed by Wolfgang Solfrank.

• This product includes software developed by Yasushi Yamasaki

• This product includes software developed by Zembu Labs, Inc.

• This product includes software developed by the Alice Group.

• This product includes software developed by the Center for Software Science at the University of Utah.

• This product includes software developed by the Charles D. Cranor, Washington University, University
of California, Berkeley and its contributors.
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• This product includes software developed by the Computer Systems Engineering Group at Lawrence
Berkeley Laboratory.

• This product includes software developed by the David Muir Sharnoff.

• This product includes software developed by the Harvard University and its contributors.

• This product includes software developed by the Kungliga Tekniska Hogskolan and its contributors.

• This product includes software developed by the Network Research Group at Lawrence Berkeley
Laboratory.

• This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.OpenSSL.org/)

• This product includes software developed by the PocketBSD project and its contributors.

• This product includes software developed by the RiscBSD kernel team

• This product includes software developed by the RiscBSD team.

• This product includes software developed by the SMCC Technology Development Group at Sun
Microsystems, Inc.

• This product includes software developed by the University of California, Berkeley and its contributors,
as well as the Trustees of Columbia University.

• This product includes software developed by the University of California, Lawrence Berkeley
Laboratory and its contributors.

• This product includes software developed by the University of California, Lawrence Berkeley
Laboratory.

• This product includes software developed by the University of Illinois at Urbana and their contributors.

• This product includes software developed by the University of Vermont and State Agricultural College
and Garrett A. Wollman.

• This product includes software developed by the University of Vermont and State Agricultural College
and Garrett A. Wollman, by William F. Jolitz, and by the University of California, Berkeley, Lawrence
Berkeley Laboratory, and its contributors.

• This product includes software developed for the FreeBSD project

• This product includes software developed for the NetBSD Project by Bernd Ernesti.

• This product includes software developed for the NetBSD Project by Christopher G. Demetriou.

• This product includes software developed for the NetBSD Project by Christos Zoulas

• This product includes software developed for the NetBSD Project by Emmanuel Dreyfus.

• This product includes software developed for the NetBSD Project by Frank van der Linden

• This product includes software developed for the NetBSD Project by Ignatios Souvatzis.

• This product includes software developed for the NetBSD Project by Jason R. Thorpe.

• This product includes software developed for the NetBSD Project by John M. Vinopal.

• This product includes software developed for the NetBSD Project by Matthias Drochner.
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• This product includes software developed for the NetBSD Project by Michael L. Hitch.

• This product includes software developed for the NetBSD Project by Perry E. Metzger.

• This product includes software developed for the NetBSD Project by Scott Bartram and Frank van der
Linden

• This product includes software developed for the NetBSD Project by Allegro Networks, Inc., and
Wasabi Systems, Inc.

• This product includes software developed for the NetBSD Project by Genetec Corporation.

• This product includes software developed for the NetBSD Project by Jonathan Stone.

• This product includes software developed for the NetBSD Project by Piermont Information Systems
Inc.

• This product includes software developed for the NetBSD Project by SUNET,Swedish University
Computer Network.

• This product includes software developed for the NetBSD Project by Shigeyuki Fukushima.

• This product includes software developed for the NetBSD Project by Wasabi Systems, Inc.

• This product includes software developed under OpenBSD by Per Fogelstrom Opsycon AB for RTMX
Inc, North Carolina, USA.

• This product includes software developed under OpenBSD by Per Fogelstrom.

• This software is a component of "386BSD" developed by William F. Jolitz,TeleMuse.

• This software was developed by Holger Veit and Brian Moore for use with "386BSD" and similar
operating systems. "Similar operating systems" includes mainly non-profit oriented systems for
research and education, including but not restricted to "NetBSD", "FreeBSD", "Mach" (by CMU).

• This software includes software developed by the Computer Systems Laboratory at the University of
Utah.

• This product includes software developed by Computing Services at Carnegie Mellon University
(http://www.cmu.edu/computing/).

• This product includes software developed by Allen Briggs.

In the following statement, "This software" refers to the Mitsumi CD-ROM driver:

• This software was developed by Holger Veit and Brian Moore for use with "386BSD" and similar
operating systems. "Similar operating systems" includes mainly non-profit oriented systems for
research and education, including but not restricted to "NetBSD", "FreeBSD", "Mach" (by CMU).

In the following statement, "This software" refers to the parallel port driver:

• This software is a component of "386BSD" developed by William F. Jolitz, TeleMuse.

Netatalk(NetBSD)/NetaTalk 1.4b2+asun2.1.3

Copyright (c) 1990,1991 Regents of The University of Michigan. All Rights Reserved.
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FreeBSD 4.6.2/netipx

Copyright (c) 1984, 1985, 1986, 1987, 1993

The Regents of the University of California. All rights reserved.

Modifications Copyright (c) 1995, Mike Mitchell

Modifications Copyright (c) 1995, John Hay

Sablotron

Sablotron (Version 0.82) Copyright (c) 2000 Ginger Alliance Ltd. All Rights Reserved

a) The application software installed on this product includes the Sablotron software Version 0.82
(hereinafter, "Sablotron 0.82"), with modifications made by the product manufacturer. The original code
of the Sablotron 0.82 is provided by Ginger Alliance Ltd., the initial developer, and the modified code of
the Sablotron 0.82 has been derived from such original code provided by Ginger Alliance Ltd.

b) The product manufacturer provides warranty and support to the application software of this product
including the Sablotron 0.82 as modified, and the product manufacturer makes Ginger Alliance Ltd., the
initial developer of the Sablotron 0.82, free from these obligations.

c) The Sablotron 0.82 and the modifications thereof are made available under the terms of Mozilla Public
License Version 1.1 (hereinafter, "MPL 1.1"), and the application software of this product constitutes the
"Larger Work" as defined in MPL 1.1. The application software of this product except for the Sablotron
0.82 as modified is licensed by the product manufacturer under separate agreement(s).

d) The source code of the modified code of the Sablotron 0.82 is available at: http://support-
download.com/services/device/sablot/notice082.html

e) The source code of the Sablotron software is available at: http://www.gingerall.com

f) MPL 1.1 is available at: http://www.mozilla.org/MPL/MPL-1.1.html

JPEG LIBRARY

• The software installed on this product is based in part on the work of the Independent JPEG Group.

SASL

CMU libsasl

Tim Martin

Rob Earhart

Rob Siemborski
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Copyright (c) 2001 Carnegie Mellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived
from this software without prior written permission.

For permission or any other legal details, please contact:

Office of Technology Transfer

Carnegie Mellon University

5000 Forbes Avenue

Pittsburgh, PA 15213-3890

(412) 268-4387, fax: (412) 268-7395

tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
CARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Samba(Ver 3.0.4)

For SMB transmission, this machine uses Samba ver 3.0.4 (hereinafter referred to as Samba 3.0.4).

Copyright (c) Andrew Tridgell 1994-1998

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675
Mass Ave, Cambridge, MA 02139, USA.
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• The source code for SMB transmission by this machine can be downloaded from the following website:
http://support-download.com/services/scbs

RSA BSAFE®

• This product includes RSA BSAFE (c) cryptographic software from RSA Security Inc.

• RSA, BSAFE are either registered trademarks or trademarks of RSA Security Inc. in the United States
and/or other countries.

• RSA Security Inc. All rights reserved.

Open SSL

Copyright (c) 1998-2004 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.
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5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If
this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used. This can be in the form of a textual message at program startup or in documentation (online
or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used
are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence

[including the GNU Public Licence.]

Open SSH

The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.

OpenSSH contains no GPL code.

1)

Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland All rights reserved

As far as I am concerned, the code I have written for this software can be used freely for any purpose. Any
derived versions of this software must be clearly marked as such, and if the derived work is incompatible
with the protocol description in the RFC file, it must be called by a name other than "ssh" or "Secure Shell".

[Tatu continues]

However, I am not implying to give any licenses to any patents or copyrights held by third parties, and the
software includes parts that are not under my direct control. As far as I know, all included source code is
used in accordance with the relevant license agreements and can be used freely for any purpose (the GNU
license being the most restrictive); see below for details.

[However, none of that term is relevant at this point in time. All of these restrictively licenced software
components which he talks about have been removed from OpenSSH, i.e.,

- RSA is no longer included, found in the OpenSSL library

- IDEA is no longer included, its use is deprecated

- DES is now external, in the OpenSSL library

- GMP is no longer used, and instead we call BN code from OpenSSL
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- Zlib is now external, in a library

- The make-ssh-known-hosts script is no longer included

- TSS has been removed

- MD5 is now external, in the OpenSSL library

- RC4 support has been replaced with ARC4 support from OpenSSL

- Blowfish is now external, in the OpenSSL library

[The licence continues]

Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can
be found e.g. at "http://www.cs.hut.fi/crypto".

The legal status of this program is some combination of all these permissions and restrictions. Use only at
your own responsibility. You will be responsible for any legal consequences yourself; I am not making any
claims whether possessing or using this is legal or not in your country, and I am not taking any responsibility
on your behalf.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED
IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY
TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2)

The 32-bit CRC compensation attack detector in deattack.c was contributed by CORE SDI S.A. under a
BSD-style license.

Cryptographic attack detector for ssh - source code

Copyright (c) 1998 CORE SDI S.A., Buenos Aires, Argentina.

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are
permitted provided that this copyright notice is retained.
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THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES ARE
DISCLAIMED. IN NO EVENT SHALL CORE SDI S.A. BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE
OR MISUSE OF THIS SOFTWARE.

Ariel Futoransky <futo@core-sdi.com>

<http://www.core-sdi.com>

3)

One component of the ssh source code is under a 3-clause BSD license, held by the University of California,
since we pulled these parts from original Berkeley code.

Copyright (c) 1983, 1990, 1992, 1993, 1995

The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

4)

Remaining components of the software are provided under a standard 2-term BSD licence with the
following names as copyright holders:

Markus Friedl

Theo de Raadt

Niels Provos

Dug Song

Kevin Steves
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Daniel Kouril

Wesley Griffin

Per Allansson

Jason Downs

Solar Designer

Todd C. Miller

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5)

Portable OpenSSH contains the following additional licenses:

c) Compatibility code (openbsd-compat)

Apart from the previously mentioned licenses, various pieces of code in the openbsd-compat/ subdirectory
are licensed as follows:

Some code is licensed under a 3-term BSD license, to the following copyright holders:

Todd C. Miller

Theo de Raadt

Damien Miller

Eric P. Allman

The Regents of the University of California

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Open LDAP

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a
version number. You may use this Software under terms of this license revision or under the terms of any
subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS "AS IS"
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S) OR
OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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The names of the authors and copyright holders must not be used in advertising or otherwise to promote
the sale, use or other dealing in this Software without specific, written prior permission. Title to copyright
in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright (c) 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

Heimdal

Copyright (c) 1997-2005 Kungliga Tekniska Högskolan (Royal Institute of Technology, Stockholm,
Sweden). All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the Institute nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE INSTITUTE OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

IPSTM print language emulations

Copyright (c) 1987-2006 Zoran Corporation. All rights reserved.

racoon

Copyright (C) 1995, 1996, 1997, and 1998 WIDE Project.

All rights reserved.
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TrouSerS

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS COMMON PUBLIC
LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF THE PROGRAM
CONSTITUTES RECIPIENT'S ACCEPTANCE OF THIS AGREEMENT.

1. DEFINITIONS

"Contribution" means:

a) in the case of the initial Contributor, the initial code and documentation distributed under this Agreement,
and

b) in the case of each subsequent Contributor:

i) changes to the Program, and

ii) additions to the Program;

where such changes and/or additions to the Program originate from and are distributed by that particular
Contributor. A Contribution 'originates' from a Contributor if it was added to the Program by such
Contributor itself or anyone acting on such Contributor's behalf. Contributions do not include additions to
the Program which: (i) are separate modules of software distributed in conjunction with the Program under
their own license agreement, and (ii) are not derivative works of the Program.

"Contributor" means any person or entity that distributes the Program.

"Licensed Patents " mean patent claims licensable by a Contributor which are necessarily infringed by the
use or sale of its Contribution alone or when combined with the Program.

"Program" means the Contributions distributed in accordance with this Agreement.

"Recipient" means anyone who receives the Program under this Agreement, including all Contributors.

2. GRANT OF RIGHTS

a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive,
worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display,
publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such derivative
works, in source code and object code form.

b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive,
worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and
otherwise transfer the Contribution of such Contributor, if any, in source code and object code form. This
patent license shall apply to the combination of the Contribution and the Program if, at the time the
Contribution is added by the Contributor, such addition of the Contribution causes such combination to be
covered by the Licensed Patents. The patent license shall not apply to any other combinations which include
the Contribution. No hardware per se is licensed hereunder.

c) Recipient understands that although each Contributor grants the licenses to its Contributions set forth
herein, no assurances are provided by any Contributor that the Program does not infringe the patent or
other intellectual property rights of any other entity. Each Contributor disclaims any liability to Recipient for
claims brought by any other entity based on infringement of intellectual property rights or otherwise. As a
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condition to exercising the rights and licenses granted hereunder, each Recipient hereby assumes sole
responsibility to secure any other intellectual property rights needed, if any. For example, if a third party
patent license is required to allow Recipient to distribute the Program, it is Recipient's responsibility to acquire
that license before distributing the Program.

d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if
any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own license agreement,
provided that:

a) it complies with the terms and conditions of this Agreement; and

b) its license agreement:

i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and implied,
including warranties or conditions of title and non-infringement, and implied warranties or conditions of
merchantability and fitness for a particular purpose;

ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, indirect,
special, incidental and consequential damages, such as lost profits;

iii) states that any provisions which differ from this Agreement are offered by that Contributor alone and
not by any other party; and

iv) states that source code for the Program is available from such Contributor, and informs licensees how
to obtain it in a reasonable manner on or through a medium customarily used for software exchange.

When the Program is made available in source code form:

a) it must be made available under this Agreement; and

b) a copy of this Agreement must be included with each copy of the Program.

Contributors may not remove or alter any copyright notices contained within the Program.

Each Contributor must identify itself as the originator of its Contribution, if any, in a manner that reasonably
allows subsequent Recipients to identify the originator of the Contribution.

4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to end users, business
partners and the like. While this license is intended to facilitate the commercial use of the Program, the
Contributor who includes the Program in a commercial product offering should do so in a manner which
does not create potential liability for other Contributors. Therefore, if a Contributor includes the Program
in a commercial product offering, such Contributor ("Commercial Contributor") hereby agrees to defend
and indemnify every other Contributor ("Indemnified Contributor") against any losses, damages and costs
(collectively "Losses") arising from claims, lawsuits and other legal actions brought by a third party against
the Indemnified Contributor to the extent caused by the acts or omissions of such Commercial Contributor
in connection with its distribution of the Program in a commercial product offering. The obligations in this
section do not apply to any claims or Losses relating to any actual or alleged intellectual property
infringement. In order to qualify, an Indemnified Contributor must: a) promptly notify the Commercial
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Contributor in writing of such claim, and b) allow the Commercial Contributor to control, and cooperate
with the Commercial Contributor in, the defense and any related settlement negotiations. The Indemnified
Contributor may participate in any such claim at its own expense.

For example, a Contributor might include the Program in a commercial product offering, Product X. That
Contributor is then a Commercial Contributor. If that Commercial Contributor then makes performance
claims, or offers warranties related to Product X, those performance claims and warranties are such
Commercial Contributor's responsibility alone. Under this section, the Commercial Contributor would have
to defend claims against the other Contributors related to those performance claims and warranties, and
if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor must
pay those damages.

5. NO WARRANTY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON AN "AS
IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED
INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each Recipient is
solely responsible for determining the appropriateness of using and distributing the Program and assumes
all risks associated with its exercise of rights under this Agreement, including but not limited to the risks and
costs of program errors, compliance with applicable laws, damage to or loss of data, programs or
equipment, and unavailability or interruption of operations.

6. DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY
CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS),
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY RIGHTS GRANTED
HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the
validity or enforceability of the remainder of the terms of this Agreement, and without further action by the
parties hereto, such provision shall be reformed to the minimum extent necessary to make such provision
valid and enforceable.

If Recipient institutes patent litigation against a Contributor with respect to a patent applicable to software
(including a cross-claim or counterclaim in a lawsuit), then any patent licenses granted by that Contributor
to such Recipient under this Agreement shall terminate as of the date such litigation is filed. In addition, if
Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit)
alleging that the Program itself (excluding combinations of the Program with other software or hardware)
infringes such Recipient's patent(s), then such Recipient's rights granted under Section 2(b) shall terminate
as of the date such litigation is filed.
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All Recipient's rights under this Agreement shall terminate if it fails to comply with any of the material terms
or conditions of this Agreement and does not cure such failure in a reasonable period of time after becoming
aware of such noncompliance. If all Recipient's rights under this Agreement terminate, Recipient agrees to
cease use and distribution of the Program as soon as reasonably practicable. However, Recipient's
obligations under this Agreement and any licenses granted by Recipient relating to the Program shall
continue and survive.

Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid inconsistency
the Agreement is copyrighted and may only be modified in the following manner. The Agreement Steward
reserves the right to publish new versions (including revisions) of this Agreement from time to time. No one
other than the Agreement Steward has the right to modify this Agreement. IBM is the initial Agreement
Steward. IBM may assign the responsibility to serve as the Agreement Steward to a suitable separate entity.
Each new version of the Agreement will be given a distinguishing version number. The Program (including
Contributions) may always be distributed subject to the version of the Agreement under which it was
received. In addition, after a new version of the Agreement is published, Contributor may elect to distribute
the Program (including its Contributions) under the new version. Except as expressly stated in Sections 2
(a) and 2(b) above, Recipient receives no rights or licenses to the intellectual property of any Contributor
under this Agreement, whether expressly, by implication, estoppel or otherwise. All rights in the Program
not expressly granted under this Agreement are reserved.

This Agreement is governed by the laws of the State of New York and the intellectual property laws of the
United States of America. No party to this Agreement will bring a legal action under this Agreement more
than one year after the cause of action arose. Each party waives its rights to a jury trial in any resulting
litigation.

• To obtain the source code for opening TrouSerS (Version 0.27), which is provided with this machine,
access the Web site at the following URL: http://www.ricoh.com/support/trousers/index.html

• TrouSerS version control is by SourceForge CVS. For methods of obtaining the source code, access
the Web site at the following URL: http://sourceforge.net/cvs/?group_id=126012
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